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About this document

Purpose

The NSP Troubleshooting Guide provides information about using NSP alarms, NSP applications,

NFM-P tools and other functions to troubleshoot customer services and the NSP network

management domain.

Scope

The scope of this document is limited to the NSP application and the NFM-P. Many configuration,

monitoring, and assurance functions are delivered in NSP web-based applications accessible from

the NSP Launchpad. Help for all installed NSP applications is available in the NSP Help Center.

The content in this document is divided by relevance to the NSP and NFM-P.

Safety information

For your safety, this document contains safety statements. Safety statements are given at points

where risks of damage to personnel, equipment, and operation may exist. Failure to follow the

directions in a safety statement may result in serious consequences.

Document support

Customer documentation and product support URLs:

• Documentation Center

• Technical support

How to comment

Please send your feedback to documentation.feedback@nokia.com.
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Part I: Troubleshooting overview

Overview

Purpose

This part provides an overview of NSP troubleshooting.

Contents
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1 NSP troubleshooting overview

1.1 Overview

1.1.1 General information

This chapter provides information about the troubleshooting process, guidelines, and tools, along

with a process for troubleshooting a problem in the NSP.

The NSP Troubleshooting Guide is intended for NOC operators and engineers who are responsible

for identifying and resolving NSP performance issues. The guide contains troubleshooting

information for the following domains:

• managed network

• NSP applications

• NSP platform

• NFM-P platform

1.1.2 Managed network troubleshooting

The NSP has a number of powerful troubleshooting apps and dashboards that help to quickly

pinpoint the root cause of network and service management problems to speed resolution.

You can use the NSP alarm and service monitoring functions to help you troubleshoot the network

of managed NEs.

Alarms for network objects

The NSP raises alarms against network objects in response to received SNMP traps from managed

NEs. You can then use the NSP Fault Management application to correlate the events and alarms

to the managed object, configured services and policies. A correlated event or alarm can cause

fault conditions on multiple network objects and services. For example, an alarm raised for a port

failure causes alarms on all services that use the port. You can view the alarm notification from the

NSP Fault Management, Service Supervision, and Network Supervision applications.

1.1.3 Platform troubleshooting

You can troubleshoot NSP platform issues that include the following:

• slow system response, poor performance, or excessive disk activity

• database failure, corruption, disk capacity, or performance degradation

• server communication problems, slow response, system alarms or statistics of concern, or

inability to manage new devices
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1.2 The troubleshooting process

1.2.1 Identifying network performance issues

The troubleshooting process identifies and resolves performance issues related to a network

service or component. The performance issue can result in service degradation, or in a complete

network failure.

The first step in problem resolution is to identify the problem. Problem identification can include an

alarm received from a network component, an analysis of network capacity and performance data,

or a customer problem report.

The personnel responsible for troubleshooting the problem must:

• understand the designed state and behavior of the network, and the services that use the

network

• recognize and identify symptoms that impact the intended function and performance of the

product

1.2.2 Network maintenance

The most effective method to prevent problems is to schedule and perform routine maintenance on

your network. Major networking problems often start as minor performance issues. See the NSP

Administrator Guide for more information about how to perform routine maintenance on your

network.

1.2.3 Troubleshooting problem-solving model

An effective troubleshooting problem-solving model includes the following tasks:

1. “Establish a performance baseline” (p. 14) .

2. “Categorize the problem” (p. 15) .

3. “Identify the root cause of the problem” (p. 15) .

4. “Plan corrective action and resolve the problem” (p. 16) .

5. “Verify the solution to the problem” (p. 16) .

See 1.5 “Process to troubleshoot a problem in the NSP” (p. 20) for information about how the

problem-solving model aligns with using the NSP to troubleshoot a network or network

management problem.

Establish a performance baseline

You must have a thorough knowledge of your network and how it operates under normal conditions

to troubleshoot problems effectively. This knowledge facilitates the identification of fault conditions

in your network. You must establish and maintain baseline information for your network and

services. The maintenance of the baseline information is critical because a network is not a static

environment.

See the NSP Administrator Guide for more information on how to generate NSP system baseline

information.
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Categorize the problem

When you categorize a problem, you must differentiate between total failures and problems that

result in a degradation in performance. For example, the failure of an access switch results in a

total failure for a customer who has one DS3 link into a network. A core router that operates at over

80% average utilization can start to discard packets, which results in a degradation of performance

for services that use the device. Performance degradations exhibit different symptoms from total

failures and may not generate alarms or significant network events.

Multiple problems can simultaneously occur and create related or unique symptoms. Detailed

information about the symptoms that are associated with the problem helps the NOC or engineering

operational staff diagnose and fix the problem. The following information can help you assess the

scope of the problem:

• alarm files

• error logs

• network statistics

• network analyzer traces

• output of CLI show commands

• accounting logs

• customer problem reports

Use the following guidelines to help you categorize the problem:

• Is the problem intermittent or static?

• Is there a pattern associated with intermittent problems?

• Is there an alarm or network event that is associated with the problem?

• Is there congestion in the routers or network links?

• Has there been a change in the network since proper function?

Identify the root cause of the problem

A symptom for a problem can be the result of more than one network issue. You can resolve

multiple, related problems by resolving the root cause of the problem.

Use the following guidelines to help you implement a systematic approach to resolve the root cause

of the problem:

• Identify common symptoms across different areas of the network.

• Focus on the resolution of a specific problem.

• Divide the problem based on network segments and try to isolate the problem to one of the

segments.

Examples of network segments are:

− LAN switching (edge access)

− LAN routing (distribution, core)

− metropolitan area

− WAN (national backbone)

− partner services (extranet)

− remote access services

• Determine the network state before the problem appeared.
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• Extrapolate from network alarms and network events the cause of the symptoms. Try to

reproduce the problem.

Plan corrective action and resolve the problem

The corrective action required to resolve a problem depends on the problem type. The problem

severity and associated QoS commitments affect the approach to resolving the problem. You must

balance the risk of creating further service interruptions against restoring service in the shortest

possible time.

Corrective action should:

1. Document each step of the corrective action.

2. Test the corrective action.

3. Use the CLI to verify behavior changes in each step.

4. Apply the corrective action to the live network.

5. Test to verify that the corrective action resolved the problem.

Verify the solution to the problem

You must make sure that the corrective action associated with the resolution of the problem did not

introduce new symptoms in your network. If new symptoms are detected, or if the problem has only

recently been mitigated, you need to repeat the troubleshooting process.

1.2.4 Checklist for identifying problems

When a problem is identified in the network management domain, track and store data to use for

troubleshooting purposes:

• Determine the type of problem.

Review the sequence of events before the problem occurred:

− Trace the actions that were performed to see where the problem occurred.

− Identify what changed before the problem occurred.

− Determine whether the problem happened before under similar conditions.

• Check the documentation or your procedural information to verify that the steps you performed

followed documented standards and procedures.

• Check the alarm log for any generated alarms that are related to the problem.

• Record any system-generated messages, such as error dialog boxes, for future troubleshooting.

• If you receive an error message, perform the actions recommended in the error dialog box, client

GUI dialog box, SOAP exception response, or event notification.

During troubleshooting:

• Keep both the Nokia documentation and your company policies and procedures nearby.

• Check the appropriate release notice from the Nokia Support Documentation Service for any

release-specific problems, restrictions, or usage recommendations that relate to your problem.
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• If you need help, confirmation, or advice, contact your TAC or technical support representative.

See Table 1-2, “General NSP problem types” (p. 20) to collect the appropriate information

before you call support.

• Contact your TAC or technical support representative if your company guidelines conflict with

Nokia documentation recommendations or procedures.

• Perform troubleshooting based on your network requirements.

1.3 NSP and NFM-P troubleshooting tools

1.3.1 NSP troubleshooting tools

NSP provides various apps and dashboard that can help your troubleshoot network, provide various

alarm details, and see the network health.

Network Health dashboard

The Network Health dashboard provides a quick view of essential information relating to the proper

function of your network. It presents an abbreviated view of equipment and service alarms, root

cause alarms, graphical plots of service-affecting network object counts, and network object status.

See 2.2.7 “Use the Network Health Dashboard to retrieve data about the health of a service and its

components” (p. 39) for information about collecting network data.

Troubleshooting dashboard

The Troubleshooting dashboard provides the user with a centralized view of network equipment

and service performance. The dashboard allows a network operator to view summarized

performance information, and to drill down into specific objects and view performance details,

opening objects in NSP applications where necessary. See the NSP User Guide for more

information.

Assurance Apps

There are assurance and analyze apps used by NSP: Fault Management, Analytics, Network

Supervision, and Service Supervision.

Fault Management

The Fault Management app provides alarm monitoring, correlation, and troubleshooting for the

most unhealthy network elements (NE) in the network. You can diagnose problems using various

Fault Management tools. See the NSP Fault Management App Help for more information.

Analytics

The Analytics app uses business intelligence (BI) software to generate graphical and tabular

reports, based on the aggregate statistical data that is extracted from the big data cluster. There are

two category of the reports available to you: Network and service, and Application assurance. See

the NSP Analytics Report Catalog for more information.

Network Supervision

The Network Supervision app provides a dashboard that helps you monitor the health of core,

access, transport, and optical NEs and virtual NFs using pre-defined KPIs and alarms. See the

NSP Network Supervision App Help for more information.
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Service Supervision

See the NSP Service Supervision App help for more information.

1.3.2 NFM-P troubleshooting tools

The NFM-P supports a number of troubleshooting tools and event logs to help identify the root

cause of a network or network management problem.

OAM diagnostics

The NFM-P supports configurable in-band and out-of-band, packet-based OAM diagnostic tools for

network troubleshooting and for verifying compliance with SLAs. See 8.1.1 “STM OAM diagnostics

for troubleshooting” (p. 119) for more information.

Ethernet CFM diagnostics

Ethernet CFM diagnostic tests detect connectivity failures between pairs of local and remote

maintenance end points, or MEPs, in a MEG. Each MEP is a reference point that can initiate or

terminate one of the following diagnostic tests:

• CFM continuity check

• CFM loopback

• CFM link trace

• CFM Eth test

• CFM two-way delay

• CFM one-way delay

• CFM single-ended loss (7705 SAR only)

• CFM two-way SLM

See the NSP NFM-P User Guide for more information about Ethernet CFM diagnostic.

RCA audit tool

The NFM-P RCA audit tool allows you to perform on-demand or scheduled verifications of the

configuration of services and physical links to identify possible configuration problems. Except for

physical links, the NFM-P provides a solution, which, at your request, can automatically be

implemented to make all the required configuration changes.

You can perform RCA audits of the following objects:

• VLL services

• VPLSs

• VPRN services

• physical links

• OSPF interfaces, areas, and area sites (NFM-P/CPAM integration only)

• IS-IS interfaces and sites (NFM-P/CPAM integration only)

See the NSP NFM-P User Guide for more information about the RCA audit tool.

NFM-P log files

You can use NFM-P log files to help troubleshoot your network. The log files can consume a large

amount of disk space during a long period of significant activity. Ensure that the contents of the
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various log directories are backed up on a regular basis. See the NSP Administrator Guide for more

information about how to perform routine NFM-P system maintenance.

Note: The event log files may be overwritten or removed when you restart an NFM-P server.

NFM-P LogViewer

The NFM-P LogViewer is a system monitoring and troubleshooting utility that parses, formats, and

displays the contents of NFM-P log files.

You can use LogViewer to perform the following:

• View and filter real-time log updates.

• View, filter, and sort the entries in a static log view.

• Open compressed or uncompressed log files.

• Compare active logs in real time.

• Automatically send a notification when a specified type of entry is logged.

See Chapter 15, “Troubleshooting using the LogViewer” for more information.

User activity log

The NFM-P records each NFM-P GUI and OSS user action. The NFM-P User Activity form allows

an operator with the appropriate privilege level to list and view the NFM-P GUI and OSS client user

activity, and to navigate directly to the object of a user action. You can also open a pre-filtered list of

the recent activity for an object from the object properties form.

See the NSP NFM-P User Guide for detailed information about the user activity log. See Chapter

13, “Troubleshooting using the NFM-P user activity log” for more information.

1.4 Before you call support

1.4.1 Gathering information

Collect the information listed in the table below before you contact technical support. The list of

support contacts is available at the following URL:

Technical support

Table 1-1 Required technical-support Information

Information type Description

Issue description
• recent NSP GUI operations

• screen captures or text versions of error or information messages

• actions performed in response to the issue
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Table 1-1 Required technical-support Information (continued)

Information type Description

Platform specifications
• NSP software Release and patch level

• OS type, release, and patch level

• hardware information such as:

- CPU type

- number of CPUs

- disk sizes, partition layouts, and RAID configuration

- amount of RAM

System logs You can use the following apps to collect the log files required by

technical support: Analytics, Service Supervision, and Network

Supervision.

1.5 Process to troubleshoot a problem in the NSP

1.5.1 Purpose

Perform the following high-level sequence of actions with respect to the problem-solving model

described in 1.2 “The troubleshooting process” (p. 14) .

1.5.2 Stages

1

Establish an operational baseline for your network. See the NSP Administrator Guide for more

information.

2

When a problem occurs, identify the type of problem. The table below lists some general NSP

problem types.

Table 1-2 General NSP problem types

Type Example problems

Managed network
• alarms raised against network objects

• service degradation with no associated alarms

• problem indications on topology maps

Service and network health
• network health issues

• error or warning messages related to configuration

• problem encountered during diagnose
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Table 1-2 General NSP problem types (continued)

Type Example problems

NSP platform
• pod failure

• errored cluster member

• disk capacity or performance issues

• MDM server issues

3

Identify the root cause of the problem using NSP or NFM-P procedures in the document

a. Use Table 1-3, “NSP Apps and dashboards problems or tasks” (p. 21) to identify the

appropriate NSP application troubleshooting procedure for the problem.

b. Use Table 1-4, “NSP platform problems or tasks” (p. 22) to identify the appropriate NSP

platform troubleshooting procedure for the problem.

c. Use Table 1-5, “NFM-P managed NE network problems or tasks” (p. 22) to identify the

appropriate NFM-P managed NE network troubleshooting procedure for the problem.

d. Use Table 1-6, “NFM-P network management domain problems or tasks” (p. 23) to identify

the appropriate NFM-P network management domain troubleshooting procedure for the

problem.

e. Use Table 1-7, “NFM-P platform problems or tasks” (p. 23) to identify the appropriate NFM-P

platform troubleshooting procedure for the problem.

Table 1-3 NSP Apps and dashboards problems or tasks

Problem or task

Troubleshooting using NSP applications

2.1 “Troubleshooting services and connectivity” (p. 29)

2.2 “Onboarding a service into Assurance applications” (p. 30)

Troubleshooting using Service Supervision

3.1 “Using routine service maintenance with Service Supervision” (p. 61)

Troubleshooting using Network Supervision

4.1 “Using the Matrix view to identify and troubleshoot equipment problems” (p. 69)

4.2 “Using the routine NE maintenance with Network Supervision” (p. 75)

Troubleshooting using Analytics

5.2 “Troubleshooting data collection” (p. 81)

5.3 “Troubleshooting data storage” (p. 84)

5.4 “Troubleshooting report generation” (p. 85)
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Table 1-4 NSP platform problems or tasks

Problem or task

Troubleshooting NFM-P platform problems

6.1.2 “Pod troubleshooting” (p. 89)

6.1.3 “NSP cluster member troubleshooting” (p. 90)

6.1.4 “MDM server troubleshooting” (p. 91)

6.1.5 “Disk performance tests” (p. 93)

Table 1-5 NFM-P managed NE network problems or tasks

Problem or tasks

Troubleshooting with alarms

7.3 “To view and sort alarms in the alarm list” (p. 101)

7.4 “To view object alarms and aggregated object alarms” (p. 102)

7.5 “To categorize alarms by object hierarchy” (p. 103)

7.6 “To acknowledge alarms” (p. 106)

7.7 “To determine probable cause and root cause using alarm and affected object information” (p. 107)

7.8 “To determine root cause using related objects” (p. 108)

7.10 “To troubleshoot a service equipment problem” (p. 109)

7.11 “To clear alarms related to an equipment problem” (p. 111)

7.12 “To troubleshoot an underlying port state problem” (p. 111)

7.13 “To clear alarms related to an underlying port state problem” (p. 114)

7.14 “To troubleshoot a service configuration problem” (p. 114)

7.15 “To clear a Frame Size Problem (MTU Mismatch) alarm” (p. 116)

Troubleshooting services and connectivity

8.3 “To identify whether a VPLS is part of an H-VPLS” (p. 122)

8.4 “To verify the operational and administrative states of service components” (p. 122)

8.5 “To verify the FIB configuration” (p. 123)

8.6 “To verify connectivity for all egress points in a service using MAC Ping and MAC Trace” (p. 124)

8.7 “To verify connectivity for all egress points in a service using MEF MAC Ping” (p. 127)

8.8 “To measure frame transmission size on a service using MTU Ping” (p. 128)

8.9 “To verify the end-to-end connectivity of a service using Service Site Ping” (p. 129)

8.10 “To verify the end-to-end connectivity of a service tunnel using Tunnel Ping” (p. 131)

8.11 “To verify end-to-end connectivity of an MPLS LSP using LSP Ping” (p. 134)

8.12 “To review the route for an MPLS LSP using LSP Trace” (p. 135)
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Table 1-5 NFM-P managed NE network problems or tasks (continued)

Problem or tasks

8.13 “To review ACL filter properties” (p. 136)

8.14 “To view anti-spoof filters” (p. 137)

8.15 “To retrieve MIB information from a GNE using the snmpDump utility” (p. 138)

Table 1-6 NFM-P network management domain problems or tasks

Problem or task

Troubleshooting network management LAN issues

10.1 “Problem: All network management domain stations experience performance degradation” (p. 145)

10.2 “Problem: Lost connectivity to one or more network management domain stations” (p. 145)

10.3 “Problem: Another station can be pinged, but some functions are unavailable” (p. 146)

10.4 “Problem: Packet size and fragmentation issues” (p. 147)

Troubleshooting using NFM-P client GUI warning messages

11.2 “To respond to a GUI warning message” (p. 152)

Troubleshooting with Problem Encountered forms

12.2 “To view additional problem information” (p. 155)

12.3 “To collect problem information for technical support” (p. 156)

Troubleshooting with the client activity log

13.2 “To identify the user activity for a network object” (p. 157)

13.3 “To identify the user activity for an NFM-P object” (p. 158)

13.4 “To navigate to the object of a user action” (p. 159)

13.5 “To view the user activity records of an object” (p. 160)

Table 1-7 NFM-P platform problems or tasks

Problem or task

Troubleshooting NFM-P platform problems

2.2.7 “Use the Network Health Dashboard to retrieve data about the health of a service and its components” (p. 39)

14.2 “Problem: Poor performance on a RHEL station” (p. 167)

14.3 “Problem: Device discovery fails because of exceeded ARP cache” (p. 170)

Troubleshooting with the NFM-P LogViewer

15.4 “To display logs using the LogViewer GUI” (p. 175)

15.5 “To configure the LogViewer using the GUI” (p. 180)

15.7 “To show or hide buttons from the LogViewer main tool bar” (p. 184)
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Table 1-7 NFM-P platform problems or tasks (continued)

Problem or task

15.8 “To set highlight colors and fonts for LogViewer components and levels” (p. 185)

15.9 “To automatically show or hide log messages” (p. 186)

15.10 “To manage filters using the GUI Filter Manager” (p. 187)

15.11 “To specify a plug-in using the LogViewer GUI” (p. 189)

15.12 “To display logs using the LogViewer CLI” (p. 190)

15.13 “To configure the LogViewer CLI” (p. 195)

15.14 “To specify plug-ins using the CLI” (p. 196)

Troubleshooting the NFM-P database

16.2 “Problem: NFM-P database corruption or failure” (p. 199)

16.3 “Problem: The database is running out of disk space” (p. 200)

16.4 “Problem: Frequent database backups create performance issues” (p. 201)

16.5 “Problem: An NFM-P database restore fails and generates a No backup sets error” (p. 202)

16.6 “Problem: NFM-P database redundancy failure” (p. 202)

16.7 “Problem: Primary or standby NFM-P database is down” (p. 203)

16.8 “Problem: Need to verify that Oracle database and listener services are started” (p. 203)

16.9 “Problem: Need to determine status or version of NFM-P database or Oracle proxy” (p. 204)

Troubleshooting NFM-P server issues

17.2 “Problem: Cannot start an NFM-P server, or unsure of NFM-P server status” (p. 207)

17.3 “Problem: NFM-P server and database not communicating” (p. 211)

17.4 “Problem: An NFM-P server starts up, and then quickly shuts down” (p. 212)

17.5 “Problem: Client not receiving server heartbeat messages” (p. 212)

17.6 “Problem: Main server unreachable from RHEL client station” (p. 213)

17.7 “Problem: Excessive NFM-P server-to-client response time” (p. 214)

17.8 “Problem: Unable to receive alarms on the NFM-P, or alarm performance is degraded” (p. 215)

17.9 “Problem: All SNMP traps from managed devices are arriving at one NFM-P server, or no SNMP traps are arriving” (p. 216)

17.10 “Cannot manage new devices” (p. 217)

17.11 “Problem: Cannot discover more than one device, or device resynchronization fails” (p. 218)

17.12 “Problem: Slow or failed resynchronization with network devices” (p. 219)

17.13 “Problem: Statistics are rolling over too quickly” (p. 220)

Troubleshooting NFM-P GUI and OSS clients

18.1 “Problem: Cannot start NFM-P client, or error message during client startup” (p. 221)
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Table 1-7 NFM-P platform problems or tasks (continued)

Problem or task

18.2 “Problem: NFM-P client unable to communicate with NFM-P server” (p. 222)

18.3 “Problem: Delayed server response to client activity” (p. 223)

18.4 “Problem: Cannot place newly discovered device in managed state” (p. 224)

18.5 “Problem: User performs action, such as saving a configuration, but cannot see any results” (p. 225)

18.6 “Problem: Device configuration backup not occurring” (p. 227)

18.7 “Problem: NFM-P client GUI shuts down regularly” (p. 228)

18.8 “Problem: Configuration change not displayed on NFM-P client GUI” (p. 229)

18.9 “Problem: List or search function takes too long to complete” (p. 229)

18.10 “Problem: Cannot select some menu options or save some configurations” (p. 230)

18.11 “Problem: The NFM-P client GUI does not display NE user accounts created, modified, or deleted using the CLI” (p. 230)

4

Plan corrective action using information in the NSP User Guide and NSP System Administrator

Guide.

5

Verify the solution.
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Part II: Troubleshooting using NSP applications

Overview

Purpose

This part provides information about troubleshooting using various NSP applications and

dashboards.

Contents

Chapter 2, Troubleshooting scenarios using multiple NSP applications 29

Chapter 3, Troubleshooting using Service Supervision 61

Chapter 4, Troubleshooting using Network Supervision 69

Chapter 5, Troubleshooting using the Analytics application 81
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2 Troubleshooting scenarios using multiple NSP
applications

2.1 Troubleshooting services and connectivity

2.1.1 Before you begin

This process provides a series of tasks you can perform to identify the root cause of a problem.

See the NSP System Administrator Guide for information about other NSP troubleshooting actions

such as displaying the system status or checking system performance.

2.1.2 Steps

Service Supervision application

1

Verify whether the administrative and operational states of each component of the service are

Up:

• Sites

• Endpoints

• Tunnel Bindings

See the procedure to investigate a service in the Service Supervision help.

2

Check the Alarm List for alarms against the services in your network.

3

Check the Event Timeline to view the history of events related to alarms, configuration, OAM

test failures and state change notifications.

Fault management application

4

Verify that there are no alarms associated with any component of the service:

• The Alarm List view provides high-level visibility of all alarms in the network.

• Choose the Current Alarms format to see the alarm information in a list you can filter.

Select an alarm to view detailed information in an information panel.
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5

From the Alarm List, check the Historical Alarms and Merged Alarms lists for further information

about root causes of any current alarms.

Original Service Fulfillment application and/or NFM-P

6

Verify that the NFM-P service configuration aligns with the customer requirements. For

example, ensure that NFM-P configuration uses the correct service type and SAP configuration,

and that the circuit and site are included in the service.

7

Contact your technical support representative if the problem persists.

END OF STEPS

2.2 Onboarding a service into Assurance applications

2.2.1 Purpose

This process shows you how to use the NSP to create a service and to monitor service health,

service components’ health, and service performance.

See the online help for the applications for detailed procedures.

2.2.2 Create a service using Service Fulfillment

Note: This process assumes that intent types for service creation have already been imported

into Intent Manager, Service Supervision groups have been created, and rules have been

added so that a new service created by Service Fulfillment is automatically added to a Service

Supervision group, for example, based on the name of the service.

1

In the Service Fulfillment application, create an Epipe service template, and use the template to

create an Epipe service.

See the service creation procedure in the Service Fulfillment Application Help.

2

Validate that the service is up and running:

Select the service. From the more menu, choose Open in Service Supervision.
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Service Supervision opens, with the service highlighted.

2.2.3 Initiate OAM tests from the service in Service Supervision

Run an end to end OAM test from the service endpoints to verify that the new service was

provisioned and activated properly. An OAM test verifies that traffic flows end to end.

1

From the services list in Service Supervision, choose More , Execute OAM Test.

2

In the form that opens, choose the test type, choose both service endpoints, and click

PROCEED.
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Insights Administrator opens, showing the Generate OAM Tests form.

3

Verify the test details and click GENERATE & EXECUTE.

Tip: Note the generated test suite name at the top of the View Test Suite Details form.

4

When test generation is completed, view the results in Insights Administrator.
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2.2.4 Use the Network Health Dashboard to view telemetry data in real time

From the Network Health Dashboard, you can launch the Insights Viewer utility to view raw

utilization data and verify that traffic is moving between service endpoints. Launching Insights

Viewer creates a temporary telemetry subscription in Insights Administrator, which is deleted when

Insights Viewer is closed.

1

Identify the service endpoints:

1. Open the Network Health Dashboard and navigate to Service Endpoints (SAPs).

2. Filter the list to display the service endpoints. Note the port information for the endpoints.

2

On the Network Health Dashboard, navigate to Ports.

3

Select one of the endpoints in the service from the port list and choose (More), Plot

Utilization Statistics.

Insights Viewer opens, showing the chart of the pre-configured utilization counters.
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In the event that traffic is not flowing, you can look at the error statistics by choosing Plot Error

Statistics from the Ports list.

4

The creation of the chart in Insights Viewer creates a temporary subscription for the utilization

counters in Insights Administrator.

The subscription is automatically deleted when you close the chart in Insights Viewer.

Tip: The description of the temporary subscription is Created by telemetry data subscription.

5

While the chart is open in Insights Viewer, you can:

a. Review the details of the pre-configured subscription by clicking Configure.

Tip: From the Edit Subscription form, copy the Object Filter string. You can use this string

to create a permanent subscription.

b. Edit the chart configuration in Insights Viewer.
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c. Save the chart to make the chart available from Insights Viewer in the future.
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2.2.5 Create telemetry subscriptions for the service endpoints in Insights
Administrator

Creating a telemetry subscription is an optional step, used for monitoring performance over time. A

telemetry subscription allows you to configure statistics collection, for example, utilization statistics

for a service, and to run the collection at any time, for example, for use in SLA management.

Statistics can also be used to generate Analytics reports. See the Insights Administrator Application

Help for the detailed procedure to create a subscription, and for information about aggregation and

retention for use in reporting.

1

Perform the subscription creation procedure in the Insights Administrator Application Help to

create subscriptions for the service SAPs.

Use the object filter string you copied from the temporary subscription in Stage 5.
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2.2.6 View utilization statistics from Network Supervision

1

In Network Supervision, open the group containing the service in Topology View format.

2

Select the Utilization view.
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A subscription is automatically created in Insights Administrator for the ports associated with the

endpoints for NEs present on the Network Supervision utilization map.

3

Edit the subscription in Insights Administrator and chart it in Insights Viewer as needed.

Note: Two subscriptions are automatically generated, for two telemetry types:

base/classic-utilization/utilization and base/interfaces/utilization. The

interfaces telemetry type must be used for charting.

Tip: The name of the subscription starts with netsup-.
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2.2.7 Use the Network Health Dashboard to retrieve data about the health of a
service and its components

You can use the Network Health Dashboard to access service information and information about

service components.

1

If a service is experiencing problems, one step in troubleshooting can be checking port details

on the service endpoints. This can be done by navigating to the equipment view in Network

Supervision:

1. On the Network Health Dashboard, navigate to Ports.

2. Select a port associated with one of the service endpoints and choose Show in
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Equipment view.

The equipment inventory page opens in Network Supervision, with the port highlighted in

the equipment tree.

Network Supervision shows the status of the port, for example, the administrative state,

operational state, and port data rate.
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2

Service Supervision provides service health information, including KPI status, health status of

components, alarms on the service, service mapping, and the event timeline. See the use case

for routine maintenance in the Service Supervision Application Help for details.

To verify details about the service and its components, you can navigate to Service Supervision

at the service level or at the endpoint level.

a.

1. On the Network Health Dashboard, navigate to Services.

2. Select the service and choose Show in Service Supervision.

The services list opens in Service Supervision for the group containing the service.

b.

1. On the Network Health Dashboard, navigate to Service Endpoints (SAPs).

2. Select an endpoint of the service and choose (More), Show in Service Supervision.
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The service endpoints list in Service Supervision opens.

2.3 End-to-end NE troubleshooting scenario

2.3.1 Purpose

This process shows you how to use NSP Applications in troubleshooting issues on NEs.

In this scenario, an NE is experiencing problems.

2.3.2 View affected equipment related resources

1

The Equipment Health dashlet in the Network Health dashboard uses KPIs to show NE states.

The Affected NEs KPI indicates that there are NEs to look at to start investigating.
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The Network Elements data page appears, filtered to show the list of NEs with at least one

affected object. The default filter can be changed if needed, for example, to focus on NEs with

more affected objects. We’ll focus on the Affected Objects column for the NE we’re

troubleshooting.

Let’s open Network Supervision to get more details. Select an NE and choose Go to

equipment view from the table row actions menu.
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The Network Supervision application opens in a new tab, showing affected objects in the

Equipment Tree.
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2.3.3 View the News Feed in the Network Health dashboard

The News Feed provides a live feed of unacknowledged root cause alarms as they occur in real

time. Alarm severity and number of impacts are displayed, and cross launch is available depending

on the alarm. All alarms can cross launch to the Current Alarm List. NE and link alarms can cross

launch to the current alarm list and the map, and NE and port alarms can cross launch to the

current alarm list, equipment view or port utilization.

1

Select an alarm with impact and show it in the current alarm list to dig deeper into possible

causes of the problem.
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2

Hover over the alarm row to see options. For example, open an impacts diagram to see other

alarms caused by this root cause.
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Fault Management also provides details of the alarm, such as the alarm description, raising and

clearing conditions, and remedial action.

3

Another option is to note the NE name and switch to the Top Unhealthy NEs or Top Problems

tabs, to see what other alarms are present on the NE, to see what other issues the NE is

experiencing.

2.3.4 View the Network Health Dashboard map view

Another option the Network Health Dashboard offers is a network map view. The map view is the

same as the one provided by Network Supervision. Viewing the NE in the map will show us the

status of links, in case there are any port issues affecting connectivity.

1

From the Network Elements list, click on the NE and choose Show in map.

A network map opens within the Network Health dashboard, highlighting the NE.
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2

From the map view, there are similar options to the Network Elements list, such as showing the

NE in the Current Alarm list or the Equipment View. In addition, you can plot statistics for the

NE.

3

Right click on the NE in the map view and choose Plot statistics.

The Insights Viewer utility opens, showing an on-demand chart of memory and CPU usage for

the NE.
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In the event that a subscription is already present for the memory and CPU usage counters,

historical data will also be displayed.

2.3.5 Open the alarm list from the Network Health dashboard

1

From the Network Elements list in the Network Health dashboard, choose Go to current alarm

list.
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The NSP Fault Management application opens, displaying the list of current alarms for the NE.

Click on Last Time Detected to see the most recent alarms.
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2

Hover over the alarm to see additional options for investigating the alarm, such as opening the

Root Cause diagram.

From the Alarm List, you can also investigate alarms by looking into the alarm details, showing

Impacts, showing Root cause, or opening an NE session to use CLI.

2.3.6 Check the Troubleshooting Dashboard.

1

Viewing a target in the Troubleshooting Dashboard can help you see where to look to

investigate a problem.

From the Network Elements dashlet in the Network Health dashboard, right click on the NE and

choose Show in troubleshooting dashboard.
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The Troubleshooting dashboard shows summary information for the NE, and provides a health

and an alarm summary.

We can click Go to equipment view to see the port in Network Supervision, or Go to Network

Supervision to view alarms and impacts.
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2.3.7 Check configuration alignment and operation history in Device Administrator

1

From Network Supervision, click on the matrix menu and choose Device Administrator.
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2

In the NETWORK ELEMENTS tab in Device Administrator, select the NE and choose Operation

history from the Table row actions menu. The most recent operations are displayed.
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From the history list, we can see when the most recent successful backup was performed, and

see if any recent operations have failed.

You can click on the link icon from a failed operation to view error information in Workflow

Manager.

3

To restore from a backup, select a successful backup and choose Restore from the Table row

actions menu. The restore operation is launched.
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4

If the NE was configured using Infrastructure Configuration Management, we can check for a

misalignment in the CONFIGURATIONS tab.

Click on the misaligned object and click View Result under Last Audit.
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The audit results show the misaligned attributes.
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5

Click ALIGN ALL CONFIG to fix the misalignment.
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3 Troubleshooting using Service Supervision

3.1 Using routine service maintenance with Service Supervision

3.1.1 Purpose

This article shows you how to use the Service Supervision application to monitor the status of the

services running in your network and to locate and troubleshoot problems.

3.1.2 Starting points for troubleshooting monitored services

Changes to services manifest themselves through trending arrows on group tiles, and through

changes to KPI icon color on service objects.

Any of the following events could indicate that you need to troubleshoot your services:

• One or more KPI icons turn red on services in the Watch view.

To add services to the Watch view, hover over a service item in the Service list and click

More, Add To Watch Drawer.

• A Trending Arrow appears on a tile, or the tile changes color as services are impacted by

new issues.

• A service item in the Service list shows problems with service objects: service site down,

endpoint down, tunnel binding down, and/or OAM test validation failure.

3.1.3 Triaging steps for a group

1

Select an affected group tile in the view.

2

Determine the number of affected services and services with sites down for the group.
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Click More Details to expand a group tile and view additional KPIs: services with

endpoints down, tunnel bindings down, or OAM test failures.

3

Double-click on the group to display its affected services in the Service list.

From the Service list, you can open the Alarms list to view alarms for the entire group.

4

Proceed to 3.1.4 “Triaging steps for services” (p. 62).

END OF STEPS

3.1.4 Triaging steps for services

One or more KPI icons turn red on services in the Service list or in the Watch view.

1

Double-click on an affected service in the Service list or click on an affected service in the

Watch view.
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The affected service opens in the Service list as a list of service sites.

2

Determine which KPIs are affected (i.e. down ): service site down, endpoint down, tunnel

binding down, and/or OAM test validation failure.

3

Open the Alarms list for the affected service; on the service item click More, Alarms. Use the

Alarms List, Impacts diagram, and Event Timeline as described in 3.1.8 “Troubleshoot

problems in Alarms list” (p. 65) and 3.1.9 “Troubleshoot problems in the Event Timeline” (p. 66)

to view events that might point to the problem.

4

On the service item, click Service Map. On the Service map, check the status of tunnel

bindings as described in 3.1.11 “Troubleshoot problems in the Service Map” (p. 68).

5

To change the configuration of the service item in its management application, hover over a

service item and click More, View Properties. Monitor the object in Service Supervision to

determine if KPIs improve as a result of the change.
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6

After troubleshooting, verify that all alarms and KPIs have cleared and run OAM tests to prove

that traffic can flow.

END OF STEPS

3.1.5 Triaging steps for a service site

For a selected service item in the Service list, the Service Site KPI is Down.

1

Double-click on the service item to drill down to a list of all sites for the service.

2

Open the Alarms list for the affected service site; on the site item, click More, Alarms.

3

Use the Alarms List and Impacts diagram as described in 3.1.8 “Troubleshoot problems in

Alarms list” (p. 65) to view events that might point to the problem.

4

On the service item, click Event Timeline. Use the Event Timeline as described in

3.1.9 “Troubleshoot problems in the Event Timeline” (p. 66) to view events that might point to

the problem.

5

Select multiple affected service site item(s) and click OAM Test. Perform OAM tests as

described in 3.1.10 “Troubleshoot problems with OAM tests” (p. 67) .

END OF STEPS

3.1.6 Triaging steps for an endpoint

For a selected service item in the Service list, the Endpoint KPI is Down.

1

On the service item, click on the endpoint icon to drill down to a list of endpoints on the service.

2

On an affected endpoint item, click Alarms. Use the Alarms List and Impacts diagram as

described in 3.1.8 “Troubleshoot problems in Alarms list” (p. 65) to view events that might point

to the problem.
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3

On an affected endpoint item, click Event Timeline. Use the Event Timeline as described in

3.1.9 “Troubleshoot problems in the Event Timeline” (p. 66) to view events that might point to

the problem.

4

Select multiple affected endpoint item(s) and click OAM Test. Perform OAM tests as

described in 3.1.10 “Troubleshoot problems with OAM tests” (p. 67) .

END OF STEPS

3.1.7 Triaging steps for a tunnel binding

For a selected service item in the Service list, the Tunnel Binding KPI is Down.

1

On the service item, click the Tunnel Binding icon to drill down to a list of tunnel bindings on the

service.

2

On an affected tunnel binding item, click Alarms. Use the Alarms List and Impacts diagram

as described in 3.1.8 “Troubleshoot problems in Alarms list” (p. 65) to view events that might

point to the problem.

3

On an affected tunnel binding item, click Event Timeline. Use the Event Timeline as

described in 3.1.9 “Troubleshoot problems in the Event Timeline” (p. 66) to view events that

might point to the problem.

4

Select one or more affected tunnel binding item(s) and click OAM Test. Perform OAM tests

as described in 3.1.10 “Troubleshoot problems with OAM tests” (p. 67) .

END OF STEPS

3.1.8 Troubleshoot problems in Alarms list

Click on an alarm message in the list to display complete details of the alarm, including descriptive

and remedial information.

If you suspect that the affected object for the selected alarm is a cause of the current problem, you

can open the affected object in its management application directly from the Alarms list. On the
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selected alarm item, click More →Show Affected Object. Make configuration changes to the

affected object while monitoring the object in Service Supervision to determine if KPIs improve as a

result of the change.

From the Alarms list (in the context of the selected service) you can take the following actions:

• For an alarm item in the list, click Show Impacts to determine the root cause of the alarm.

• The selected alarm object is circled in dark blue. Click on an alarm object to view details and

remedial information.

If you suspect that the affected object for the selected alarm is a cause of the current problem,

you can open the affected object in its management application from the Impact Analysis view. At

the bottom of the Details panel, click Show Affected Object. Make configuration changes to

the affected object while monitoring the object in Service Supervision to determine if KPIs

improve as a result of the change.

• Open the Event Timeline for the alarm.

Set a date range around the alarm event and view events that occurred prior to alarm being

raised to determine a possible cause (for example, an object configuration change).

3.1.9 Troubleshoot problems in the Event Timeline

You can open the Event Timeline directly from a service object, or from individual alarm objects.

View events that occurred prior to a hardware problem or an alarm being raised to determine a

possible cause (for example, an object configuration change).

• Set an appropriate date range around the hardware problem or alarm event.

• Select an event icon in the timeline and click Event Details to view information related to the

event. Use the Zoom function to expand clusters of events and search for causal events for a
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failure.

3.1.10 Troubleshoot problems with OAM tests

OAM diagnostic tests allow on-demand service performance monitoring and SLA verification to

ensure that a service meets its performance settings in a controlled test time.

OAM tests can be run on a service by multi-selecting service sites, endpoints, or tunnel bindings. A

failed OAM test result generally indicates that the service or part of the service is not operational.

Not all OAM test types apply to all service types.

Select a test type and click Run Test. The results are displayed in the Test Results Summary.
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3.1.11 Troubleshoot problems in the Service Map

Note: CPAM configuration is required in the service management application in order for the

Service Map to display.

From the Service list, you can open a selected service in the Service Map. The Service Map

can be useful in identifying the service segment that is experiencing a failure.

• In the Service Map, click on a tunnel binding, Service link, or Service site object and then click

Info to view details about the object.

• Set the Map Type parameter to Troubled Tunnel Bindings to display only tunnel bindings that are

not working on the service.
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4 Troubleshooting using Network Supervision

4.1 Using the Matrix view to identify and troubleshoot equipment
problems

4.1.1 Overview

Network operators are tasked with resolving problems in complex networks. Some network

problems are identified using trouble tickets, others by active monitoring. For operators who are

actively monitoring the network, there are several options in Network Supervision for identifying

problems and investigating root causes. For example, Network Supervision provides multiple

display formats for showing information about network equipment: Matrix View, NE List, Topology

View, and others. Each view provides a different perspective for identifying problems, comparing

KPIs, and troubleshooting to find root causes.

In this article we’ll look at the Matrix view, and see how problem indicators on NE tiles help identify

which NEs need closer inspection. Then we’ll discuss how to troubleshoot those NEs using three

main entry points and processes.

This article assumes you are already familiar with views and supervision groups, and know how to

recognize when a supervision group requires closer inspection.

4.1.2 Problem indicators in the Matrix View

The Matrix View shows the NEs in a supervision group as tiles in a grid. When you’re looking at the

tiles in the Matrix View, how can you tell which NEs have problems that require investigation?

There are three main problem indicators on the NE tiles:

• Tile location

• Tile color

• Trend arrows
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Tile location: Tiles in the upper left have the most serious problems. Network Supervision sorts the

tiles at every Trend Time interval, and moves tiles to the upper left based on either the number of

unacknowledged critical alarms, or the number of components affected (cards, ports, links). You

can choose to sort based on alarms or components by setting User Preferences. Trend Time

interval is also configurable.

Tile color: Red means trouble. Tiles may be green, yellow, orange, or red, and problems are more

serious as the colors change, in that order. The colors indicate the percentage of affected

components on the NE. You can set KPI Threshold settings to customize the percentages at which

the colors change.

Trend arrows: If you see one of these on an NE tile, problems on that NE have become worse

since the last Trend Time interval.

As you actively monitor the NE matrix, the NE tiles that sift to the upper left, show red, or have a

trend arrow, indicate that you may need to investigate the NE to troubleshoot and identify problems.

4.1.3 Entry points for troubleshooting

OK, you’ve identified an NE that needs further investigation. Now what?

At the bottom of each NE tile is a Show More menu. When you hover over the Show

More menu, three icons appear:

• Current Alarms

• Event Timeline

• Troubleshooting Map

29443
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The icons provide entry points for active troubleshooting. Clicking on an icon starts a processthat

allows you to troubleshoot the root cause of the problem. Let’s look at the troubleshooting options

one at a time.

4.1.4 Troubleshooting using the Current Alarms list

The Current Alarms list shows all alarms on the NE that have not been cleared. You can filter and

sort the alarms using the column headings; for example, you can sort to show all critical alarms at

the top of the list, or sort by impact, or probable cause.

When you select an alarm in the list, information about that alarm appears in the Details panel. The

Description and Remedial Action are expanded by default; these details may provide enough

information to fix the problem. Expanding Additional Text may provide further help. You can expand

any of the Details headings as needed.

You may have to select more than one alarm in the list to identify the root cause of the problem.

From the Current Alarms list, you can select several other options for troubleshooting or more

information, using the icons or the More menu located above the list. For instance, you can open

the Event Timeline (discussed next).

To fix the problem, you may need to open the NFM-P properties form for the NE by clicking

More, Show object. The properties form for the object opens in the NFM-P client, and you can

make configuration changes to resolve the issue.
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4.1.5 Troubleshooting using the Event Timeline

If you know the approximate time that a problem began, the Event Timeline provides you with quick

identification of equipment events that may have caused the problem. Events can be alarms,

configuration changes, or equipment updates.

Events are shown either individually or as a cluster, depending on the zoom level. Alarms are

shown on the lower part of the timeline, configuration events are shown in the middle, and updates

along the top. When you click on an event icon in the timeline, an information panel opens showing

more details. For instance, a state change event might show that it was user-initiated, possibly

indicating a maintenance window, or similar activity.
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By default, the timeline shows the 24 hour period immediately prior to when it was opened. You can

configure the time range to narrow down the number of events. This is useful when you have an

indication of when the problem started.

As with the Current Alarms list, from the Event Timeline you can select several other options for

troubleshooting, more information, or to fix the problem, using the icons or the More menu.

4.1.6 Using the Troubleshooting Map

Some problems have their root cause in equipment other than the NE you are investigating. The

Troubleshooting Map shows related equipment in the segment of network topology immediately

surrounding the initial problem NE. Map tools allow you to explore for issues on NEs and links that

are closely connected to that initial NE.
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When you open the Troubleshooting Map, the initial NE is shown, along with the NEs to which it

has immediate links. The links are shown also. If NEs have alarms, a badge appears on the NE

icon, showing the highest level alarm on the NE. When you hover over NEs or links, basic

information is displayed.

Typically, you look at the NEs that have alarms and are immediately connected to the initial NE that

you are investigating, to see if they have issues that are causing the problem on that NE. You can

expand the map to investigate additional NEs farther away from the initial NE, by right-clicking on

an NE in the map and choosing Explore. The map expands outward by the number of hops you

have configured in the Hop count.

To show more detailed information, you can open an information panel on the right. When you click

on any NE or link on the map, it’s outlined in blue and details are displayed in the panel. The

displayed information may be enough to identify the root cause, but if not, you can use the

More actions menu in the panel to show the equipment inventory or open a Current Alarms list

for any NE on the map, to further troubleshoot on the related NEs.

If the problem is an equipment configuration error, you can fix it on the properties form for an NE by

clicking More, Show object. If you need to investigate further, you can choose several other

options for troubleshooting or more information, using the icons or the More menu located above

the map.

The Troubleshooting Map has display controls and a legend to help you manage the view and

identify map objects.

29444
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4.1.7 Matrix view - use case summary

The Network Supervision application provides multiple methods for identifying and investigating

equipment problems in the network. In this article, we discussed how to identify problems using the

Matrix View, then looked at three main entry points and processes for troubleshooting and fixing the

root cause of equipment problems:

• Current Alarms

• Event Timeline

• Troubleshooting Map

Any of these methods may lead to the successful resolution of equipment problems. The best

method will depend on the type of problem encountered, and on the operator’s preference and

experience. There are other troubleshooting methods in Network Supervision besides those

described here, such as Equipment Inventory and Analytics Reports, or using display formats other

than the NE Matrix. More detailed procedures, descriptions, and processes are available in the

NSP Help Center.

The Network Supervision application works in conjunction with the NFM-P, Fault Management,

Service Supervision, and other NSP applications to provide effective management of network

equipment, using efficient processes and navigation to solve problems in dynamic networks.

4.2 Using the routine NE maintenance with Network Supervision

4.2.1 Purpose

This article shows you how to use the Network Supervision application to monitor the status of your

network hardware (NEs and their installed equipment) and to locate and troubleshoot the root

cause of problems.

4.2.2 Starting points for troubleshooting monitored NEs

Any of the following events could indicate that you need to troubleshoot your network:

• One or many KPI icons turn red or show upward trending arrows on NEs in the Watch view.

To add NEs to the Watch view, hover over an NE tile in the NE Matrix and click Show More,

Add To Watch View.

• A supervision group turns red or shows upward trending arrows.
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• NE tiles change color or show upward trending arrows in the NE Matrix.

4.2.3 Triaging steps for a supervision group

1

Select an affected supervision group in the view.

2

Determine the number of affected NEs and critical alarms for the group.

3

Click on the supervision group to display its NEs in the NE Matrix.

From the Matrix, you can open the Alarms list to view alarms for the entire group.

4

Proceed to 4.2.4 “Triaging steps for an NE” (p. 75).

END OF STEPS

4.2.4 Triaging steps for an NE

1

Select an affected NE in the Watch view or NE Matrix.

2

Determine which KPIs on the NE are affected (yellow or red color): the number of cards, ports,

or links that are down.

Also look for upward trending arrows on NEs in the Watch view or NE Matrix. These indicate

affected NEs that developed problems recently.

Troubleshooting using Network Supervision
Using the routine NE maintenance with Network Supervision

NSP

© 2022 Nokia.
Use subject to Terms available at: www.nokia.com/terms

3HE-18817-AAAC-TQZZA

Release 22.9
September 2022

76 Issue 1

http://www.nokia.com/terms/


3

Select one or more of the following methods to troubleshoot the problem.

Troubleshooting with the Current Alarms list and Event Timeline

4

Open the Alarms list to view all standing alarms for the selected NE; on the NE tile, click

Show More, Current Alarms.

5

Click on an alarm message in the list to display complete details of the alarm, including

descriptive and remedial information.

If you suspect that the affected object for the selected alarm is a cause of the current problem,

you can open the affected object in its management application directly from the Alarms list. On

the selected alarm item, click More > Show Affected Object. Make configuration changes to the

affected object while monitoring the object in Network Supervision to determine if KPIs improve

as a result of the change.

6

To further investigate a selected alarm, open its Impact Analysis diagram to view objects

impacted by the alarm. On the selected alarm item, click Show Impacts.

The selected alarm object is circled in dark blue. Click on an alarm object to view details and

remedial information.

If you suspect that the affected object for the selected alarm is a cause of the current problem,

you can open the affected object in its management application from the Impact Analysis view.

At the bottom of the Details panel, click Show Affected Object. Make configuration

changes to the affected object while monitoring the object in Network Supervision to determine

if KPIs improve as a result of the change.

7

Open the Event Timeline for the alarm to view events that occurred just prior to the alarm

being raised, and determine the possible cause (for example, an object configuration change).
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Adjust the date range around the alarm event using the Date Chooser .

Select an event icon in the timeline to view information related to the event.

Troubleshooting with the Troubleshooting Map

8

Return to the NE Matrix or Watch view and open the Troubleshooting Map for the selected

NE. Click on a red NE or link object and then click Info to view details about the object.
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NE objects with alarms carry a badge. The badge color indicates alarm severity, as described in

the Details panel. Hover over an NE or link object to view basic status or alarm information

about the object.

To correct a problem on an affected object, you can open the object in its management

application to change its configuration, or to undo a previous configuration change that caused

the problem. On the Details panel, click Show More, Show Object. Make configuration

changes to the affected object while monitoring the object in Network Supervision to determine

if KPIs improve as a result of the change.

9

When troubleshooting is complete, verify that all alarms have cleared and KPI indicators are

green.

END OF STEPS
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5 Troubleshooting using the Analytics application

5.1 Troubleshooting overview

5.1.1 Troubleshooting

An effective troubleshooting model for solving Analytics application problems includes the following

tasks:

• Eliminate the possibility of a hardware or network problem. For example, if you are having

trouble with a Port Throughput report, verify that the port is up.

• Check the report description in this guide for the report-specific requirements, such as statistics,

aggregation, or policies that must be in place.

• Verify that the NE is generating the required files. For example, if the report requires a statistic,

verify that counters for that statistic are being generated.

• Categorize the problem.

The following are the most common categories of problems affecting Analytics reports:

− Data collection issues

− Data storage issues

− Report generation issues

• Plan corrective action and resolve the problem.

• Verify that the problem is resolved.

5.2 Troubleshooting data collection

5.2.1 Statistics collection for Application Assurance reports

A blank report may be due to a statistics collection issue, or a prompt selection that excludes all

available data.

The description of the report shows the statistics type required for the report, and whether an NSP

Flow Collector is required. Table 5-1, “Troubleshooting statistics collection for Application

Assurance reports ” (p. 82) describes options for checking statistics collection.
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Table 5-1 Troubleshooting statistics collection for Application Assurance reports

Statistics type Items to verify See

AA accounting
• Are required policies in place?

• Are statistics being collected?

• What is the accounting retrieval

status of the NE?

• Is additional information available

from server performance statistics?

“Workflow for accounting statistics

collection” in the NSP NFM-P

Statistics Management Guide

“Workflow for server performance

statistics collection” in the NSP

NFM-P Statistics Management Guide

“To view the accounting statistics

collection status of an NE” in the NSP

NFM-P User Guide

AA Cflowd
• Has AA Cflowd sampling been

configured?

• Are required policies in place?

“To enable and configure

global Cflowd sampling on an NE” in

the NSP NFM-P User Guide

“To configure Cflowd collectors on an

ISA-AA group or partition” in the NSP

NFM-P User Guide

“To configure an AA Cflowd group

policy” in the NSP NFM-P User Guide

“Workflow to configure flow statistics

collection” in the NSP NFM-P

Statistics Management Guide

If the report requires special study

statistics collection, see “Workflow to

configure AA Cflowd special study

statistics collection” in the NSP

NFM-P Statistics Management Guide

Is the NSP Flow Collector operating

correctly?

Is the Flow Collector mode correct? A

single Flow Collector can collect AA

Cflowd or IPFIX, but not both

simultaneously.

“To display the NSP Flow Collector

status” in the NSP NFM-P

Administrator Guide

Check the NSP Flow Collector logs to

verify connectivity to the auxiliary

database; see 5.3 “Troubleshooting

data storage” (p. 84)

Subscriber
• Are required policies in place?

• Are statistics being collected?

“To configure AA subscriber

statistics collection on an ISA-AA

group or partition” in the NSP NFM-P

User Guide

Is the NSP Flow Collector operating

correctly?

“To display the NSP Flow Collector

status” in the NSP System

Administrator Guide

5.2.2 Statistics and data collection for Network and Service reports

A blank report may be due to a statistics collection issue, or a prompt selection that excludes all

available data.

The description of the report shows the statistics or data type required for the report, and any other

prerequisites that may apply. Table 5-2, “Troubleshooting statistics and data collection for Network

and Service reports ” (p. 83) describes options for checking collection.
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Table 5-2 Troubleshooting statistics and data collection for Network and Service reports

Statistics type Items to verify See

Accounting (also known as XML

statistics)
• Are required policies in place?

• Are statistics being collected?

• Are required aggregators

configured?

“Workflow for accounting statistics

collection” in the NSP NFM-P

Statistics Management Guide

“How do I configure analytics

aggregation?” in the NSP Analytics

Report Catalog

Performance (SNMP) data
• Are required policies in place?

• Is SNMP connectivity established

between the NE and the NFM-P?

• Are required statistics being

collected?

• Are required aggregation rules

enabled?

• Alarms: if the system cannot collect

and process all performance

statistics in the specified polling

period, the PollerDeadlineMissed

alarm will be raised.

“How do I configure analytics

aggregation?” in the NSP Analytics

Report Catalog

IPFIX (also called System Cflowd or

Netflow v10)
• Has IPFIX sampling been

configured?

• Are required policies in place?

“Workflow to configure flow statistics

collection” in the NSP NFM-P

Statistics Management Guide

Is the NSP Flow Collector operating

correctly?

Is the Flow Collector mode correct? A

single Flow Collector can collect AA

Cflowd or IPFIX, but not both

simultaneously.

“To display the NSP Flow Collector

status” in the NSP System

Administrator Guide

OAM data
• Is OAM testing configured in the

NFM-P?

• Are required policies in place?

• Are OAM aggregation rules

enabled?

“How do I configure analytics

aggregation?” in the NSP Analytics

Report Catalog

Event data for Uptime reports
• Is an event log policy in place with

an appropriate retention time for

assurance events?

• Is event logging configured in the

Service Supervision application?

• Are maintenance windows

configured appropriately?

“To configure an event log policy” in

the NSP NFM-P User Guide

Online help for the Service

Supervision application

“To create and manage custom

auxiliary database table attributes” in

the NSP NFM-P Administrator Guide

5.2.3 NFM-P auxiliary database

In order to enable data collection, the auxiliary database must be configured and operational.
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The NFM-P forwards statistics to the auxiliary database only if the auxdb-storage parameter is

enabled in the aa-stats section of each NFM-P main server configuration. See the NSP Installation

and Upgrade Guide for information about using the samconfig utility to modify the NFM-P

configuration.

If you suspect an auxiliary database problem, you can run the following script on an auxiliary

database station to collect log files for technical support:

/opt/nsp/nfmp/auxdb/install/bin/getDebugFiles.bash

5.2.4 NFM-P main database

For Inventory reports, the NFM-P main database must be operational and able to receive files from

NEs.

To confirm that files are being received and stored, monitor the following folder on the standalone or

primary main server to ensure that new statistics files are being generated:

/opt/nsp/nfmp/server/xml_output

5.3 Troubleshooting data storage

5.3.1 OAM test result storage

For OAM test reporting, the OAM test results must be stored in the auxiliary database, which

requires that the oam-test-results parameter is enabled in the samauxdb section of each NFM-P

main server configuration. See the NSP Installation and Upgrade Guide for information about using

the samconfig utility to modify the NFM-P configuration.

5.3.2 Statistics retention policy

Verify that the statistics retention policy is appropriate; data is unavailable for reporting if statistics

are removed prematurely.

5.3.3 Auxiliary database log locations

Logs for each NE can be found in the following directory on an auxiliary database station:

/opt/nsp/nfmp/auxdb/catalog/samdb/member_ID_catalog/vertica.log

where member_ID is the ID of the auxiliary database station, for example, v_samdb_node0002

The following log file contains basic auxiliary database status information:

/opt/nsp/nfmp/auxdb/install/proxy/log/EmsAuxDbProxy.log

5.3.4 Assurance event logging

If an auxiliary database is present, assurance events are recorded in the following auxiliary

database table:

samdb.assurance_assuranceevent

If no auxiliary database is present, assurance events are recorded in the following main database

table:
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PsoAssuranceEvent obj_199a4deb

5.4 Troubleshooting report generation

5.4.1 Analytics server

The analytics-server installation logs are in the following location on an analytics server:

/opt/nsp/analytics/log

By default, an analytics server logs only errors. The server application log is the following:

/opt/nsp/analytics/log/analytics.server.log

You can enable additional logging using a script. See “To enable and manage analytics server

logging” in the NSP System Administrator Guide for information.

The SQL log shows the data table names. Verify that the table for your report is requesting and

receiving timed frame data to generate reports.

Additional logs are available in the following location on an analytics server:

/opt/nsp/os/tomcat/logs

For example, the analytics-registration.log file records analytics server communication with the NSP

ZooKeeper service, and the tomcat catalina.out file records web-server operations and events.

5.4.2 Other reporting problems

The following may assist with troubleshooting NSP Analytics reporting:

• See “Using the Analytics application” in the NSP Analytics Report Catalog document to ensure

that the reporting criteria are correctly specified. For example, all data for a report must be

collected using the same collection interval.

• Verify the connectivity between the analytics servers, auxiliary database, and NFM-P main

servers.

• If a report is taking a long time to execute, or generating errors, try reducing the number of

objects in the data set.

• Verify that TLS is configured correctly in the NFM-P, and on each analytics server; see “TLS

configuration and management” in the NSP Installation and Upgrade Guide for information.
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Part III: NSP troubleshooting

Overview

Purpose

This part provides information about NSP troubleshooting.

Contents

Chapter 6, NSP system troubleshooting 89
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6 NSP system troubleshooting

6.1 Troubleshooting NSP cluster issues

6.1.1 Purpose

The commands provided in this section can help diagnose and resolve NSP deployment and

installation issues by providing detailed information about the status of various deployed

components.

6.1.2 Pod troubleshooting

This topic covers troubleshooting the pods that are part of the NSP cluster.

Retrieve a list of pods

Enter the following command to view a list of pods in the NSP cluster:

# kubectl get pods ↵

Retrieve pod information

Enter the following to view information about a specific pod:

# kubectl describe pod pod_name ↵

where pod_name is the name of the pod to view

The command output includes many parameters, including any events associated with the pod. For

example:

Type Reason Age From Message

---- ------ ---- ---- -------

Warning FailedScheduling <unknown> default-scheduler 0/1 nodes are

available: 1 Insufficient memory.

Recover pods

Enter the following command to recover a pod:

# kubectl delete pod pod-name ↵

where pod-name is the name of the pod

The pod is automatically redeployed. You can use the command to recover a pod in an errored

state.

Recover executor pods

The following applications use executor and driver pods:
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• act-pipeline-app

• rta-anomaly-detector-app

• rta-trainer-app

• rta-windower-app

An executor pod name has the following format:

app_name-instance-exec-executor_ID

where

app_name is the application name

instance is the pod instance ID

executor_ID is a number that identifies the executor instance

Enter the following to recover an executor pod, where app_name is the application name:

# kubectl delete pod app-name-driver ↵

The driver pod is automatically redeployed, thereby recovering any associated errored executor

pods.

6.1.3 NSP cluster member troubleshooting

This topic describes troubleshooting the members of an NSP cluster.

Retrieve a list of members

Enter the following to list the NSP cluster members:

# kubectl get nodes ↵

Retrieve member information

Enter the following to view information about a specific member:

# kubectl describe nodes node_name ↵

where node_name is the name of the member to view

The command output includes member information such as the following:

• member status; for example:

Type Status LastHeartbeatTime LastTransitionTime Reason Message

---- ------ ----------------- ------------------ ------ -------

NetworkUnavailable False Wed, 30 Sep 2020 12:19:23 -0400 Wed, 30 Sep 2020 12:19:23 -0400

CalicoIsUp Calico is running on this node

• member resource capacity; for example:

Capacity:

cpu: 24

ephemeral-storage: 67092472Ki

hugepages-1Gi: 0

hugepages-2Mi: 0
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memory: 64381888Ki

pods: 110

• running pods on the member; for example:

Namespace Name CPU Requests CPU Limits Memory Requests Memory Limits AGE

--------- ---- ------------ ---------- --------------- ------------- ---

default nginx-ingress-controller-8fj7s 100m (0%) 12 (37%) 500Mi (0%) 1000Mi (0%) 7h9m

default nspos-app1-tomcat-8597d67787-wdgxd 5100m (16%) 12100m (38%) 17230Mi (13%) 17230Mi (13%)

7h10m

default nspos-neo4j-core-default-1 2050m (6%) 2050m (6%) 2650Mi (2%) 2650Mi (2%) 7h10m

default nspos-postgresql-primary-0 6050m (19%) 6050m (19%) 1290Mi (1%) 1290Mi (1%) 7h9m

• resources allocated to the member; for example:

Resource Requests Limits

-------- -------- ------

cpu 22870m (71%) 41150m (129%)

memory 42120228Ki (32%) 44290630912 (33%)

ephemeral-storage 0 (0%) 0 (0%)

6.1.4 MDM server troubleshooting

This topic describes troubleshooting MDM instances.

Note: The NSP system must be operational before these operations can be performed.

Retrieve detailed information about MDM servers

From the NSP deployer host software directory, enter the following to show the MDM server roles,

the number of NEs managed using MDM, and which MDM server is hosting which NE.

# tools/mdm/bin/server-load.bash --user username --pass password--detail

where

username is the NSP username

password is the NSP password

The command output includes information such as the following:

{

"mdmInstanceInfos": [

{

"name": mdm-server-0,

"ipAddress": mdm-server-0.mdm-server-svc-headless.default.svc.

cluster.local,

"grpcPort": 30000,

"status": Up,

"neCount": 0,
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"neIds": null,

"active": False

"groupIds": [1, 2],

},

{

"name": mdm-server-1,

"ipAddress": mdm-server-1.mdm-server-svc-headless.default.svc.

cluster.local,

"grpcPort": 30000,

"status": Up,

"neCount": 2,

"neIds": ["1.1.1.1", "1.1.1.2"],

"active": True

"groupId": 1,

},

{

"name": mdm-server-2,

"ipAddress": mdm-server-2.mdm-server-svc-headless.default.svc.

cluster.local,

"grpcPort": 30000,

"status": Up,

"neCount": 2,

"neIds": ["1.1.1.3", "1.1.1.4"],

"active": True

"groupId": 2,

}

]

}

Rebalance NE load on MDM servers

From the NSP deployer host software directory, enter the following to rebalance the NE load on the

MDM servers.

# tools/mdm/bin/server-load.bash --user username --pass
password--rebalance

where
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username is the NSP username

password is the NSP password

6.1.5 Disk performance tests

This topic describes NSP disk tests for collecting performance metrics such as throughput and

latency measurements.

Verify disk performance for etcd

As the root user, enter the following:

# mkdir /var/lib/test

# fio --rw=write --ioengine=sync --fdatasync=1 --directory=/var/lib/test
--size=22m --bs=3200 --name=mytest ↵

The command produces output like the following:

Starting 1 process

mytest: Laying out IO file (1 file / 22MiB)

Jobs: 1 (f=1)

mytest: (groupid=0, jobs=1): err= 0: pid=40944: Mon Jun 15 10:23:23 2020

write: IOPS=7574, BW=16.6MiB/s (17.4MB/s)(21.0MiB/1324msec)

clat (usec): min=4, max=261, avg= 9.50, stdev= 4.11

lat (usec): min=4, max=262, avg= 9.67, stdev= 4.12

clat percentiles (nsec):

| 1.00th=[ 5536], 5.00th=[ 5728], 10.00th=[ 5920], 20.00th=[

6176],

| 30.00th=[ 7584], 40.00th=[ 8896], 50.00th=[ 9408], 60.00th=[

9792],

| 70.00th=[10432], 80.00th=[11584], 90.00th=[12864], 95.00th=

[14528],

| 99.00th=[20352], 99.50th=[23168], 99.90th=[28800], 99.95th=

[42752],

| 99.99th=[60672]

bw ( KiB/s): min=16868, max=17258, per=100.00%, avg=17063.00,

stdev=275.77, samples=2

iops : min= 7510, max= 7684, avg=7597.00, stdev=123.04,

samples=2

lat (usec) : 10=64.21%, 20=34.68%, 50=1.08%, 100=0.02%, 500=0.01%

In the second block of output, which is shown below, the 99th percentile durations must be less

than 10ms. In this block, each durations is less than 1ms.
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fsync/fdatasync/sync_file_range:

sync (usec): min=39, max=1174, avg=120.71, stdev=63.89

sync percentiles (usec):

| 1.00th=[ 42], 5.00th=[ 45], 10.00th=[ 46], 20.00th=[

48],

| 30.00th=[ 52], 40.00th=[ 71], 50.00th=[ 153], 60.00th=[

159],

| 70.00th=[ 167], 80.00th=[ 178], 90.00th=[ 192], 95.00th=[

206],

| 99.00th=[ 229], 99.50th=[ 239], 99.90th=[ 355], 99.95th=[
416],

| 99.99th=[ 445]

cpu : usr=2.95%, sys=29.93%, ctx=15663, majf=0, minf=35

IO depths : 1=200.0%, 2=0.0%, 4=0.0%, 8=0.0%, 16=0.0%, 32=0.0%,

>=64=0.0%

submit : 0=0.0%, 4=100.0%, 8=0.0%, 16=0.0%, 32=0.0%, 64=0.0%,

>=64=0.0%

complete : 0=0.0%, 4=100.0%, 8=0.0%, 16=0.0%, 32=0.0%, 64=0.0%,

>=64=0.0%

issued rwts: total=0,10029,0,0 short=10029,0,0,0 dropped=0,0,0,0

latency : target=0, window=0, percentile=100.00%, depth=1

Verify disk performance for NSP

Enter the following as the root user in the /opt/nsp directory to create a file called 'test' in the

directory:

# fio --randrepeat=1 --ioengine=libaio --direct=1 --gtod_reduce=1
--name=test --filename=random_read_write.fio --bs=4k --iodepth=64
--size=4G --readwrite=randrw --rwmixread=50 ↵

The command produces output like the following:

test: (g=0): rw=randrw, bs=(R) 4096B-4096B, (W) 4096B-4096B, (T)

4096B-4096B, ioengine=libaio, iodepth=64

fio-3.7

Starting 1 process

test: Laying out IO file (1 file / 4096MiB)

Jobs: 1 (f=1): [m(1)][100.0%][r=22.1MiB/s,w=22.2MiB/s][r=5645,w=5674

IOPS][eta 00m:00s]

test: (groupid=0, jobs=1): err= 0: pid=32439: Mon Sep 21 10:25:11 2020
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read: IOPS=6301, BW=24.6MiB/s (25.8MB/s)(2049MiB/83252msec)

bw ( KiB/s): min=13824, max=39088, per=99.57%, avg=25098.60,

stdev=5316.27, samples=166

iops : min= 3456, max= 9772, avg=6274.49, stdev=1329.11,

samples=166

write: IOPS=6293, BW=24.6MiB/s (25.8MB/s)(2047MiB/83252msec)

bw ( KiB/s): min=13464, max=40024, per=99.56%, avg=25062.73,

stdev=5334.65, samples=166

iops : min= 3366, max=10006, avg=6265.57, stdev=1333.67,

samples=166

cpu : usr=5.13%, sys=18.63%, ctx=202387, majf=0, minf=26

IO depths : 1=0.1%, 2=0.1%, 4=0.1%, 8=0.1%, 16=0.1%, 32=0.1%,

>=64=100.0%

submit : 0=0.0%, 4=100.0%, 8=0.0%, 16=0.0%, 32=0.0%, 64=0.0%,

>=64=0.0%

complete : 0=0.0%, 4=100.0%, 8=0.0%, 16=0.0%, 32=0.0%, 64=0.1%,

>=64=0.0%

issued rwts: total=524625,523951,0,0 short=0,0,0,0 dropped=0,0,0,0

latency : target=0, window=0, percentile=100.00%, depth=64

Run status group 0 (all jobs):

READ: bw=24.6MiB/s (25.8MB/s), 24.6MiB/s-24.6MiB/s (25.8MB/s-25.

8MB/s), io=2049MiB (2149MB), run=83252-83252msec

WRITE: bw=24.6MiB/s (25.8MB/s), 24.6MiB/s-24.6MiB/s (25.8MB/s-25.

8MB/s), io=2047MiB (2146MB), run=83252-83252msec

Disk stats (read/write):

vda: ios=523989/526042, merge=0/2218, ticks=3346204/1622070,

in_queue=4658999, util=96.06%

6.2 Intent Manager errors with CAS authentication

6.2.1 Description

If you are using legacy CAS authentication in NSP, you may encounter authorization errors when

using the Intent Manager application.

As a workaround for this problem, an Admin user can assign access permissions to Intent Manager

users through Keycloak:

1. Log into Keycloak: https://<NSP_system_IP_address>/auth - admin / <admin_password>

2. Ensure that the realm is set to Nokia.

3. Under the manager section, click on Users.
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4. Click on View All Users.

5. Click on the altiplano_admin user ID.

6. Click on Role Mappings.

7. Under Client Roles, click on NSP.

8. Select ALTIPLANO_ADMIN, ALTIPLANO_SYSTEM, ALTIPLANO_VIEWER, and SNMP_MGR_

SYSTEM.

9. Click Add Selected.

10. Restart the nsp-mdt-ac-0 pod.
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Part IV: Troubleshooting using NFM-P

Overview

Purpose

This part provides information about troubleshooting a managed network using the NFM-P.

Contents

Chapter 7, Troubleshooting using network alarms 99

Chapter 8, Troubleshooting services and connectivity 119

Chapter 9, Troubleshooting using the NE resync audit function 141

Chapter 10, Troubleshooting network management LAN issues 145

Chapter 11, Troubleshooting using NFM-P client GUI warning messages 151

Chapter 12, Troubleshooting with Problems Encountered forms 155

Chapter 13, Troubleshooting using the NFM-P user activity log 157

Troubleshooting using NFM-P NSP

Release 22.9
September 2022
Issue 1 97

© 2022 Nokia.
Use subject to Terms available at: www.nokia.com/terms

3HE-18817-AAAC-TQZZA

http://www.nokia.com/terms/


Troubleshooting using NFM-P NSP

© 2022 Nokia.
Use subject to Terms available at: www.nokia.com/terms

3HE-18817-AAAC-TQZZA

Release 22.9
September 2022

98 Issue 1

http://www.nokia.com/terms/


7 Troubleshooting using network alarms

7.1 Network alarms overview

7.1.1 The alarm handling process

Incoming alarms from network objects are displayed in the dynamic alarm list and are associated

with the affected objects. When the failure of an object affects a higher-level object, an alarm called

a correlated alarm is raised against the higher-level object. The original alarm is called the

correlating alarm. When a correlating alarm clears, the correlated alarms clear automatically.

An alarm can be raised in response to one or more network problems. To identify the root cause of

a problem, you must identify the root cause of individual alarms starting with alarms on the lowest-

level managed object. If the affected object is not the cause of the alarm, the problem may be found

on a related, supporting object below the lowest-level object in the alarm.

See the NSP Alarm Search Tool for information about a specific alarm. See the Fault Management

Application Help for information about NSP alarm management.

7.2 Process to troubleshoot using network alarms

7.2.1 Stages

1

View and monitor alarms using the dynamic alarm list or the navigation tree:

a. Use the alarm list to monitor alarms and sort them according to time received. See 7.3 “To

view and sort alarms in the alarm list” (p. 101) for more information.

b. Use the Service Supervision and Network Supervision applications to view object alarms and

navigate to affected objects. See the NSP User Guide for more information.

2

Categorize alarms by object hierarchy and identify the alarm that is lowest in the network object

hierarchy. See the Fault Management Application Help for more information.

3

Acknowledge alarms on the affected object and on the related problems. See the Fault

Management Application Help for more information.
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4

View detailed information about the alarm to determine the probable cause or root cause of the

problem. See the Fault Management Application Help for more information.

See the following sources of information:

• Fault Management application alarm list

• managed object hierarchy table

• alarm description tables in the NSP Alarm Search Tool

5

View the affected object information to determine the probable cause or root cause of the

problem. See 7.7 “To determine probable cause and root cause using alarm and affected

object information” (p. 107) for more information.

6

View related object information if the root cause is not found on the affected object. See 7.8 “To

determine root cause using related objects” (p. 108) for more information.

7

In the event of a service equipment problem which produces a series of alarms, assess the

alarms in the order that they are raised. See 7.10 “To troubleshoot a service equipment

problem” (p. 109) for more information.

8

If there is an equipment down alarm, use the equipment view of the navigation tree for more

information and check the physical connections to the port. See 7.11 “To clear alarms related

to an equipment problem” (p. 111) for more information.

9

In the event of an underlying port state problem which produces a series of alarms, assess the

alarms in the order that they are raised. See 7.12 “To troubleshoot an underlying port state

problem” (p. 111) for more information.

10

As required, clear the alarms related to the underlying port state problem. See 7.13 “To clear

alarms related to an underlying port state problem” (p. 114) for more information.

11

In the event of a service configuration problem which produces a series of alarms, assess the

alarms in the order that they are raised. See 7.14 “To troubleshoot a service configuration

problem” (p. 114) for more information.
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12

As required, clear alarms associated with SDP binding frame size problems. See 7.15 “To clear

a Frame Size Problem (MTU Mismatch) alarm” (p. 116) for more information.

13

As required, use the alarm description tables and the database of historical alarms to help

interpret the data and troubleshoot network problems.

7.3 To view and sort alarms in the alarm list

7.3.1 Purpose

Monitor the dynamic alarm list in the Fault Management application and attempt to address alarms

in the order that they are raised.

7.3.2 Steps

1

In the Fault Management application, click on the Alarm List tab to display the alarm list.

2

Click on the First Time Detected column heading to sort the alarms in ascending order

according to the first time the alarm was raised.

Multiple alarms received at approximately the same time indicate that the alarms may be

correlated and may have a common root cause. Review the alarms in the order in which they

are received. The alarm types, severity, and probable causes may provide the first indication of

the root cause of the problem.

3

Before you start to deal with each alarm systematically, determine the total alarm count so that

you can track your alarm-clearing progress. A count of each alarm type is displayed at the top

of the alarm list.

END OF STEPS
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7.4 To view object alarms and aggregated object alarms

7.4.1 Purpose

You can use the navigation tree to view object alarm status, and aggregated alarm status for parent

objects. See the NSP NFM-P User Guide for more information about the relationship between

objects, related alarms, and aggregated alarms.

Consider the following:

• When an aggregated alarm is indicated, and no object alarm is seen for any child object, change

the view of the equipment tree.

• An aggregated alarm may not appear in the selected view from the navigation tree. For example,

with the Equipment drop-down menu selected, a critical alarm aggregated against the device

object may appear. However, no object below the device object has a critical alarm. That is

because the critical alarm is aggregated from the network view of the router. The alarm is based

on the entire object, but the equipment view shows a subset of the entire object.

7.4.2 Steps

1

From the navigation tree, view alarms against objects. Alarms in circles are aggregated alarms.

Alarms in squares are object alarms.

2

Right click on the object in the navigation tree and choose Properties. The Properties form

appears.

3

Click on the Faults tab.

4

View object alarms from the Object Alarms tab. View aggregated alarms against a parent object

from the Aggregated Alarms tab.

To view the object on which the aggregated alarm was raised:

1. Choose an alarm from the aggregated alarms list.

2. Click View Alarm. The Alarm Info form appears.

3. Click View Alarmed Object. The Properties form for the object appears.

END OF STEPS
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7.5 To categorize alarms by object hierarchy

7.5.1 Steps

1

In the Fault Management application alarm list, click on the Object Type column to sort the

alarms alphabetically according to object type. If required, resize the column width to display

the full text.

2

Scroll through the alarm list to locate the object type that is the lowest level in the network

managed object hierarchy. Level 1 is the highest level, as listed in Table 7-1, “Hierarchy of

NFM-P-managed objects” (p. 102) .

If two or more objects in the alarm are at the same level, choose the alarm with the earliest

detected time. If two or more alarms at the same level are raised at the same time, use the

alarm information provided to determine which alarm may be closer to the root cause of the

problem and begin troubleshooting using this alarm.

Note: Alarm reporting latency can vary depending on network conditions. Therefore, the

First Time Detected stamp is not a reliable indication of the exact time an event occurred

and should be used only as an aid in troubleshooting.

3

If you need more information about an alarm, see the NSP Alarm Search Tool.
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Table 7-1 Hierarchy of NFM-P-managed objects

Level Managed object Domain (class)

— General network management or NFM-P objects Accounting (accounting)

Alarm mapping (trapmapper)

Anti-spoofing (antispoof)

Application assurance (isa)

APS (aps)

Auto-config (autoconfig)

Database (db)

DHCP (dhcp)

File policy (file)

Generic object (generic)

LI (mirrorli)

Mediation (mediation)

MLD (mld)

MSDP (msdp)

NE security (sitesec)

Policy (policy)

PPP (ppp)

RADIUS accounting (radiusaccounting)

Residential subscriber (ressubscr)

Schedule (schedule)

Scheduler (vs)

Security (security)

Server (server)

SNMP (snmp)

Software (sw)

Subscriber identification (subscrident)

Template (template)

VRRP (vrrp)
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Table 7-1 Hierarchy of NFM-P-managed objects (continued)

Level Managed object Domain (class)

1 Network CAC (cac)

CCAG (ccag)

Circuit emulation (circem)

IGH (igh)

IPsec (ipsec)

L2 (layer2)

L2 forwarding (l2fwd)

L3 forwarding (l3fwd)

LAG (lag)

Network (netw)

NE (rtr)

Multichassis (multichassis)

SRRP (srrp)

2 Service Aggregation scheduler (svq)

Epipe (epipe)

Ipipe (ipipe)

NAT (nat)

Resiliency (resiliency)

Service management (service)

Service mirror (mirror)

STM (sas)

VLANs (vlan)

VLL (vll)

VPLS (vpls)

VPRN (vprn)

3 SDP binding Service tunnel management (tunnelmgmt)

4 Tunnel Ethernet tunnel (ethernettunnel)

L2TP (l2tp)

MPLS (mpls)

Rules (rules)

Service tunnel (svt)
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Table 7-1 Hierarchy of NFM-P-managed objects (continued)

Level Managed object Domain (class)

5 LSP binding MPLS (mpls)

6 LSP

7 Session RSVP (rsvp)

8 LDP interface or targeted peer LDP (ldp)

9 Network interface BGP (bgp)

IGMP (igmp)

IS-IS (isis)

OSPF (ospf)

PIM (pim)

RIP (rip)

10 Physical equipment Equipment (equipment)

Ethernet equipment (ethernetequipment)

Ethernet OAM (ethernetoam)

GNE (genericne)

LPS (lps)

MPR (mpr)

RMON (rmon)

Wireless (radioequipment)

11 SONET / SDH bundle Bundle (bundle)

SONET SONET (sonet)

SONET port/channel SONET equipment (sonetequipment)

12 DS1 / E1 channel TDM equipment (tdmequipment)

END OF STEPS

7.6 To acknowledge alarms

7.6.1 Purpose

When you select an alarm to investigate the root cause, you should acknowledge the alarm and its

related problems to indicate that the problem is under investigation. This ensures that duplicate

resources are not applied to the same problem.
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7.6.2 Steps

1

Open the Fault Management application and select an alarm in any alarm list.

2

To acknowledge the selected alarm:

1. Click on the More button in the row for the selected alarm and choose Acknowledge

Alarm(s). The Alarm Acknowledgment form opens.

If required, add text in the Acknowledgment Text box or assign a new severity to the alarm.

2. Select the Acknowledgement check box and click OK.

3. Click OK.

END OF STEPS

7.7 To determine probable cause and root cause using alarm and
affected object information

7.7.1 Purpose

Alarms are raised against managed objects. Objects with alarms are called affected objects.

7.7.2 Steps

1

Open the Fault Management application and select an alarm from the alarm list. The Alarm Info

panel displays detailed information about the alarm.

The alarm cause indicates the probable cause, which can result from a problem on a related

object lower in the hierarchy, even though no alarms are reported against it. However, the

problem may be caused by the state conditions of the affected object itself.

2

To view the affected object states, click on the More button and select Show Affected Object.

a. If the Administrative State is Up and the Operational State is Down, there are two

possibilities:

• The affected object is the root cause of the problem. The alarm probable cause is the root

cause. See the NSP Alarm Search Tool for additional information about the alarm, which

may help to correct the problem. When the problem is fixed, all correlated alarms are

cleared. See 7.9 “Two-NE sample network” (p. 109) for a sample equipment problem.

• The affected object is not the root cause of the problem. The alarm probable cause does

not provide the root cause of the problem. The root cause is with a related, supporting

object that is lower in the managed object hierarchy. Perform 7.8 “To determine root cause

using related objects” (p. 108) to review related object information.
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b. If the Administrative State is Up and the Operational State is not Up or Down but states a

specific problem such as Not Ready or MTU Mismatch, this is the root cause of the alarm.

Correct the specified problem and all correlated alarms should clear. See 7.9 “Two-NE

sample network” (p. 109) for a sample configuration problem. If alarms still exist, perform

7.8 “To determine root cause using related objects” (p. 107).

c. If the object Administrative State is Down, it is not the root cause of the alarm on the object;

however, it may cause alarms higher in the network object hierarchy. Change the

Administrative State to Up. See 7.9 “Two-NE sample network” (p. 109) for a sample

underlying port state problem. This does not clear the alarm on the affected object that you

are investigating. Perform 7.8 “To determine root cause using related objects” (p. 107) to

review related object information.

END OF STEPS

7.8 To determine root cause using related objects

7.8.1 Steps

1

In the Fault Management application, select an alarm and click on Show Object Impacts.

2

Find the object type that is lowest in the network object hierarchy. See the object hierarchy in

Table 7-1, “Hierarchy of NFM-P-managed objects” (p. 104).

Through this process, you should find the lowest level managed object related to the object in

the alarm.

3

Check the States information. This information should point to the root cause of the alarm. The

problem should be found on the related, supporting object below the lowest level object in the

alarm.

If required, check the Administrative State of the supporting port objects. A port with

Administrative State Down does not generate alarms on the port, card, shelf, LAG, protocols, or

sessions, but generates network path and service alarms. If the Administrative State is Down,

change it to Up.

After the problem is fixed, the correlated alarms should automatically clear.

END OF STEPS

Troubleshooting using network alarms
To determine root cause using related objects

NSP

© 2022 Nokia.
Use subject to Terms available at: www.nokia.com/terms

3HE-18817-AAAC-TQZZA

Release 22.9
September 2022

108 Issue 1

http://www.nokia.com/terms/


7.9 Two-NE sample network

7.9.1 Two-NE network

The configuration below shows a two-NE example network configured with a VPLS that was used

to create problems and generate alarms. This configuration generates the maximum number of

alarms per problem type because alternate network paths are not available for self-healing.

The dynamic alarm list is used to troubleshoot the following types of problems that are created:

• physical port problem that causes an Equipment Down alarm

• underlying port state problem that causes a number of related alarms at the LSP level

• configuration problem that causes a Frame Size Problem alarm

7.10 To troubleshoot a service equipment problem

7.10.1 Pupose

An equipment problem in the example network in Figure 7-1, “Sample network” (p. 109) produces

a series of alarms. The following procedure provides an example of how to troubleshoot the

problem.

7.10.2 Steps

1

Review the alarms in the order that they are raised. When the First Time Detected column or

Last Time Detected column shows that the alarms are raised at approximately the same time, it

is a good indication that these alarms may be correlated.

2

Determine the total alarm count to track the alarm-clearing progress. Right-click on any column

heading in the dynamic alarm list. The contextual menu displays the alarm count.

3

Click on the Object Type column to sort the alarms alphabetically according to object type.

Figure 7-1 Sample network

Customer
access
ports

Customer
access
ports

1/1/4 1/1/4
LAG 1/1/2, 1/1/3

10.10.11.1/24

LAG 1/1/2, 1/1/3

10.10.11.2/24

BGP, OSPF, and MPLS are on each network interface.
17558

7750 SR
site ID
10.1.200.52/32

7750 SR
site ID
10.1.200.53/32
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4

Scroll through the dynamic alarm list and find the object type that is lowest in the network object

hierarchy, as listed in Table 7-1, “Hierarchy of NFM-P-managed objects” (p. 104).

In Figure 7-1, “Sample network” (p. 109), the lowest-level object type in the alarm list is

Physical Port in the equipment domain. There are four physical port objects in the alarm. Each

alarm has the same severity level.

5

Choose one of the physical port alarms and acknowledge the alarm.

In Figure 7-1, “Sample network” (p. 109), the alarm to investigate is one of the first two

detected Physical Port alarms: Port 1/1/2 on Site ID 10.1.200.52.

6

Select the alarms related to this affected object and acknowledge the alarms.

7

View alarm information for the affected object. Select the alarm in the list to view the information

in the Alarm Info panel.

8

Review the information about the alarm. In Figure 7-1, “Sample network” (p. 109):

• The Equipment Down alarm is a Physical Port alarm in the Equipment domain.

• The device at Site ID 10.1.200.52. raised the alarm on object Port 1/1/2.

• The alarm cause is inoperable equipment.

9

Check the port states.

In this case, the Administrative State is Up and the Operational State is Down, which results in

an alarm. The Operational state cannot be modified manually.

10

The root cause is indicated by the probable cause of alarm on the affected object: physical Port

1/1/2 at site ID 10.1.200.52 is inoperable.

The dynamic alarm list also indicates that a second port on site 10.1.200.52, Port 1/1/3, is

down. This port forms LAG 2 with port 1/1/2 and LAG 2 is down.

11

For equipment alarms, use the navigation tree view to identify the extent of the problem. Locate

ports 1/1/2 and 1/1/3 under the Shelf object that supports LAG 2 at Site 10.1.200.52. The state

for each port is operationally down. The tree view displays the aggregated alarms on objects up

to the Router level.
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A related LAG, LAG 1, is down but the alarms on LAG 2 ports were detected first.

END OF STEPS

7.11 To clear alarms related to an equipment problem

7.11.1 Purpose

This procedure describes how to clear the 22 alarms from the sample problem in 7.9 “Two-NE

sample network” (p. 109). The troubleshooting process determined that two physical ports in LAG 2

at Site 10.1.200.52. are operationally down.

7.11.2 Steps

1

Check the physical connection to the port. The physical inspection shows that the two port

connections supporting LAG 2 at Site 10.1.200.52. are not properly seated.

2

Seat the port connections. The 22 alarms, including the second two physical port Equipment

Down alarms on LAG 1, automatically clear.

END OF STEPS

7.12 To troubleshoot an underlying port state problem

7.12.1 Purpose

An underlying port state problem in the sample network in 7.9 “Two-NE sample network” (p. 109)

produces a series of alarms. The following procedure provides an example of how to troubleshoot

the problem.

7.12.2 Steps

1

The First Time Detected column shows that 16 alarms are raised at approximately the same

time, which is a good indication that these alarms may be correlated.

Note: The list contains an Lsp Down alarm and an Lsp Path Down alarm. Approximately

one half hour later, a second Lsp Down alarm and a second Lsp Path Down alarm were

raised for a total of 18 alarms.

2

Click on the Object Type column to sort the alarms alphabetically according to object type.
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3

Scroll through the alarm list and find the object type that is lowest in the network object

hierarchy, as listed in Table 7-1, “Hierarchy of NFM-P-managed objects” (p. 104).

In the sample network in Figure 7-1, “Sample network” (p. 109), the lowest-level object type in

the alarm list is Lsp Path in the Path/Routing Management domain. There are two Lsp Path

Down alarms. One was raised later than the other.

4

Choose the earlier Lsp Path alarm and acknowledge the alarm.

Note: Alarm reporting latency can vary depending on network conditions. Therefore, the

First Time Detected stamp is not a reliable indication of the exact time an event occurred

and should be used only as an aid in troubleshooting.

5

Choose the alarms related to this affected object and acknowledge those alarms. In this case,

the only alarm listed under Related Problems is the dynamic Lsp Down alarm.

6

View alarm information for the affected object. Select the alarm in the list to view the information

in the Alarm Info form.

7

Review the information about the alarm:

• Lsp Down is a path alarm on MPLS path 53 to 52.

• The affected object name and site name indicate that the alarm arose on the LSP path from

device/site 53 to site 52.

• The Site information identifies the site that raised the alarm. The root cause is related to the

device with Site Id 10.1.200.53.

8

Click View Alarmed Object and click Properties.

9

On the Alarm Info form, click Affected Object tab and then click Properties to view the state and

other information about the object in the alarm.

In the sample network in Figure 7-1, “Sample network” (p. 109), the Administrative State is Up

and the Operational State is Down, which results in an alarm. The Operational State cannot be

modified manually.

10

Check the additional information for the alarm, which in this case indicates that the root cause

may be a lower object in the managed object hierarchy.
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11

View the details from the Related tab on the Alarm Info form to display the managed objects

related to the object in alarm.

12

Find the object type that is lowest in the network object hierarchy, as listed in Table 7-1,

“Hierarchy of NFM-P-managed objects” (p. 104). The lowest level object is a LAG.

13

Open the equipment view of the navigation tree. It indicates that there are alarms related to

both existing LAGs (Site Id 10.1.200.52 and Site Id 10.1.200.53). However, there is no LAG

alarm in the dynamic alarm list and the LAG State is Up.

14

Check states of related, supporting objects for the lowest-level object in the alarm.

Underlying port states may propagate alarms higher up the managed object hierarchy without

causing alarms on ports, LAGs, interfaces, protocols, and sessions.

1. In the equipment view of the navigation tree, choose a port under the LAG on Router 53

(Site 10.1.200.53) and choose Properties. The LAG member properties form opens.

2. Click on the Port tab to view the underlying port state of the LAG member. The LAG

Member 1/1/2 properties form shows the Underlying Port State: Shut Down.

3. Repeat Step 14 2 for the second port. The LAG Member 1/1/3 properties form shows the

State: Up.

15

In the equipment view of the navigation tree, choose port 1/1/2 under the Shelf object that

supports LAG 1 (Site 10.1.200.53), and click Properties. The Properties form opens.

The form includes the following port information:

• Status is Admin Down.

• Operational State is Down

• Administrative State is Down

• Equipment Status is OK

• State: Link Down

There are no physical port equipment alarms. However, the port Status is Admin Down. This

indicates that the root problem is the port Administrative state. Perform 7.13 “To clear alarms

related to an underlying port state problem” (p. 114) to clear alarms related to an underlying

port state problems.

END OF STEPS
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7.13 To clear alarms related to an underlying port state problem

7.13.1 Purpose

This procedure describes how to clear the 16 alarms from the sample problem described in

7.9 “Two-NE sample network” (p. 109). The troubleshooting process determined that a port, which

supports LAG 1 at Site 10.1.200.53, is Down.

7.13.2 Steps

1

In the equipment view of the navigation tree, locate port 1/1/2 under the Shelf object supporting

LAG 1 at Site 10.1.200.53. The State is Admin Down.

2

Choose the port and choose Turn Up. Of the 18 alarms, 16 automatically clear. The remaining

two alarms are Session alarms.

3

In the Fault Management application, choose one of the remaining alarms in the alarm list and

choose Show Object Impacts.

4

Select an object and click Show Impacted Object to open the object properties form in the

NFM-P.

5

Click Resync. An Object Deleted notification appears and the alarm clears automatically.

6

Repeat Step 3 and Step 5 for the remaining alarm.

END OF STEPS

7.14 To troubleshoot a service configuration problem

7.14.1 Purpose

A service configuration problem in the sample network in 7.9 “Two-NE sample network” (p. 109)

produces a series of alarms. The following procedure provides an example of how to troubleshoot

the problem.
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7.14.2 Steps

1

Using the Fault Management application, review the alarms in the order that they were raised.

The First Time Detected column shows that three alarms were raised at the same time, which is

a good indication that these may be correlated.

2

Find the object in the Object Type column that is lowest in the network object hierarchy, as

shown in Table 7-1, “Hierarchy of NFM-P-managed objects” (p. 104). SDP binding is the lowest

object. There are two SDP binding alarms on 28-2.

3

Choose one of the two SDP binding alarms and acknowledge the alarm. In the sample network

in Figure 7-1, “Sample network” (p. 109), the selected alarm is the SDP binding alarm raised

against Site ID 10.1.200.53.

4

Select the alarms related to this affected object and acknowledge those alarms as described in

7.6 “To acknowledge alarms” (p. 106).

5

Double-click on the alarm in the list to view information for the affected object in the Alarm Info

form.

Review the information about the alarm:

• Affected object is SDP binding (formerly known as circuit).

• Alarm type is configuration alarm.

• Probable cause is frame size problem.

• Domain is Service Tunnel Management.

6

Click the Show Object Impacts, then click Show Impacted Object to determine the SDP binding

states.

• Administrative State is Up.

• Operational State is MTU Mismatch.

MTU Mismatch is the root cause of the Frame Size Problem alarm. You do not need to

investigate the related objects.
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7

Click on the Frame Size tab on the SDP binding object form to find more information about the

problem.

• The Max Frame Size Mismatch box is selected. The Max. Frame Size box shows a value

greater than the value in the Actual Tunnel Max Frame Size box.

• The maximum frame size configured exceeds the maximum frame size supported for the

service ingress and service egress termination points, which are also called the MTU.

8

See the NSP Alarm Search Tool for additional information about the Frame Size Problem alarm.

Perform 7.15 “To clear a Frame Size Problem (MTU Mismatch) alarm” (p. 115) to clear the

Frame Size Problem alarm.

END OF STEPS

7.15 To clear a Frame Size Problem (MTU Mismatch) alarm

7.15.1 Purpose

This procedure describes how to clear the SDP binding Frame Size Problem alarm described in

7.9 “Two-NE sample network” (p. 109).

7.15.2 Steps

1

Choose Manage→Service→Services from the NFM-P main menu.

2

Choose the service identified by the Alarmed Object Id in the Alarm Info form for the alarm that

you are trying to clear.

3

Click Properties. The Service form opens.

4

Click on the Sites tab. The list of available sites for the service appears.

5

Choose the site identified by the Site Id in the Alarm Info form for the alarm that you are trying

to clear.

6

Click Properties. The Site form opens.
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7

Change the MTU to a value less than 1492, for example, 1000.

8

Save your changes. The MTU configuration change is applied to customer, service, and site

objects. The SDP binding and related service alarms clear automatically.

END OF STEPS
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8 Troubleshooting services and connectivity

8.1 Service and connectivity diagnostics

8.1.1 STM OAM diagnostics for troubleshooting

This chapter documents how to troubleshoot service and general connectivity problems when there

is no associated alarm condition. See Chapter 7, “Troubleshooting using network alarms” for

information about troubleshooting a service using NFM-P alarms.

You can use the NFM-P Service Test Manager, or STM, OAM diagnostic tools for network

troubleshooting and for verifying compliance with SLAs. The STM provides the ability to group OAM

diagnostic tests into test suites for more comprehensive fault monitoring and troubleshooting. A test

suite can perform end-to-end testing of a customer service and the underlying network transport

elements. The use of test suites is especially valuable when multiple objects of the same type

require testing. Test suites can be scheduled to run on a regular basis to provide continual network

performance feedback. See the NSP NFM-P User Guide for information about using the STM and

creating scheduled tasks.

8.1.2 OAM diagnostics sample network

The configuration below shows a network that is used as an example for the OAM diagnostics

procedures in this chapter.

8.2 Workflow to troubleshoot a service or connectivity problem

8.2.1 Purpose

Perform the following tasks in sequence until you identify the root cause of the problem.

Figure 8-1 Sample network

Customer
access
ports

Customer
access
ports

1/1/2
10.10.12.1/24

1/1/1
10.10.10.1/24

1/1/1
10.10.12.2/24

1/1/1
10.10.10.2/24

Customer
access ports

1/1/4

1/1/4 1/1/4
LAG 1/1/2, 1/1/3

10.10.11.1/24

LAG 1/1/2, 1/1/3

10.10.11.2/24

BGP, OSPF, and MPLS are on each network interface.
17557

7750 SR
site ID
10.1.200.52/32

7750 SR
site ID
10.1.200.51/32

7750 SR
site ID
10.1.200.53/32
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8.2.2 Stages

1

Verify that there are no alarms associated with the service by clicking on the Faults tab in the

Service form.

a. If there are alarms that affect the service, see Chapter 7, “Troubleshooting using network

alarms”.

b. If there are no alarms that affect the service, see Stage 2.

2

If you are troubleshooting a VPLS service, determine whether it is part of an H-VPLS

configuration. See 8.3 “To identify whether a VPLS is part of an H-VPLS” (p. 122).

3

Verify whether the administrative and operational states of each component of the service are

Up; see 8.4 “To verify the operational and administrative states of service components”

(p. 122).

4

Verify the connectivity of the customer equipment using the entries in the FIB; see 8.5 “To

verify the FIB configuration” (p. 123).

5

Verify that the NFM-P service configuration aligns with the customer requirements. For

example, ensure that NFM-P configuration uses the correct service type and SAP configuration,

and that the circuit and site are included in the service.

6

Verify the connectivity of all egress points in the service:

a. using MAC Ping and MAC Trace; see 8.6 “To verify connectivity for all egress points in a

service using MAC Ping and MAC Trace” (p. 124).

b. using MEF MAC Ping; see 8.7 “To verify connectivity for all egress points in a service using

MEF MAC Ping” (p. 127).

7

Use the results from the MAC Ping and MAC Trace diagnostics to choose one of the following

options:

a.

If the MAC Ping, MEF MAC Ping, or MAC Trace diagnostics returned the expected results

for the configuration of your network:

1. Measure the frame transmission size on all objects associated with the service such as

the service sites, access and network ports, service tunnels, and circuits; see 8.8 “To
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measure frame transmission size on a service using MTU Ping” (p. 134).

2. Review the ACL filter policies to ensure that the ACL filter for the port is not excluding

packets that you want to test; see 8.13 “To review ACL filter properties” (p. 136).

3. Verify the QoS configuration.

b.

If the MAC Ping and MAC Trace diagnostics did not return the expected results for the

configuration of your network:

1. Verify the end-to-end connectivity on the service using the Service Site Ping diagnostic;

see 8.9 “To verify the end-to-end connectivity of a service using Service Site Ping”

(p. 129).

2. Verify the end-to-end connectivity on the service tunnel using the Tunnel Ping diagnostic;

see 8.10 “To verify the end-to-end connectivity of a service tunnel using Tunnel Ping”

(p. 131).

3. Verify the end-to-end connectivity of an MPLS LSP using the LSP Ping diagnostic; see

8.11 “To verify end-to-end connectivity of an MPLS LSP using LSP Ping” (p. 134).

c.

If the MAC Ping diagnostic returned the expected results for the configuration of your

network, and the MAC Trace diagnostic did not return the expected results for the

configuration of your network:

1. Verify that the correct service tunnels are used for the service.

2. Correct the service tunnel configuration, if required.

3. Review the route for the MPLS LSP using the LSP Trace OAM diagnostic. (For MPLS

encapsulation, only.) If the LSP Trace results do not meet the requirements of your

network, review the resource availability and configurations along the LSP expected

routes; see 8.12 “To review the route for an MPLS LSP using LSP Trace” (p. 135).

8

As required, perform one or more of the following.

a. Review ACL filter properties; see 8.13 “To review ACL filter properties” (p. 136).

b. View anti-spoof filters; see 8.14 “To view anti-spoof filters” (p. 137).

c. Retrieve MIB information from a GNE using the snmpDump utility; see 8.15 “To retrieve MIB

information from a GNE using the snmpDump utility” (p. 138).

9

Contact your technical support representative if the problem persists; see Chapter 1, “NSP

troubleshooting overview” .
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8.3 To identify whether a VPLS is part of an H-VPLS

8.3.1 Steps

1

Choose Manage→Service→Services from the NFM-P main menu.

2

Choose the service associated with the service problem.

3

Click Properties. The Service form opens.

4

Click on the Mesh SDP Bindings or Spoke SDP Bindings tab.

5

Drag and drop the Service ID, VC ID, and Service Type columns to first three positions on the

left side of the form.

6

Sort the list by VC ID.

If a VC ID has more than one unique Service ID, these services are involved in an H-VPLS

relationship.

a. If there are no alarms on the H-VPLS service, go to Stage 3 in 8.2 “Workflow to

troubleshoot a service or connectivity problem” (p. 119).

b. If there are alarms on the H-VPLS service, see Chapter 7, “Troubleshooting using network

alarms”.

Note: An alarm on a service can propagate across the services in the H-VPLS domain.

END OF STEPS

8.4 To verify the operational and administrative states of service
components

8.4.1 Steps

1

Open the service properties form.
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2

On the navigation tree, click on the site on which you want to verify the operational and

administrative states of service components; expand the entries for that site.

3

Click on the site. The service (Edit) form opens. Review the states for the site using the

Operational State and Administrative State parameters.

4

On the navigation tree, click on the L2 Access Interfaces, L3 Access Interfaces, and Mesh SDP

Bindings or Spoke SDP bindings objects to review the operational and administrative states for

the remaining components of the service.

5

Use the operation and administrative states of the service components to choose one of the

following options:

a. If the operational and administrative states for all service components are Up, go to Stage 4

in 8.2 “Workflow to troubleshoot a service or connectivity problem” (p. 119) .

b. If the operational state is Down and the administrative state is Up for one or more service

components, the NFM-P generates an alarm. You must investigate the root problem on the

underlying object. See Chapter 7, “Troubleshooting using network alarms” for more

information.

c. If the administrative state is Down for one or more service components, change the

administrative state to Up. Go to Step 7 .

6

If the service problem persists, another type of service problem may be present. Perform the

steps of the 8.2 “Workflow to troubleshoot a service or connectivity problem” (p. 119)

troubleshooting workflow.

7

If the workflow does not identify the problem with your service, contact your technical support

representative. See Chapter 1, “NSP troubleshooting overview” for more information.

END OF STEPS

8.5 To verify the FIB configuration

8.5.1 Purpose

This procedure describes how to verify the connectivity of customer equipment on the service

tunnel.
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8.5.2 Steps

1

Click on the L2 Access Interfaces tab on the Services (Edit) form. A list of L2 access interfaces

appears.

2

Double-click on a row in the list. The L2 Access Interface form appears.

3

Click on the Forwarding Control tab.

4

Click on the FIB Entries tab.

5

Click Resync.

a. If there is a list of FIB entries, confirm the number of entries with the customer configuration

requirement. If the configuration meets the customer requirement, go to Stage 5 in

8.2 “Workflow to troubleshoot a service or connectivity problem” (p. 119).

b. If there are no FIB entries, there is a configuration problem with the customer equipment or

the connection from the equipment to the service tunnel.

1. Confirm that the NFM-P service configuration aligns with the customer requirements.

2. Confirm that there are no problems with the customer equipment and associated

configuration.

6

If the service problem persists, another type of service problem may be present. Perform the

steps of the 8.2 “Workflow to troubleshoot a service or connectivity problem” (p. 119)

troubleshooting workflow.

7

If the workflow does not identify the problem with your service, contact your technical support

representative; see Chapter 1, “NSP troubleshooting overview”.

END OF STEPS

8.6 To verify connectivity for all egress points in a service using MAC
Ping and MAC Trace

8.6.1 Steps

1
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Choose Tools→Service Test Manager (STM) from the NFM-P main menu. The Manage Tests

form appears.

2

Click Create.

3

Choose L2 Service→Create MAC Ping from the Create contextual menu. The MAC Ping

(Create) form appears.

4

Clear the results from the previous diagnostic session from the Results tab, if necessary.

Note: You must use the MAC Ping and MAC Trace diagnostic to test the service in both

directions for the connection.

5

Configure the required parameters for the diagnostic session and run the diagnostic.

a. You can target the MAC broadcast address of FF-FF-FF-FF-FF-FF in the data plane to flood

the service domain and receive a response from all operational service access ports. Enter

the service ID for the VPLS or VLL service between the sites, and the sites you want to ping,

in this case, from site ID 10.1.200.51/32 to site IDs 10.1.200.52/32 and 10.1.200.53/32 using

the network in Figure 8-1, “Sample network” (p. 119).

Click on the Results tab to view the list of ping responses. Double-click on a row in the list to

view its details.

b. You can target the specific MAC address of a service site. Enter the target MAC address of

the specific site in the service that you want to ping, in this case, from site ID 10.1.200.51/32

to site ID 10.1.200.52/32 using the network in Figure 8-1, “Sample network” (p. 119).

Click on the Results tab to view the list of ping responses. Double-click on a row in the list to

view its details.

6

Review the results and assess whether the configuration meets the network requirements.

In particular, review the results in the Return Code column. The table below lists the displayed

messages.

Table 8-1 MAC Ping OAM diagnostic results

Displayed message Description

notApplicable (0) The OAM diagnostic message does not apply to the OAM diagnostic

performed.
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Table 8-1 MAC Ping OAM diagnostic results (continued)

Displayed message Description

fecEgress (1) The replying router is an egress for the FEC.

The far-end egress point exists and is operating correctly. No action

required.

fecNoMap (2) The replying router has no mapping for the FEC.

notDownstream (3) The replying router is not a downstream router.

downstream (4) The replying router is a downstream router, and the mapping for this FEC

on the router interface is the specified label.

downstreamNotLabel (5) The replying router is a downstream router, and the mapping for this FEC

on the router interface is not the specified label.

downstreamNotMac (6) The replying router is a downstream router, but it does not have the

specified MAC address.

downstreamNotMacFlood (7) The replying router is a downstream router, but it does not have the

specified MAC address and cannot flood the request to other routers.

malformedEchoRequest (8) The received echo request is malformed.

tlvNotUnderstood (9) One or more TLVs were not understood.

7

Click Create.

8

Choose L2 Service→Create MAC Trace from the Create contextual menu. The MAC Trace

(Create) form appears.

9

Configure the required parameters for the diagnostic session and run the diagnostic. A MAC

Trace shows the path, protocol, label, destination SAP, and hop count to the location of the

destination MAC. Enter the service ID for the VPLS or VLL service between the sites, and the

sites you want to trace, in this case, from site ID 10.1.200.51/32 to site IDs 10.1.200.52/32 and

10.1.200.53/32 using the network in Figure 8-1, “Sample network” (p. 119) .

Click on the Results tab to view the list of trace responses. Double-click on a row in the list to

view its details.

10

Review the diagnostic results and assess whether the configuration meets the network

requirements.

a. If MAC Ping and MAC Trace diagnostics returned the expected results for the configuration

of your network, go to Stage 7 a in 8.2 “Workflow to troubleshoot a service or connectivity

problem” (p. 119).

b. If MAC Ping and MAC Trace diagnostics did not return the expected results for the
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configuration of your network, go to Stage 7 b in 8.2 “Workflow to troubleshoot a service or

connectivity problem” (p. 119).

c. Go to Stage 7 c in 8.2 “Workflow to troubleshoot a service or connectivity problem” (p. 119)

if:

• MAC Ping diagnostic returned the expected result for the configuration of your network

• MAC Trace diagnostic did not return the expected result for the configuration of your

network

END OF STEPS

8.7 To verify connectivity for all egress points in a service using MEF
MAC Ping

8.7.1 Steps

1

Choose Tools→Service Test Manager (STM) from the NFM-P main menu. The Manage Tests

form appears.

2

Click Create.

3

Choose L2 Service→Create MEF MAC Ping from the Create contextual menu. The MEF MAC

Ping (Create) form appears.

4

Clear the results from the previous diagnostic session from the Results tab, if necessary.

Note: MEF MAC Ping must run simultaneously in both directions between the source and

destination VPLS sites.

5

Configure the required parameters for the diagnostic session and run the diagnostic.

You can target the specific MAC address of a service site. Enter the target MAC address of the

specific site in the service that you want to ping.

Click on the Results tab to view the list of ping responses. Double-click on a row in the list to

view its details.

6

Review the results and assess whether the configuration meets the network requirements.

In particular, review the results in the Return Code column. The table below lists the displayed

messages.
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Table 8-2 MEF MAC Ping OAM diagnostic results

Displayed message (return code) Description

responseReceived (1) A response was received on the device to the OAM diagnostic

performed.

requestTimedOut (5) The OAM diagnostic could not be completed because no reply

was received within the allocated timeout period.

7

Review the diagnostic results and assess whether the configuration meets the network

requirements.

a. If MEF MAC Ping diagnostics returned the expected results for the configuration of your

network, go to Stage 7 a in 8.2 “Workflow to troubleshoot a service or connectivity

problem” (p. 119).

END OF STEPS

8.8 To measure frame transmission size on a service using MTU Ping

8.8.1 Steps

1

Record the maximum frame transmission size for the service.

2

Choose Manage→Service Tunnels from the NFM-P main menu. The Manage Service Tunnels

form appears.

3

Filter to list only the source and destination routers of the service tunnel and click Search. The

list of service tunnels appears.

4

Double-click on a service tunnel from the list. The Tunnel (Edit) form appears.

5

Click on the Tests tab.

6

Click on the MTU Ping tab and click Create. The MTU Ping (Create) form appears with the

General tab selected. The form displays information about the service tunnel being tested and

the originating tunnel ID.
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Note: You must use the MTU Ping diagnostic to test the service in both directions for the

connection.

7

Configure the required parameters for the diagnostic session. Click on the Test Parameters tab

and enter the MTU value recorded in Step 1 for the MTU End Size (octets) parameter.

8

Run the diagnostic. The MTU Ping increments the datagram size until it fails to pass through

the SDP (service tunnel) data path, in this case, an MTU Ping from site ID 10.1.200.52/32 to

site ID 10.1.200.53/32 using the network in Figure 8-1, “Sample network” (p. 119).

Click on the Results tab to view the list of trace responses. Double-click on a row in the list to

view its details. The number of responses is determined by the incremental increase in

datagram size.

9

Review the diagnostic results and assess whether the configuration meets the network

requirements. Click on the Packets tab.

a. If the Status column displays Response Received for all circuits, the service tunnel supports

the configured frame transmission size for the circuit. Go to Stage 7 a 2 in 8.2 “Workflow

to troubleshoot a service or connectivity problem” (p. 119).

b. If the Status column displays Request Timed Out for any of the circuits, the transmission

failed at that frame size. If the frame size for the failure point is below the MTU value

configured for the service, the packets are truncating along the service route. Investigate the

cause of the truncated packets.

10

If the service problem persists, another type of service problem may be present. Perform the

steps of the troubleshooting workflow in this chapter.

11

If the troubleshooting workflow does not identify the problem with your service, contact your

technical support representative; see Chapter 1, “NSP troubleshooting overview”.

END OF STEPS

8.9 To verify the end-to-end connectivity of a service using Service
Site Ping

8.9.1 Steps

1

Choose Tools→Service Test Manager (STM) from the NFM-P main menu. The Manage Tests

form appears.
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2

Click Create.

3

Choose Service→Create Service Site Ping from the Create contextual menu. The Service site

ping (Create) form appears.

Note: You must use the Service Site Ping diagnostic to test the service in both directions

for the connection.

4

Configure the required parameters for the diagnostic session and run the diagnostic.

The originating service tunnel for the Service Site Ping is from site ID 10.1.200.51/32 to site ID

10.1.200.53/32, the other end of the service using the network in Figure 8-1, “Sample network”

(p. 119).

Click on the Results tab to view the list of trace responses. Double-click on a row in the list to

view its details.

5

Review the diagnostic results and assess whether the configuration meets the network

requirements. The table below lists the displayed messages.

Table 8-3 Service Site Ping OAM diagnostic results

Displayed message Description

Sent - Request Timeout The request timed out with a reply.

Sent - Request Terminated The request was not sent because the diagnostic was

terminated by the operator.

Sent - Reply Received The request was sent and a successful reply message was

received.

Not Sent - Non-Existent Service-ID The configured service ID does not exist.

Not Sent - Non-Existent SDP for Service There is no SDP for the service tested.

Not Sent - SDP For Service Down The SDP for the service is down.

Not Sent - Non-Existent Service Egress Label There is a service label mismatch between the originator and the

responder.

a. If the Service Site ping passes, the routes between the two sites are complete and in an

operational state. If the MAC Ping performed in 8.6 “To verify connectivity for all egress

points in a service using MAC Ping and MAC Trace” (p. 124) failed:

1. Investigate the status of the two SAPs used for the circuit.

2. Correct the configuration issue related to the SAPs, if required.
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If there is no configuration problem with the SAPs, the service problem is related to the

MAC addresses.

The MAC address problem could be caused by the:

• ACL MAC filter excluding the required MAC address

• external customer equipment

b. If the Service Site Ping fails, there is a loss of connectivity between the two sites.

1. Log in to one of the sites using the CLI.

2. Enter the following command:

ping <destination_site_ip_address> ↵

where <destination_site_ip_address> is the address of the other site in the route

If the CLI IP ping passes, go to Stage 7 b 2 of 8.2 “Workflow to troubleshoot a service

or connectivity problem” (p. 119).

6

Use the CLI to verify that the IP address of the destination site is in the routing table for the

originating site by entering:

show router route-table ↵

If the IP address for the destination site is not in the routing table for the originating site, there is

an L3 or L2 problem.

1. Verify that the appropriate protocols are enabled and operational on the two sites.

2. Verify the administrative and operational states of the underlying L2 equipment, for

example, ports and cards.

7

If the service problem persists, another type of service problem may be present. Perform the

steps 8.2 “Workflow to troubleshoot a service or connectivity problem” (p. 119).

8

If the troubleshooting workflow does not identify the problem with your service, contact your

technical support representative; see Chapter 1, “NSP troubleshooting overview”.

END OF STEPS

8.10 To verify the end-to-end connectivity of a service tunnel using
Tunnel Ping

8.10.1 Steps

1

Choose Manage→Service Tunnels from the NFM-P main menu. The Manage Service Tunnels

form appears.
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2

Filter to list only the source and destination routers of the service tunnel and click Search. The

list of service tunnels appears.

3

Double-click on a service tunnel from the list. The Tunnel (Edit) form appears.

4

Click on the Tests tab.

5

Click on the Tunnel Ping tab and click Create. The Tunnel Ping (Create) form appears with the

General tab displayed. The form displays information about the circuit being tested, including

the originating tunnel ID.

Note: You must use the Tunnel Ping diagnostic to test the service in both directions for

the connection.

6

Configure the required parameters for the diagnostic session as follows.

• The Return Tunnel parameter must specify the return tunnel ID number, because the tunnels

are unidirectional.

• From the Test Parameters tab, the Forwarding Class parameter must specify the forwarding

class for the service tunnel. Make sure that the forwarding classes for the service tunnels

map to the QoS parameters configured for customer services, such as VLL.

• The Number of Test Probes and Probe Interval parameters must be configured to send

multiple probes.

7

Run the diagnostic. Set the diagnostic configuration for a Tunnel Ping from site ID

10.1.200.51/32 to site ID 10.1.200.53/32 using the network in Figure 8-1, “Sample network”

(p. 119) , by specifying the return ID of the tunnel you want to test.

Click on the Results tab to view the list of trace responses. Double-click on a row in the list to

view its details. Double-click on the entry in the Tunnel Ping results form to view the diagnostic

details.

8

Review the diagnostic results and assess whether the configuration meets the network

requirements.

The table below lists the displayed messages.
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Table 8-4 Tunnel OAM diagnostic results

Displayed message Description

Request Timeout The request timed out with a reply.

Orig-SDP Non-Existent The request was not sent because the originating SDP does not exist.

Orig-SDP Admin-Down The request was not sent because the originating SDP administrative

state is Down.

Orig-SDP Oper-Down The request was not sent because the originating SDP operational

state is Down.

Request Terminated The operator terminated the request before a reply was received, or

before the timeout of the request occurred.

Far End: Originator-ID Invalid The request was received by the far-end, but the far-end indicates that

the originating SDP ID is invalid.

Far End: Responder-ID Invalid The request was received by the far-end, but the responder ID is not

the same destination SDP ID that was specified.

Far End:Resp-SDP Non-Existent The reply was received, but the return SDP ID used to respond to the

request does not exist.

Far End:Resp-SDP Invalid The reply was received, but the return SDP ID used to respond to the

request is invalid.

Far End:Resp-SDP Down The reply was received, but the return SDP ID indicates that the

administrative or operational state of the SDP is Down.

Success The tunnel is in service and working as expected. A reply was received

without any errors.

a. If the Tunnel Ping passes, the network objects below the tunnel are operating with no

performance issues.

b. If the Tunnel Ping fails, go to Stage 7 b 3 of 8.2 “Workflow to troubleshoot a service or

connectivity problem” (p. 119) to verify the end-to-end connectivity of services using MPLS

LSP paths, if required.

9

If the service problem persists, another type of service problem may be present. Perform the

steps of 8.2 “Workflow to troubleshoot a service or connectivity problem” (p. 119) .

10

If the troubleshooting workflow does not identify the problem with your service, contact your

technical support representative; see Chapter 1, “NSP troubleshooting overview”.

END OF STEPS
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8.11 To verify end-to-end connectivity of an MPLS LSP using LSP Ping

8.11.1 Steps

1

Choose Tools→Service Test Manager (STM) from the NFM-P main menu. The Manage Tests

form appears.

2

Click Create.

3

Choose MPLS→Create LSP Ping from the Create contextual menu. The LSP Ping (Create)

form appears.

Note: You must use the LSP Ping diagnostic to test the service in both directions for the

connection.

4

Configure the required parameters for the diagnostic session and run the diagnostic. Target an

LSP or an LSP path. Choose the MPLS site for the test, then configure the LSP you want to

ping that is associated with the MPLS site, in this case, an LSP Ping from site ID

10.1.200.51/32 to site ID 10.1.200.52/32 using the network in Figure 8-1, “Sample network”

(p. 119).

Click on the Results tab to view the list of trace responses. Double-click on a row in the list to

view its details. Double-click on the entry in the LSP Ping results form to view the diagnostic

details.

5

Review the diagnostic results and assess whether the configuration meets the network

requirements.

The table below lists the displayed messages.

Table 8-5 LSP Ping OAM diagnostic results

Displayed message Description

notApplicable (0) The OAM diagnostic message does not apply to the OAM diagnostic

performed.

fecEgress (1) The replying router is an egress for the FEC.

The far-end egress point exists and is operating correctly. No action required.

fecNoMap (2) The replying router has no mapping for the FEC.

notDownstream (3) The replying router is not a downstream router.
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Table 8-5 LSP Ping OAM diagnostic results (continued)

Displayed message Description

downstream (4) The replying router is a downstream router, and the mapping for this FEC on

the router interface is the specified label.

downstreamNotLabel (5) The replying router is a downstream router, and the mapping for this FEC on

the router interface is not the specified label.

downstreamNotMac (6) The replying router is a downstream router, but it does not have the specified

MAC address.

downstreamNotMacFlood (7) The replying router is a downstream router, but it does not have the specified

MAC address and cannot flood the request to other routers.

malformedEchoRequest (8) The received echo request is malformed.

tlvNotUnderstood (9) One or more TLVs were not understood.

a. If the LSP Ping passes, you have completed the workflow for troubleshooting services.

Contact your technical support representative if the problem persists; see Chapter 1, “NSP

troubleshooting overview”.

b. If the LSP Ping fails, verify the administrative and operational status of the underlying L2

equipment.

6

If the service problem persists, another type of service problem may be present. Perform the

steps of 8.2 “Workflow to troubleshoot a service or connectivity problem” (p. 119).

7

If the troubleshooting workflow does not identify the problem with your service, contact your

technical support representative; see Chapter 1, “NSP troubleshooting overview”.

END OF STEPS

8.12 To review the route for an MPLS LSP using LSP Trace

8.12.1 Steps

1

Choose Tools→Service Test Manager (STM) from the NFM-P main menu. The Manage Tests

form appears.

2

Click Create.

3

Choose MPLS→Create LSP Trace from the Create contextual menu. The LSP trace create

form appears.
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Note: You must use the LSP Trace diagnostic to test the service in both directions for the

connection.

4

Configure the required parameters for the diagnostic session and run the diagnostic. Target an

LSP, any LSP or an LSP path. Choose the MPLS site for the test, then configure the LSP or

LDP you want to trace that is associated with the MPLS site, in this case, an LSP Ping from site

ID 10.1.200.51/32 to site ID 10.1.200.52/32 using the network in Figure 8-1, “Sample network”

(p. 119).

Click on the Results tab to view the list of trace responses. Double-click on a row in the list to

view its details. Double-click on the entry in the LSP Trace results form to view the diagnostic

details.

5

Review the diagnostic results and assess whether the configuration meets the network

requirements.

a. If the LSP Trace returned the expected results for the configuration of your network, the

troubleshooting is complete.

b. If the LSP Trace did not return the expected results for the configuration of your network,

verify that the correct MPLS LSP is used for the service.

6

If the service problem persists, another type of service problem may be present. Perform the

steps of 8.2 “Workflow to troubleshoot a service or connectivity problem” (p. 119).

7

If the troubleshooting workflow does not identify the problem with your service, contact your

technical support representative; see Chapter 1, “NSP troubleshooting overview”.

END OF STEPS

8.13 To review ACL filter properties

8.13.1 Steps

1

Click on the L2 Access Interfaces or L3 Access Interfaces tabs on the Services (Edit) form. A list

of interfaces appears.

2

Double-click on a row in the list. The L2 or L3 Interface configuration form appears.
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3

Click on the ACL tab.

4

Review the ingress and egress filter configurations to ensure that ACL filtering configurations do

not interfere with the service traffic.

a. If there are no ACL filtering configurations that interfere with the service traffic, go to Stage 7

a 2 in 8.2 “Workflow to troubleshoot a service or connectivity problem” (p. 119).

b. If there are ACL filtering configurations that interfere with the service traffic, implement and

verify the solution for the service problem.

5

If the service problem persists, another type of service problem may be present. Perform the

steps of 8.2 “Workflow to troubleshoot a service or connectivity problem” (p. 119).

6

If the troubleshooting workflow does not identify the problem with your service, contact your

technical support representative; see Chapter 1, “NSP troubleshooting overview”.

END OF STEPS

8.14 To view anti-spoof filters

8.14.1 Purpose

If a host is having a problem connecting to the network, one possibility for the problem is dropped

packets as a result of anti-spoofing filters on the SAP. The NFM-P allows you to view the anti-spoof

filters currently in effect on a SAP.

Anti-spoof filters are frequently created and deleted in the network. As a result, the NFM-P does not

keep synchronized with the anti-spoof filters on the managed devices. However, the NFM-P allows

you to retrieve, on demand, the current anti-spoof filters for a SAP.

8.14.2 Steps

1

Select Manage→Service→Services from the NFM-P main menu. The Manage Services form

opens.

2

Select the service for which you want to view the anti-spoof filters.

3

Click Properties. The Service (Edit) form opens.
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4

Click on the L2 Access Interfaces or L3 Access Interfaces tab, depending on the service that

you selected.

5

Select an interface from the list and click Properties. The Access Interface (Edit) form opens.

6

Click on the Anti-Spoofing tab.

7

Click on the Filters tab.

8

Click Search to retrieve the current anti-spoof filters for the SAP. The Filters tab refreshes with a

list of the current anti-spoof filters.

END OF STEPS

8.15 To retrieve MIB information from a GNE using the snmpDump
utility

8.15.1 Purpose

Perform this procedure to export all object values from the NFM-P-supported SNMP MIBs on a

GNE. The exported information may help with troubleshooting the GNE configuration on the device

or in the NFM-P.

8.15.2 Steps

1

Log in to an NFM-P main server station as the nsp user.

2

Open a console window.

3

Navigate to the /opt/nsp/nfmp/server/nms/bin directory.

4

Enter the following:

./snmpDump.bash option_list ↵
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where option_list is one or more of the options listed in Table 8-6, “snmpDump .bash options”

(p. 138)

Note: Each option must be separated by a space, as shown in the following example:

snmpDump.bash -v 3 -h 192.168.18.77 -u jsmith -apw mypass -ppw yoda

If an option has a default value, the default value is included in the option description.

Table 8-6 snmpDump .bash options

Option Description

-v version The SNMP version in use on the GNE

Default: 2

-f file_name The output filename

Default: host-snmpDump.out in the current directory

-h host The IP address or hostname of the GNE

Default: localhost

-c community The SNMP community

-u v3_user The SNMPv3 user name

-e snmp_engine_ID The SNMP engine ID

-ap v3_auth_protocol The SNMPv3 authorization protocol, which can be MD5 or SHA

Default: MD5

-apw v3_auth_password The SNMPv3 authorization password

-ppw v3_privacy_password The SNMPv3 privacy password

-cn v3_context_name The SNMPv3 context name

-ci v3_context_ID The SNMPv3 context ID

-p port The TCP port on the main server that snmpDump must use to reach the GNE

Default: 161

-t timeout A communication timeout value

-r retries The number of times to retry connecting to the GNE

The utility displays status messages similar to the following as it initializes:

Init Products ...

Init ProductFamilyDefs ...

Init PollingDirectiveDefs ...

Start reading from Node ...

The utility then begins to retrieve the MIB tables. As It processes a MIB table, it lists the table

name and the number of entries the table contains, as shown below:

IF-MIB.ifEntry : 21

IP-MIB.ipAddrEntry : 5

MPLS-LSR-STD-MIB.mplsInterfaceEntry : 8

MPLS-TE-STD-MIB.mplsTunnelEntry : 0
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MPLS-TE-STD-MIB.mplsTunnelHopEntry : 0

MPLS-TE-STD-MIB.mplsTunnelARHopEntry : 0

MPLS-TE-STD-MIB.mplsTunnelCHopEntry : 0

MPLS-LDP-STD-MIB.mplsLdpEntityEntry : 3

MPLS-LDP-STD-MIB.mplsLdpEntityStatsEntry : 3

MPLS-LDP-STD-MIB.mplsLdpPeerEntry : 3

The utility is finished when the command prompt is displayed.

5

To view the utility output, open the file using a MIB browser or a text editor.

END OF STEPS
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9 Troubleshooting using the NE resync audit
function

9.1 NE resync auditing overview

9.1.1 Functional description

The NE resync audit function detects and reports differences between the NFM-P database version

of the NE configuration and the version stored on the NE. The NE resync audit manager displays a

list of misaligned parameters and values as represented in the NE and NFM-P databases, and

provides quick navigation to the affected object. A resync audit polls the NE in the same manner as

a standard full resynchronization, but instead of updating the objects in the NFM-P database, the

NFM-P compares the NE configuration retrieved by the resync with the NE configuration in the

NFM-P. See 9.3 “To perform an NE resync audit” (p. 142) for information about performing an NE

resync audit.

Differences identified during the audit are displayed in the Show Difference manager. In this

manager, you can navigate to the associated NE object that contains the difference and perform a

resync on that object to resolve the difference. You can access the results of one audit per NE in

the NE audit result list.

You can specify whether to include or ignore read-only parameters in a resync audit. Some read-

only parameters are set by the NE after a configuration change. Other read-only parameters, such

as temperature measurements and time stamps, change frequently on the NE and will often differ

from the values in the NFM-P database. Disabling the inclusion of read-only parameters can help

prevent cluttered audit results.

The difference entries that an NE resync audit returns are categorized as follows:

• Property Change—the value of a specific parameter is different in the NFM-P and NE databases

• Missing—the object and contained parameters exist in the NFM-P, but not on the NE

• Added—the object and contained parameters exist on the NE, but not in the NFM-P

9.1.2 Additional information

Consider the following information about NE resync audits:

• The NFM-P limits the audit result to 1 000 differences.

• NE resync audits only compare parameters that are synchronized with the NFM-P database.

Parameters that are stored in the NE database only and are not managed by the NFM-P are not

included in the audit report.

• NE resync audit results do not include statistics.

• NE resync audits cannot be used to deploy changes to an NE.

• You cannot perform a full resync from the NE audit manager or Show Differences form.

• Dynamic read-only objects and dynamic parameters are excluded from NE resync audits. For
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example, the following objects are excluded: LDP session, RSVP session, MPLS In Segment,

Out Segment, Cross Connect, MPLS Actual Hop and Actual Path, ISIS SPF Log.

9.2 Workflow for NE resync auditing

9.2.1 Stages

1

Perform NE resync auditing to identify specific object and parameter misalignment between an

NE and the NFM-P; see 9.3 “To perform an NE resync audit” (p. 141) .

2

View the results of NE resync audits and manage audit results; see 9.4 “To view NE resync

audit results using the NE audit manager” (p. 143) .

9.3 To perform an NE resync audit

9.3.1 Steps

1

Choose Equipment from the navigation tree view selector. The managed NEs are displayed.

2

Right-click on an NE and choose NE Resync Audit.

3

Enable the check box if you want to include read-only attributes in the audit and click Yes. The

NE Audit Result form appears and displays the NE Audit State as “in progress”.

Note: The NFM-P displays an error message and does not begin the resync audit if the

NE in unreachable.

4

When the audit completes, choose one of the following based on the NE Audit State:

a. If the NE Audit State displays “succeeded” and the NE Audit Result displays “misaligned”, go

to Step 5 .

b. If the NE Audit State displays “succeeded” and the NE Audit Result displays “aligned”, then

no further action is required.

c. If the NE Audit State displays “failed”, information about the failure is displayed in the Error

Messages panel. Click to expand the panel.
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5

Click Show Difference. The Show Difference form opens with a list of difference entries

displayed.

6

To resync a missing or added object, perform a full resync.

7

To resync a property change for a single object with the NFM-P:

1. Select a difference entry from the list. The panes at the bottom of the form display the

misaligned data for the entry.

2. Click Properties for the SAM Object. The Properties form of the object is displayed.

3. Click Resync.

4. Click Yes and wait for the object to resync with the NFM-P. The value of the misaligned

parameter changes if the resync operation is successful.

8

To save the results of the resync audit to an HTML or CSV file:

1. Right-click on a column header in the differences list and choose Save to File. The Save As

form is displayed.

2. Navigate to the required location on the client workstation and specify a file name.

3. Choose a file type and click Save.

9

Close the forms.

END OF STEPS

9.4 To view NE resync audit results using the NE audit manager

9.4.1 Purpose

You can use the NE audit manager to view the results of previous NE audits and delete audit

results.

9.4.2 Steps

1

Choose Administration→NE Maintenance→NE Audit Results from the NFM-P main menu. The

NE Audit Manager list form opens.
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2

To view an entry, select an entry from the list and click Show Difference. If there are results to

display, the Show Difference form opens.

3

To delete an entry:

1. Select an entry from the list and click Delete.

2. Click Yes. The entry is deleted.

4

Close the NE Audit Manager list form.

END OF STEPS
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10 Troubleshooting network management LAN issues

10.1 Problem: All network management domain stations experience
performance degradation

10.1.1 Steps

1

Verify that there is sufficient bandwidth between the elements of the network management

domain.

Bandwidth requirements vary depending on the type of management links set up, and the

number of devices in the managed networks. For information about network planning expertise,

contact your technical support representative.

See the NSP NFM-P Planning Guide for more information about the bandwidth requirements.

2

When you are using in-band management, ensure that the network devices used to transport

the management traffic are up. Ping each of the devices to ensure the management traffic can

flow along the in-band path.

In-band management uses a connection provided by a customer service, such as a VLL. The

management traffic is sent in-band along with the customer payload traffic. The packets with

the management data arrive at the device using one of the virtual interfaces.

END OF STEPS

10.2 Problem: Lost connectivity to one or more network management
domain stations

10.2.1 Purpose

Perform this procedure on a RHEL or Windows station to check the reachability of another station.

10.2.2 Steps

1

Log in to the station.

2

Open a console window.
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3

Enter the following:

ping station ↵

where station is the station hostname or IP address

4

To interrupt the ping operation, press Ctrl+C.

5

Review the output, which resembles the following when connectivity is good:

PING station: 56 data bytes

64 bytes from station (192.168.106.169): icmp_seq=1, time=1.0 ms

64 bytes from station (192.168.106.169): icmp_seq=2, time=0.3 ms

64 bytes from station (192.168.106.169): icmp_seq=3, time=0.2 ms

----station PING Statistics----

3 packets transmitted, 3 packets received, 0% packet loss

rtt (ms) min/avg/max = 0.2/0.7/1.0

6

If the packets arrive out of order, if some packets are dropped, or if some packets take too long

to complete the round trip, LAN congestion may be a problem. Contact your IT department or

check the physical LAN connectivity.

7

If you can ping the station, but are unable to connect to the station to perform a function, there

may be a problem with access to a function on the station.

If the NFM-P deployment includes a firewall, the firewall log entries are in the /var/log/

messages file on a RHEL station.

See 10.3.1 “Purpose” (p. 146) for information about how to verify the following:

• ports that need to be open across firewalls

• routing configuration

END OF STEPS

10.3 Problem: Another station can be pinged, but some functions are
unavailable

10.3.1 Purpose

Perform this procedure to determine whether port availability or routing is the cause of a

management domain LAN issue.
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The NFM-P uses TCP and UDP ports for communication between components. Some of the ports,

such as the SNMP trap port, are configured during installation. Other ports are configured

automatically by the NFM-P software.

10.3.2 Steps

1

Log in as the root user on a station in the network management domain.

2

Verify that the required ports are open or protected by a firewall. See the NSP NFM-P Planning

Guide for a complete list of the ports that the NFM-P requires and the purpose of each port.

Note: If you modify the port configuration, ensure that you record the changes for future

reference.

3

Perform the following steps to check the local routing configuration.:

1. Open a console window on a station in the management domain.

2. Use one of the following commands to determine the path to a destination:

• on a Windows station—tracert

• on a RHEL station—traceroute

The command uses ICMP echo request messages to list the near-side interfaces that

packets traverse between the source and destination stations. A near-side interface is the

interface closest to the source host.

3. Use OS commands such as netstat -r and arp -a to display a list of active TCP connections,

Ethernet statistics, the IP routing table, and the ports on which the station is listening.

END OF STEPS

10.4 Problem: Packet size and fragmentation issues

10.4.1 General information

Large packet sizes from the managed devices are being dropped by intermediate routers because

the packets exceed the device MTU or the devices are not configured to forward fragmented

packets, causing resynchronizations to fail. The managed devices are configured to send SNMP

packets of up to 9216 bytes. The NFM-P can accept such large SNMP packets.

However, the typical L2 or L3 interface MTU on an NFM-P-managed device is likely configured to

transmit smaller SNMP packets, usually in the 1500-byte range. This causes packet fragmentation.

In order to handle these fragmented packets, intermediate devices between the NFM-P-managed

device and NFM-P must be configured to handle or forward fragmented packets. When an
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intermediate network device, such as a router, cannot handle or forward fragmented packets, then

packets may be dropped and resynchronization may fail.

Consider the following:

• The network infrastructure that carries traffic between the NFM-P main and auxiliary servers and

the managed NEs must support fragmentation and reassembly of the UDP packets for NEs that

have an SNMP PDU size greater than the MTU configured for the network path between the NE

and NFM-P. The 7210 SAS, 7450 ESS, 7705 SAR, 7710 SR, 7750 SR MG, 7750 SR, and 7950

XRS require an SNMP PDU size of 9216 bytes and fragmentation support in the network path

between the NFM-P and the NE.

• Ensure that the CPM filters on managed devices are configured to accept fragmented packets,

and that this filter policy is configured on each server in a redundant NFM-P deployment.

• Ensure that devices located between the managed devices, such as the 7750 SR, and the

NFM-P can handle an MTU size of 9216 bytes, can fragment large SNMP packets, or can

forward fragmented L2 or L3 packets.

• Verify the MTU packet sizes for all LAN devices.

• Verify that large packets can travel from the managed devices to the NFM-P by using CLI to ping

the IP address of the NFM-P server, with a large packet.

• Ensure that the firewalls between the managed devices and the NFM-P server are configured to

allow traceroute and ping packets.

10.4.2 Steps

1

Log in to the 7750 SR or another NFM-P-managed device.

2

Run the traceroute command:

> traceroute SAM_server_IP_address ↵

A list of hops and IP addresses appears.

3

Ping the first hop in the route from the managed device to the NFM-P server:

> ping intermediate_device_IP_address size 9216 ↵

A successful response indicates that the intermediate device supports large SNMP packets or

packet fragmentation.

4

Repeat for all other hops until a ping fails or until a message indicates that there is an MTU

mismatch. A failed ping indicates that the intermediate device does not support large SNMP

packets or packet fragmentation.
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5

Check the configuration of the intermediate device, and configure fragmentation or enable a

larger MTU size.

END OF STEPS
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11 Troubleshooting using NFM-P client GUI warning
messages

11.1 Client GUI warning message overview

11.1.1 Warning message scenarios

Warning messages in the NFM-P client GUI provide an error recovery mechanism to inform you

when:

• information has been entered incorrectly

• additional information is required

• the operation you are attempting cannot be completed

• a change to a configuration sub-form is not committed until the parent form is committed

• an operation that may result in service disruption is requested

• a configuration form for an object is open that can potentially conflict with a previously opened

form

When an error condition is encountered that the NFM-P client has not anticipated, a Problems

Encountered form is displayed. See 12.1 “Overview” (p. 155) for more information.

You can use the client GUI to suppress warning messages within containing windows. See the NSP

NFM-P User Guide for more information.

11.1.2 Incorrect data entry

When incorrect information is entered for a parameter, a warning message that describes the error

is displayed. For example, when you configure a password for a site user, the value entered for the

Password parameter and the Confirm Password parameter must match. If they do not match, a

warning message is displayed.

11.1.3 Additional information required

When the value selected for a parameter has a condition that requires another parameter to be

configured, a warning message indicates the missing information that is required. For example,

when you configure a new or existing user with MD5 or SHA as the value for the Authentication

Protocol parameter, a password must be configured. If you do not configure a password, a warning

message is displayed.

The warning message indicates the information that is required. In this case, click OK to close the

dialog box, and configure the New Authentication Password and Confirm New Auth Password

parameters.

11.1.4 Unable to complete requested action

Warning messages are used to indicate that a specific action cannot be completed. These warnings

may occur when you try to create a new object or modify an existing object that results in an
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unsupported configuration. For example, the message “Can't bind LSP to a non-mpls service

tunnel“ indicates that you cannot bind an LSP to a service tunnel that is not configured with the

MPLS protocol.

These errors can be difficult to resolve and may require that you retrace your steps to determine the

cause of the warning. Check the documentation to ensure that you are following procedures

correctly.

11.1.5 Commitment of changes from a form and its sub-forms

From a configuration form, you can open sub-forms that require completion before you continue

with the parent form. For example, when you create a VLL service, the Create Service Site form

opens during one of the configuration steps. After you configure parameters in this sub-form and

click on the Finish button, a warning message is displayed.

Changes entered in the sub-form are not committed until you click OK or Apply on the parent form.

When you click OK or Apply on the parent form, a final confirmation is displayed.

When you click Yes for the last confirmation, the changes to the parent or sub-forms are committed.

11.1.6 Service disruption warning

A service disruption dialog box is displayed when you perform an action that may be service-

affecting. For example, if you attempt to shut down a daughter card, a warning message is

displayed.

As indicated by the warning message, the action you are about to perform may cause a disruption

to customer service because of a potential dependency that another object or service has on the

current object. Click View Dependencies to indicate the number of services that may be affected by

the action.

Verify that the requested action is appropriate. Click on the checkbox beside the statement “I

understand the implications of this action” to continue with the action.

11.1.7 Duplicate configuration form conflicts

There are multiple ways to access a configuration form for the same object. For example, you can

view the configuration form for a port by choosing Manage→Equipment, or you can access the port

by clicking on the port object in the expanded navigation tree. When you try to perform both

accesses, a warning message is displayed.

When this warning message is displayed, another form is open for the same object. When two

forms are open concurrently for the same object, there may be unexpected results because

changes committed from one form are not reflected in the other form.

11.2 To respond to a GUI warning message

11.2.1 Steps

1

Perform an action.
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A warning message dialog box opens. For example, when you configure a site password policy,

at least one authentication order must be specified as the default in order to configure the

authentication order parameters. If at least one authentication order is not configured, a

warning message is displayed.

2

After you read the warning message, click OK. The warning message dialog box closes.

3

Correct the problem based on the information provided.

4

If you cannot correct the problem and continue to get the same warning message:

a. Check the documentation to ensure that you are following the steps correctly.

b. Verify that you are trying to perform an action that is supported.

c. Review the general troubleshooting information in 1.2.4 “Checklist for identifying problems”

(p. 16) .

d. If you cannot resolve the problem, collect the logs identified in 2.2.7 “Use the Network

Health Dashboard to retrieve data about the health of a service and its components” (p. 39)

before you contact your technical support representative.

END OF STEPS
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12 Troubleshooting with Problems Encountered forms

12.1 Overview

12.1.1 The Problems Encountered form

The Problems Encountered form reports error conditions on the client software for which there are

no associated warning messages or when the client software cannot identify the problem.

Table 12-1 Problems Encountered form field descriptions

Field name Description

Class Specifies the object type that is the source of the problem

Operation Specifies the type of operation that was attempted when the problem occurred.

Affected Object Specifies the name of the affected object. Typically, if a Problems Encountered form appears when

you are trying to create a object, this field contains N/A because the object has not been created.

Description Specifies a short description of the problem, which may help you determine the cause of the problem

and how to correct the problem. For additional information, click on the Properties button. The

information may not be enough for you to correct the problem. The information can be used by your

technical support representative to help resolve the problem.

12.2 To view additional problem information

12.2.1 Steps

1

Choose an entry in the Problems Encountered form and click Properties.

2

Try to correct the problem based on the information provided. If you cannot correct the problem,

complete the procedure and perform 12.3 “To collect problem information for technical support”

(p. 156) .

3

Close the details form.

4

If there is more than one problem, repeat Step 1 to Step 3 .

Troubleshooting with Problems Encountered forms
Overview

NSP

Release 22.9
September 2022
Issue 1 155

© 2022 Nokia.
Use subject to Terms available at: www.nokia.com/terms

3HE-18817-AAAC-TQZZA

http://www.nokia.com/terms/


5

Close the form.

END OF STEPS

12.3 To collect problem information for technical support

12.3.1 Purpose

The following procedure describes what to do before you contact your technical support

representative when you cannot resolve a problem on the Problems Encountered form.

12.3.2 Steps

1

Review the problem information in the Problems Encountered form, as described in 12.2 “To

view additional problem information” (p. 155) .

2

Record the actions performed up to the point when the Problems Encountered form appeared.

For example, if you were trying to create a VLL service, record the details about the service that

you were trying to create.

3

Record the appropriate problem information, as described in Chapter 1, “NSP troubleshooting

overview” .

4

Collect logs for your support representative, as described in 2.2.7 “Use the Network Health

Dashboard to retrieve data about the health of a service and its components” (p. 39) .

END OF STEPS
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13 Troubleshooting using the NFM-P user activity log

13.1 Overview

13.1.1 Logging user activity

The NFM-P user activity log allows an operator to view information about the actions performed by

each NFM-P GUI and OSS user.

Note: An NFM-P operator with an Administrator scope of command role can view all user

activity log records except records associated with LI management. Viewing LI management

records requires the Lawful Intercept Management role.

You can use the User Activity form to do the following:

• List and view information about recent user activities.

• List and view information about recent user sessions and the actions performed during each

session.

• Navigate directly to the object of a user action.

• View NFM-P client session information that includes connection, disconnection, and

authentication failure events.

• View NFM-P server session information, that includes startup, shutdown, and access violation

events.

Note: The NFM-P also raises an alarm for a security-related event such as an authentication

failure or access violation.

You can navigate directly from an object properties form to a filtered list of the activities associated

with the object. See the NSP NFM-P User Guide for more information about the user activity log

and using the User Activity form.

Note: The User Activity form and related list forms do not refresh dynamically. To view the

latest log entries in a list form, you must click Search.

Each log entry has a request ID. There can be multiple log entries associated with a single request

ID. For example, the creation of a discovery rule that has multiple rule elements creates one log

entry for each rule element. You can use the request ID to sort and correlate the multiple log entries

associated with a single client operation.

13.2 To identify the user activity for a network object

13.2.1 Steps

1

Open the User Activity form.
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2

Click on the Activity tab.

3

Specify the filter criteria for the object and click Search. A list of user activity entries is

displayed.

4

View the State column values for the activities associated with the object. A value of Failure or

Timeout means that the action did not modify the object. A value of Success represents the

successful deployment of the configuration action.

5

To view a suspect entry, such as a failed or incorrect configuration attempt, select the required

entry and click Properties. The Activity form opens.

6

Use the activity information from one or more entries to determine whether a sequence of user

actions is the source of the problem.

7

Close the forms.

END OF STEPS

13.3 To identify the user activity for an NFM-P object

13.3.1 Steps

1

Open the User Activity form.

2

Click on the Activity tab.

3

Specify a Site Name of NONE as the filter criterion and click Search. A list of user activity

entries is displayed.

4

Sort the entries to locate the affected NFM-P object.
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5

View the State column values for the activities associated with the object. A value of Failure or

Timeout means that the action did not modify the object. A value of Success means that the

object modification succeeded.

6

To view an entry, select the required entry and click Properties. The Activity form opens.

7

Use the activity information from one or more entries to determine whether a sequence of user

actions is the source of the problem.

8

Close the forms.

END OF STEPS

13.4 To navigate to the object of a user action

13.4.1 Steps

1

Open the User Activity form.

2

Click on the Activity tab.

3

Specify the filter criteria, if required, and click Search. A list of user activity entries is displayed.

4

Select an entry and click Properties. The Activity form opens.

5

Click View Object. The object properties form opens.

6

Close the forms.

END OF STEPS
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13.5 To view the user activity records of an object

13.5.1 Steps

1

Open the required object properties form.

2

Click User Activity, or, if the button is not displayed, click More Actions and choose User Activity.

The User Activity form opens and displays a filtered list of user activity records associated with

the object.

3

To view an entry, select the entry and click Properties. The Activity form opens.

4

Close the forms.

END OF STEPS

13.6 To view the user activity performed during a user session

13.6.1 Steps

1

Open the User Activity form.

2

Specify the filter criteria, if required, and click Search. A list of user session entries is displayed.

3

Select an entry and click Properties. The Session form opens.

4

Click on the Activity tab.

5

Specify the filter criteria, if required, and click Search. A list of the actions performed by the user

during the session is displayed.

6

To view an entry, select the entry and click Properties. The Activity form opens.
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7

Close the forms.

END OF STEPS
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Part V: Troubleshooting the NFM-P platform

Overview

Purpose

This part provides information about troubleshooting the NFM-P platform, database, server, or

clients.

Contents

Chapter 14, Troubleshooting the NFM-P platform 165

Chapter 15, Troubleshooting using the LogViewer 173

Chapter 16, Troubleshooting the NFM-P database 199

Chapter 17, Troubleshooting NFM-P server issues 207

Chapter 18, Troubleshooting NFM-P clients 221
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14 Troubleshooting the NFM-P platform

14.1 To collect NFM-P log files

14.1.1 Purpose

Perform this procedure to collect the relevant log files for troubleshooting an NFM-P database,

server, single-user client or client delegate server station.

Note:When an NFM-P log file reaches a predetermined size, the NFM-P closes, compresses,

and renames the file to include a timestamp and sequence number in the following format:

EmsServer.yyyy-mm-dd_hh-mm-ss.n.log

During a system restart, NFM-P log files are backed up to directories that are named using a

timestamp. A component that runs for a long time can generate multiple log files. Before you

restart an NFM-P component, ensure that there is sufficient disk space to store the backup log

files.

14.1.2 Steps

1

To collect the logs for a problem specifically related to installation, perform the following steps.

1. Navigate to the installation directory, which is one of the following:

• NFM-P database—/opt/nsp/nfmp/db/install

• main server—/opt/nsp/nfmp/server

• auxiliary server—/opt/nsp/nfmp/auxserver

• single-user client— typically /opt/nsp/client on RHEL, and C:\nsp\client on Windows

• client delegate server—typically /opt/nsp/client on RHEL, and C:\nsp\client on Windows

2. Collect the following files:

• NFM-P_component.install.time.stderr.txt

• NFM-P_component.install.time.stdout.txt

• NFM-P_component_InstallLog.log

where

component is the NFM-P component type, such as Main_Server or Main_Database

time is the installation start time

3. Go to Step 7 .

2

If required, collect the NFM-P database logs.

1. Log on to the NFM-P database station as the Oracle management user.

2. Collect the following files:
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• /opt/nsp/nfmp/db/install/config/dbconfig.properties

• all files in /opt/nsp/nfmp/db/install/admin/diag/rdbms/instance/instance/alert

• all files in /opt/nsp/nfmp/db/install/admin/diag/rdbms/instance/instance/trace

• all files in /opt/nsp/nfmp/db/install/admin/diag/proxy

• all files with a .log extension in the following directories:

– /opt/nsp/nfmp/db/install

– /opt/nsp/nfmp/db/install/config

where instance is the database instance name, which is maindb1 in a standalone

deployment, or maindb1 or maindb2 in a redundant deployment

3

If required, collect the main or auxiliary server logs; the log files have a .log extension and are

in the following directories:

• main server—/opt/nsp/nfmp/server/nms/log

• auxiliary server—/opt/nsp/nfmp/auxserver/nms/log

4

If required, collect the RHEL single-user client or client delegate server log files:

• install_dir/nms/config/nms-client.xml

• all files and subdirectories in the install_dir/nms/log/client directory

where install_dir is the client software installation location, typically /opt/nsp/client

5

If required, collect the Windows single-user client or client delegate server log files:

• install_dir\nms\config\nms-client.xml

• all files and subdirectories in the install_dir\nms\log\client directory

where install_dir is the client software installation location, typically C:\nsp\client

6

If required, use a script to collect a comprehensive set of log files.

1. Log in to the station as the root user.

2. Open a console window.

3. Enter one of the following:

• On a main server station:

# /opt/nsp/nfmp/server/nms/bin/getDebugFiles.bash output_dir days
↵

• On an auxiliary server station:

# /opt/nsp/nfmp/auxserver/nms/bin/getDebugFiles.bash output_
dir days ↵
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• On an NFM-P database station:

# /opt/nsp/nfmp/db/install/getSAMDebugFiles.bash output_dir days ↵

• On an auxiliary database station:

# /opt/nsp/nfmp/auxdb/install/bin/getDebugFiles.bash output_dir
days ↵

where

output_dir is a local directory that is to contain the output files

days is the optional number of days for which to collect log files

Note:

You cannot specify /tmp, or any directory below /tmp, as the output directory.

4. Collect the output files:

Note:

On a station that hosts a collocated NFM-P database and main server, all files are present.

On a station in a distributed deployment, only two files are present.

• hostname_date.WsInfoFiles.checksum.tar.gz

Contains station-specific information such as the hardware and network configuration

• hostname_date.ServerLogFiles.checksum.tar.gz

Contains server and JBoss logs, and configuration information

• hostname_date.DBLogFiles.checksum.tar.gz

Contains NFM-P database logs and configuration information

7

Store the files in a secure location to ensure that the files are not overwritten. For example, if

two NFM-P clients have problems, rename the files to identify each client and to prevent the

overwrite of one file with another of the same name.

8

Send the files to technical support, as required.

END OF STEPS

14.2 Problem: Poor performance on a RHEL station

14.2.1 Checking CPU performance

When a RHEL station is taking too long to perform a task, you can check the CPU status to ensure

that one process is not using most of the CPU resources, and then use commands to review the

CPU usage.

Perform this procedure when CPU usage remains high and performance degrades.

You can also perform other procedures to monitor performance: If you are you performing a large

listing operation using the NFM-P client GUI or OSS, check the LAN throughput using the netstat

command, as described in 18.3 “Problem: Delayed server response to client activity” (p. 223).
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14.2.2 Steps

1

Log on to the station as the root user.

2

Open a console window.

3

Perform the following steps to check for processes that are consuming excessive CPU cycles:

1. To list the top CPU processes using the UNIX utility prstat, type:

# top ↵

Depending on your system configuration, approximately the top 20 processes are

displayed.

2. Review the output.

The top NFM-P process in the CPU column should be the Java process. However, the Java

process should not consume too much CPU time. Some Oracle processes may also

consume CPU time, depending on the database load.

3. Press Ctrl-C to stop the command.

4

Perform the following steps to view a CPU activity summary.

1. Enter the following command:

# mpstat time ↵

where time is the interval, in seconds, between CPU polls; a value between 10 and 60 is

recommended

2. Review the command output.

mpstat output example
CPU %usr %nice %sys %iowait %irq %soft %steal %
guest %idle
all 0.25 0.00 0.17 0.00 0.00 0.00 0.00 0.
00 99.58
all 0.50 0.00 0.08 0.08 0.00 0.00 0.00 0.
00 99.33
all 0.17 0.00 0.08 0.00 0.00 0.00 0.00 0.
00 99.75
all 0.25 0.00 0.17 0.08 0.00 0.00 0.00 0.
00 99.50
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mpstat field descriptions

Field Description (events per second unless noted)

CPU Processor number; the keyword all indicates that statistics are calculated as averages

among all processors

%usr Percentage of CPU utilization at the user application level

%nice Percentage of CPU utilization at the user level with nice priority

%sys Percentage of CPU utilization at the system level; does not include time spent servicing

hardware and software interrupts

%iowait Percentage of CPU idle time during which the system had an outstanding disk I/O request

%irq Percentage of CPU time spent servicing hardware interrupts

%soft Percentage of CPU time spent servicing software interrupts

%steal Percentage of time spent in involuntary wait by the virtual CPU or CPUs during hypervisor

servicing of another virtual processor

%guest Percentage of CPU time spent running a virtual processor

%idle Percentage of CPU idle time without an outstanding disk I/O request

Review the %usr, %sys and %idle statistics, which together indicate the level of CPU

saturation. A Java application that fully uses the CPUs typically falls within 80 to 90 percent

of the %usr value, and 20 to 10 percent of the %sys value. A smaller percentage for the

%sys value indicates that more time is being spent running user code, which generally

results in better execution of the application.

3. Press Ctrl-C to stop the command.

5

If processes are competing for CPU resources, perform the following steps to isolate the

information about a single process.

1. Check the state of CPUs by typing:

ps -aux ↵

A list of processes is displayed.

2. Review the command output.

For CPU troubleshooting, the important data is listed in the %CPU row. If a process is

taking 90% or more of the CPU resources, there may be a problem with the process.

Contact your account or technical support representative for more information.

3. Press Ctrl-C to stop the command.

6

Contact technical support and provide the data obtained in the previous procedure steps.

END OF STEPS
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14.3 Problem: Device discovery fails because of exceeded ARP cache

14.3.1 ARP cache and /var/log/messages

When an NFM-P system manages a large number of NEs in a broadcast domain, the ARP cache

on a main server station may fill and prevent the discovery of additional devices. When this

happens, the /var/log/messages file contains entries like the following:

Jan 21 09:37:40 hostname kernel: Neighbour table overflow

Jan 21 09:37:40 hostname kernel: Neighbour table overflow

Jan 21 09:37:40 hostname kernel: Neighbour table overflow

Jan 21 09:38:00 hostname kernel: __ratelimit:190 callbacks suppressed

Perform this procedure when one of the following occurs:

• The /var/log/messages file contains more than 1024 entries like the example entries above.

• You need to increase the ARP cache size to accommodate the network.

The default ARP cache threshold values are the following:

• Threshold 1—128

• Threshold 2—512

• Threshold 3—1024

14.3.2 Steps

1

Log in to the main server station as the root user.

2

Open a console window.

3

Perform one of the following to increase the ARP cache thresholds.

a. To temporarily increase the thresholds, type the following:

# echo 8096 > /proc/sys/net/ipv4/neigh/default/gc_thresh1 ↵

# echo 25600 > /proc/sys/net/ipv4/neigh/default/gc_thresh2 ↵

# echo 32384 > /proc/sys/net/ipv4/neigh/default/gc_thresh3 ↵

b. To permanently override the default thresholds, perform the following steps.

1. Open the /etc/sysctl.conf file using a plain-text editor such as vi.

2. Add the following lines to the end of the file:

net.ipv4.neigh.default.gc_thresh1 = 8096
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net.ipv4.neigh.default.gc_thresh2 = 25600

net.ipv4.neigh.default.gc_thresh3 = 32384

3. Save and close the file.

4. Enter the following:

# sysctl -p ↵

4

Close the console window.

END OF STEPS
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15 Troubleshooting using the LogViewer

15.1 LogViewer overview

15.1.1 Managing log files

The LogViewer is a system monitoring and troubleshooting utility that parses, formats, and displays

the contents of log files.

You can use LogViewer to perform the following:

• View and filter real-time log updates.

• View, filter, and sort the entries in a static log view.

• Open compressed or uncompressed log files.

• Compare active logs in real time.

• Automatically send a notification when a specified type of entry is logged.

LogViewer is available on NFM-P main or auxiliary server stations, and on single-user client and

client delegate server stations as separate GUI and CLI utilities. The GUI has more functions than

the CLI, which is designed for use on a character-based console over a low-bandwidth connection

such as a Telnet session.

LogViewer can interpret various log formats. The log files must be local server or database logs.

15.1.2 Configuration

The LogViewer GUI and CLI utilities share a set of configuration options; an option change by one

utility affects the other utility. Some options apply only to the GUI.

You can customize LogViewer by creating and saving log filters and log profiles that are available to

all GUI and CLI users, and can save the GUI configuration, or workspace, to have LogViewer

display the currently open logs the next time it starts. LogViewer does not save the current filter and

display configuration for a log when you close the log unless you export the configuration to a log

profile.

Your operating configuration of LogViewer is stored in the user directory. Any filters, fonts, colors, or

other preferences you have set such as location, size and splitter location, are used the next time

you start the utility.

For multiple instances of LogViewer running on the same server, you can set the system

environment variable LOGV_HOME to make all instances use the same properties file. In this way,

properties such as filters, window location, and window size are common to all instances.

15.1.3 Filters

You can use the LogViewer CLI or GUI to create multiple filters that define the log entries that are

displayed in a log view. A filter uses Java regular expressions as match criteria to specify which

entries to display and optionally uses colors to identify the filtered entries.
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15.1.4 Plug-ins

LogViewer supports the use of plug-ins to provide additional functionality. You can specify a plug-in

for use with a specific log, or assign a default plug-in configuration that applies to the subsequently

opened logs.

LogViewer has default plug-ins that can send notifications, such as e-mail messages and GUI pop-

ups, when a new log entry matches a set of filter criteria. The LogViewer e-mail plug-in uses SMTP

as the transport.

15.2 LogViewer GUI and Quick Links panel

15.2.1 Accessing log entries

The LogViewer GUI opens to display a Quick Links panel that has shortcuts to the logs that are

present on the local file system. When you click on a log shortcut, LogViewer opens a tab that

displays the most recent log entries.

Note: If you hover your mouse cursor over a GUI tab, toolbar button, or field, a description or

configuration instruction specific to that object appears.

15.2.2 LogViewer GUI and log tabs

Each log that you open using the LogViewer GUI is displayed on a separate tab whose label

contains the name of the log profile and an icon that indicates the log type. The log entries are

highlighted using the colors configured for the log debug levels. A log tab that displays dynamic log

updates also has a tool bar for common operations.

The lower panel of a log tab contains the following sub-tabs:

• Preview—displays the unparsed log-file text for the currently selected log entries

• Filter—lists and permits management of the currently active filters for the log

• Status—displays status information about the current log

• Plugin—displays information about the plug-ins associated with the log

• Legend—displays a legend that correlates log file names to the numbers in the File column on a

log tab that contains multiple open logs, for example, merged logs; is not shown for log

comparisons

The LogViewer GUI allows you to drag and drop a log file into the GUI window. If you drop a file

onto an open log tab, LogViewer provides options such as merging or comparing the log with

another.

You can open a tab to list static log entries, such as the contents of an archived log or a snapshot of

entries from an active log, and can pause the updates to active logs. The GUI also includes a text-

search function.

GUI-based log filtering

The GUI provides a Filter Manager applet that lists the filters defined using the CLI or GUI and

allows filter creation, modification, and deletion. A GUI operator can also use Filter Manager to test

the regular expressions as filter match criteria.
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To rapidly isolate a specific log entry or type of entry, you can create a temporary filter, or quick

filter, by entering a regular expression in the field below a column header on a log tab. You can

convert a quick filter to a saved filter for later use. A drop-down menu above the Level column

allows the immediate filtering of log entries based on the debug level.

You can also create and use simple filters. These filters do not require the use of regular

expressions, but instead, perform a case insensitive “contains” filtration of a string you specify. The

use of simple filters must be enabled using the Preferences→Options menu option.

A color that is specified as the highlight color for a filter is saved with the filter and applies to all logs

that use the filter.

15.3 LogViewer CLI

15.3.1 Accessing log entries using the CLI

The CLI-based LogViewer works like the UNIX tail command when in display mode. The command

mode has a multiple-level menu that you can display at any time. You can specify a command or

log file using the minimum number of unique characters in the name, and can quickly toggle

between the command and display modes. LogViewer buffers new log entries while in command

mode and displays them when it returns to display mode.

The LogViewer CLI assigns a different color to each logging level, for example, WARN or INFO,

using standard ANSI color attributes that can be specified as CLI startup options or configured

through the GUI. The CLI also supports the use of filters, plugins, and quick links.

15.4 To display logs using the LogViewer GUI

15.4.1 Purpose

Perform this procedure to start the LogViewer GUI utility and view one or more logs. Move the

mouse cursor over a GUI object to view a description of the object, for example, a tool bar button.

15.4.2 Steps

1

Log in to a station as the nsp user.

2

Open a console window.

3

Enter the following:

bash$ /opt/nsp/nfmp/server/nms/bin/logviewerui.bash ↵

The LogViewer GUI opens with the Quick Links panel or the log tabs in the saved workspace

displayed.
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4

To open a log file, perform one of the following:

a. If the Quick Links panel is displayed, click on a link to view the associated log file.

b. Choose Quick Links→log_name from the LogViewer main menu.

c. To open a recently viewed log, choose File→Recent Logs→log_file_name from the

LogViewer main menu.

d. To browse for a log file, perform the following steps:

1. Choose File→Local Log File from the LogViewer main menu or click Open log in the main

tool bar. The Local Log File form opens.

2. Use the form to navigate to the log-file location.

3. Select a log file and click Add between the form panels. The log is listed in the panel on

the right.

Note:

The log file can be in compressed or uncompressed format.

4. If LogViewer cannot determine the type of log that the file contains, for example, if a log

file is renamed, it sets the Type to Other. Use the Type drop-down menu to specify the log

type, if required.

5. Configure the Max. Messages parameter to specify the maximum number of entries that

are listed on the log tab. LogViewer removes the oldest entries as required to keep the

number of entries at or below this value.

6. Configure the Auto-Tail parameter to specify whether the log tab dynamically displays the

log updates.

7. Click OK. The Local Log File form closes.

e. Drag and drop a log file into a section of the LogViewer main window that does not contain a

log tab.

f. Drag and drop a log file onto a log tab in the LogViewer main window. The Add File form

opens.

Perform the following steps:

1. Choose one of the following options:

• New View—specifies that the log is displayed on a new log tab

• Replace Existing File—specifies that the log tab displays the new log instead of the

current log

• Add to View—specifies that the entries in the new log and the entries in the current log

are merged into one list on the same log tab

• Add to Compare View—specifies that the new log is to be displayed on the same log

tab as the current log in a separate panel for comparison

2. Click OK. The new log is displayed as specified.

A log tab opens to display the most recent entries in a log. If the log is active and the Auto-

Tail parameter is enabled, the list scrolls upward to display new log entries as they are

generated.
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Note: The Auto-Tail parameter for a log is enabled by default.

Common display operations

5

To specify which columns are displayed on a log tab, right-click on a column header, and select

or deselect the column names in the contextual menu, as required.

6

To reposition a column, drag the column title bar to the desired position, or right-click on the

column header and choose Move Left or Move Right.

7

To view the raw log-file text of one or more entries, select the entries. The entry text is

displayed on the Preview sub-tab.

8

To restrict the list of displayed entries to a specific debug level, choose a debug level from the

drop-down menu under the Level column header.

9

To find log entries that contain a specific text string:

1. Choose Edit→Find from the LogViewer main menu. The Find form opens.

2. Specify a text string to search for using the text field and search options on the form.

Note:

The LogViewer Find function does not support the use of regular expressions. To perform a

search using a regular expression, use the Find In Path function, as described in 15.6 “To

search log files in a path” (p. 183).

3. Click Find, as required, to find the next list entry that contains the text string.

4. To find all list entries that contain the text string, click Find All. The Find form closes and a

new log tab opens to display the result of the search.

5. Close the Find form if it is open.

Note:

After you close the Find form, you can use the F3 key or the Find next button on the main

tool bar to perform repeated find operations for the same text string on the same log tab.

10

To remove one or more log entries from the current view, perform one of the following.

a. To clear all listed log entries, choose Log→Clear All Events from the LogViewer main menu,

or click Clear all in the main tool bar.

b. To clear the currently selected log entries, choose Log→Clear Selected Events from the
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LogViewer main menu, or click Clear Selected in the main tool bar.

c. To clear all log entries that match the currently selected cell, select a cell and choose

Log→Hide All Like Selected from the LogViewer main menu, or click Hide All Like Selected

in the main tool bar.

d. To show only log entries that match the currently selected cell, select a cell and choose

Log→Show All Like Selected from the LogViewer main menu, or click Show All Like Selected

in the main tool bar.

11

To apply a quick filter, enter a regular expression as a match criterion in the field below a

column header and press ↵. The list is cleared, and only subsequent log entries that match the

criterion are displayed; see 15.10 “To manage filters using the GUI Filter Manager” (p. 187) .

12

Repeat Step 11 to apply an additional quick filter, if required.

13

To apply a saved filter:

1. Choose Log→Add Filter from the LogViewer main menu, or click Add filter in the main tool

bar. The Select Filters form opens.

2. Select one or more filters in the list and click OK. The filters are applied to the log view and

are listed on the Filters sub-tab of the log tab.

See 15.10 “To manage filters using the GUI Filter Manager” (p. 187) for information about

creating saved filters.

14

To remove a filter from the log, select the filter in the Filter sub-tab and choose Log→Remove

Selected Filters, or click Remove filter in the main tool bar.

15

If the log display is static, such as for an archived log or the result of a Find All operation, go to

Step 22.

Dynamic view operations

16

To edit the log display properties, choose Edit→Edit Log from the LogViewer main menu, or

click Edit log in the log tab tool bar, and perform the following steps.

1. Configure the Max. Messages parameter to specify the maximum number of entries that

are listed on the log tab. LogViewer removes the oldest entries as required to keep the

number of entries at or below this value.
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2. Configure the Auto-Tail parameter to specify whether the log tab dynamically displays the

log updates.

3. Click OK to close the Local Log File form.

17

To pause the display of log-file updates, choose Log→Pause from the LogViewer main menu,

or click Pause log updates in the log tab tool bar.

18

To resume the display of log-file updates, choose Log→Initialize Connection from the

LogViewer main menu, or click Initialize log updates in the log tab tool bar.

19

By default, a dynamic log view focuses on a new log entry. To focus the display on an earlier log

entry and prevent the display from automatically focusing on a new log update, click Follow

latest updates in the log tab tool bar. Click on the button again to enable the default behavior.

20

To compare logs in real time:

1. Choose Log→Specify Compare from the LogViewer main menu, or click Add log to

compare on the log tab tool bar. The Compare Files form opens.

2. Use the form to navigate to the log-file location.

3. Select a log file and click Add between the form panels. The log is listed in the panel on the

right.

Note:

The log file can be in compressed or uncompressed format.

4. If LogViewer cannot determine the type of log that the file contains, for example, if a log file

is renamed, it sets the Type to Other. Use the Type drop-down menu to specify the log type,

if required.

5. Click OK. The Compare Files form closes, and a second panel opens on the log tab to

display the specified log.

The log entry lines are synchronized by timestamp. Dynamic log updates to each log are

displayed as they occur. Blank entry lines serve as spacers to preserve the chronological

order of the combined log entries.

6. By default, the scroll bars in the two panels are synchronized; when you scroll in the right

panel, the display in the left panel scrolls by the same amount. Click Synchronize scroll

bars between views in the log tab tool bar to disable or re-enable this behavior, as required.

7. To remove the added log from the comparison, choose Log→Clear Compare from the

LogViewer main menu, or click Clear compared logs on the log tab tool bar. The right panel

is removed from the log tab form.
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21

To capture one or more log entries for display in a static view on a separate tab:

a. To capture all listed log entries, choose Log→Full Snapshot from the LogViewer main menu,

or click Snap all in the main tool bar.

b. To capture the currently selected log entries, choose Log→Snapshot from the LogViewer

main menu, or click Snap selected in the main tool bar.

A new tab opens to display the captured log entries in a static view.

Static view operations

22

To sort a list of log entries in a static view, right-click on a column header and choose Sort

Ascending, Sort Descending, or No Sort. The log entries are sorted accordingly.

Note: You cannot sort the log entries in a dynamic view, but you can sort the entries in a

snapshot of a dynamic log view.

23

To copy the text of selected log entries to the clipboard, select one or more log entries in a log

tab and choose Edit→Copy from the LogViewer main menu, or click Copy in the main tool bar.

24

To save selected log entries to a file, select one or more log entries in a log tab and click Save

Selected in the main tool bar.

25

To save the current workspace for subsequent sessions, choose File→Save Workspace from

the LogViewer main menu, or click Save configuration in the main tool bar.

26

Choose File→Exit from the LogViewer main menu to close the LogViewer GUI.

END OF STEPS

15.5 To configure the LogViewer using the GUI

15.5.1 Purpose

Perform this procedure to use the LogViewer GUI to configure general options for the LogViewer

GUI and CLI.
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15.5.2 Steps

1

Open the LogViewer GUI.

2

Choose Edit→Options→General from the LogViewer main menu, or click Application options in

the main tool bar. The Options form opens.

3

Configure the required parameters:

• Last Directory—Click in the parameter field and use the browser form that opens to specify

where to save exported log profiles.

• Base File Messages Directory—Click in the parameter field and use the browser form that

opens to specify the base log directory.

• Default Character Set—Edit this parameter to specify the character set that LogViewer uses

to display the log-file contents.

• Default Log Pattern—Edit this parameter to specify a regular expression that LogViewer uses

to interpret log-file contents.

• Default Date Format—Enter a colon-separated string to specify the LogViewer date format

using y for year digits, M for month digits, d for date digits, H for hour digits, m for minute

digits, s for second digits, and S for millisecond digits, for example, yyyy:MM:dd

HH:mm:ss:SSS.

• Regular Expression Help URL—Enter a value to specify the location of the Java regular-

expression help web page that opens when you click Help while testing a regular expression

for a filter.

• Web Browser Location—Enter a value to specify the location of the local file browser used to

open the Java regular-expression help web page.

• Quick Links Refresh Time (ms)—Enter a value to specify how often LogViewer refreshes the

Quick Links list.

• Rollover Remove Size—Enter a value to specify the number of log entries to remove from the

LogViewer display when the maximum number of displayed log entries is reached.

• Delay for local file polling (ms)—Enter a value to specify, in ms, how long LogViewer waits

before it checks local log files for updates.

• Hide Table Tooltips—Select this parameter to suppress the display of tool tips when the

mouse pointer moves over log entries in a log tab.

• Use Simple Filters—Select this parameter to allow the use of simple filters.

• Advanced Quick Filter—Select this parameter to display the advanced Quick Filter table

header on log tabs.

• Display Advanced Quick Filter—Select this parameter to display the advanced Quick Filter

table header on the log tab when a log file is opened.

• Include Host in Title—Select this parameter to display the hostname in the log title.
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• Show Memory Monitor—Select this parameter to display the memory monitor at the bottom

right corner of the LogViewer window.

• Memory Monitor Clear Messages—Select this parameter to allow the memory monitor to

attempt recovery by clearing some messages from live event logs when the memory

threshold is exceeded.

• Clear Log on Rollover—Select this parameter to clear the events from the logs when a Style

View file rolls over or is moved.

• Style View—Select this parameter to display the styled preview pane.

• Memory Monitor Threshold (%)—Enter a value to specify the percentage of available

memory that LogViewer uses before it stops displaying log updates.

• Max. Recent Files—Enter a value to specify the number of files that LogViewer keeps in the

list of recently opened files.

• Max. Profile Files—Enter a value to specify the number of profile files that LogViewer keeps

in the list of recently opened files.

• LogViewer Log Level—Choose a logging level from the drop-down menu to specify the

minimum log level of the LogViewer-specific log messages.

• Enable Viewer Performance Stats—Select this parameter to enable the display of LogViewer

performance statistics.

• Stats Timer (seconds)—Enter a value to specify the number of seconds that LogViewer waits

between log statistics updates.

4

Click on the Command Line tab to configure the LogViewer CLI.

5

Configure the following parameter:

• Command line buffer size—Enter a value to specify the number of log messages that

LogViewer buffers when the CLI is in command mode.

6

Choose an ANSI display attribute from the drop-down menu beside each of the following

parameters to specify how the CLI displays the corresponding text.

• Normal Display—for normal text

• Trace Level Display—for trace-level log entries

• Debug Level Display—for debug-level log entries

• Info Level Display—for info-level log entries

• Warning Level Display—for warning-level log entries

• Error Level Display—for error-level log entries

• Fatal Level Display—for fatal-level log entries

• Filter Display—for filtered log entries
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7

Configure the Always Use ANSI Display parameter, as required.

8

Click on the NFM-P tab to configure the required parameters that are specific to the NFM-P.

9

Configure the required parameters by clicking in the parameter field and using the browser form

that opens to specify a directory:

• Database Location—specifies the base NFM-P database installation directory

• Oracle Location—specifies the base NFM-P Oracle installation directory

• NMS Root—specifies the nms directory under the base NFM-P server installation directory

Note:

Your configuration of LogViewer is stored in the user directory. Any filters, fonts, colors, or

other preferences you have set are preserved when you install a newer version.

10

CAUTION

Service Disruption

The parameters on the Advanced tab typically require configuration only when LogViewer has

performance problems.

Consult technical support before you attempt to modify a parameter on the Advanced tab, as it

may affect server performance.

Click on the Advanced tab to configure the required parameters related to LogViewer

performance.

END OF STEPS

15.6 To search log files in a path

15.6.1 Purpose

Use this procedure to perform a search on all log files in a specified path using a plain text search

or a regular expression.

Note: You can test regular expressions in the Find In Path window by clicking Test beside the

expression. Enter sample text in the Example box, and an expression in the Expression box,

then click on the green Execute button to test the results of the expression.
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15.6.2 Steps

1

Open the LogViewer GUI.

2

Choose Edit→Find In Path from the LogViewer main menu, or click Search all files. The Find In

Path window opens.

3

Perform one of the following:

a. To perform a text search, specify the text string to search for in the Text to find parameter

and deselect the Regular expression option.

b. To perform a search using a regular expression, enter a regular expression in the Text to find

parameter and select the Regular expression option.

4

In the Directory parameter, enter the directory path you need to search, or click Browse and

select a directory. To search subdirectories, select the Recursive option.

5

To restrict the search to logs with certain filenames, enter a regular expression in the File Mask

parameter. To search all logs in the specified path, leave this parameter blank.

6

Click Find. The log entries matching the search parameters are displayed in a new tab.

Note: A new search using the Find In Path function cannot be performed until the search

tab is closed.

END OF STEPS

15.7 To show or hide buttons from the LogViewer main tool bar

15.7.1 Purpose

Perform this procedure to show or hide specific buttons from the LogViewer main tool bar.

15.7.2 Steps

1

Open the LogViewer GUI.

Troubleshooting using the LogViewer
To show or hide buttons from the LogViewer main tool bar

NSP

© 2022 Nokia.
Use subject to Terms available at: www.nokia.com/terms

3HE-18817-AAAC-TQZZA

Release 22.9
September 2022

184 Issue 1

http://www.nokia.com/terms/


2

Choose Edit→Preferences→Manage Toolbar from the LogViewer main menu. The Manage

Toolbar page opens divided into a Palette and Toolbar section.

3

Use the directional arrows to manage which buttons appear in the main tool bar, and the order

in which the buttons appear.

4

Click OK to save your settings.

END OF STEPS

15.8 To set highlight colors and fonts for LogViewer components and
levels

15.8.1 Purpose

Perform this procedure to set highlight colors and fonts for the various LogViewer components and

levels.

15.8.2 Steps

1

Open the LogViewer GUI.

2

Choose Edit→Preferences→Highlight Colors from the LogViewer main menu. The Highlight

Color Selection form opens.

3

Set the item for which you want to specify colors and/or fonts by choosing it from the

Component/Level drop-down menu.

4

For the item that you want to change, choose the foreground or background plane as required,

by clicking on the appropriate tab. The foreground is the text contained in a field. The

background is the fill color of the field behind the text.

5

For foreground text items, set the font type, style, and size, as required.
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6

For either foreground or background items, set the color as required. You can choose a color

from the samples shown on the Swatch tab, or you can specify a color by entering its red,

green, and blue values in the RGB tab.

Previews of your choices appear in the sample fields at the bottom of the form.

7

Click OK to save your settings.

END OF STEPS

15.9 To automatically show or hide log messages

15.9.1 Purpose

Perform this procedure to automatically filter (show or hide) log messages based on the current

selected cell in the message table.

15.9.2 Steps

1

Open the LogViewer GUI.

2

To automatically show or hide log messages:

1. Select a log entry.

2. To hide log messages based on a selected cell in the message table, perform one of the

following:

• Right-click on the cell and choose Hide All Like Selected.

• Choose Log→Hide All Like Selected from the LogViewer main menu.

• Click the Hide All Like Selected button in the main tool bar.

LogViewer hides all messages that contain the selected cell. For example, if you have

selected the cell in the “Logger” column that contains the word “samConsole”, all messages

that have the logger set to “samConsole” are hidden.

3. Perform one of the following to show log messages based on a selected cell in the message

table.

• Right-click on the cell and choose Show All Like Selected.

• Choose Log→Show All Like Selected from the LogViewer main menu.

• Click the Show All Like Selected button in the main tool bar.

This shows all messages that contain the selected cell. For example, if you have selected

the cell in the “Logger” column containing the word “samConsole”, all messages that have

the logger set to “samConsole” are displayed.

END OF STEPS
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15.10 To manage filters using the GUI Filter Manager

15.10.1 Purpose

Perform this procedure to create, modify, assign or delete a LogViewer filter.

Note: The Filter Manager is opened from within LogViewer, but runs as a separate applet.

This enables the dragging and dropping of filters between Filter Manager and the Filters sub-

tab of a lob tab.

15.10.2 Steps

1

Choose Log→Filter Manager from the LogViewer main menu. The Filter Manager applet opens.

2

To add a regular filter or a simple filter:

1. Click Add or Add Simple, as required. The Add Filter form opens.

2. Configure the Name parameter by specifying a unique name for the filter.

3. Configure the required parameters that correspond to the fields in a log entry by entering

regular expressions for regular filters, or just strings for simple filters as a filter criterion for

each:

• Level

• Message

• Thread

• Logger

• Timestamp

• Platform

4. If you are configuring a simple filter, go to Step 2 11 .

5. Test a regular expression that you enter by clicking Test beside the regular expression. The

Regular Expression form opens.

6. Paste an example log entry that you want to match using the regular expression into the

Example field.

7. Click on the green right-pointing arrow to test the expression. If the expression is invalid, a

message is displayed to indicate the error in the expression.

8. Correct the errors in the expression.

9. Repeat Step 2 7 and Step 2 8 until no error message is displayed.

10. Repeat Step 2 5 to Step 2 9 to test additional regular expressions, if required.

11. Enable the Color parameter and click in the field beside the parameter to specify a highlight

color for the matching log entries. A standard color chooser form opens.

12. Use the form to specify a color and click OK. The color chooser form closes and the Add

Filter form reappears.
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13. Click OK. The Add Filter form closes and the Filter Manager form lists the new filter.

3

To create a saved filter based on the current quick filter, perform the following steps:

1. Choose Log→Create from Quick Filter from the LogViewer main menu, or click Create from

quick in the main tool bar. The Add Filter form opens and is populated with the quick filter

match criteria.

2. Modify the match criteria as required.

3. Click OK to save the filter.

4

To create a saved filter using a log entry as a template:

1. Select a log entry.

2. Choose Log→Create from Selected from the LogViewer main menu, or click Create from

entry in the main tool bar. The Add Filter form opens and is populated with the current log-

entry field values as match criteria.

3. Modify the match criteria as required.

4. Click OK to save the filter.

5

To move a filter to other instances of the LogViewer:

1. To export a filter, click Export in the main tool bar, or choose Log→Filter Manager from the

LogViewer main menu. The Export form opens, and allows you to export a filter to a

specified file.

2. To import a filter, click Import in the main tool bar, or choose Log→Filter Manager from the

LogViewer main menu. The Import form opens, and allows you to import a filter from a

specified file.

3. Click OK to save the filter.

6

To make a copy of a filter, select the filter and click Copy. A copy of the filter is listed on the

Filter Manager form.

7

To edit a filter, select the filter and click Edit. Configure the required parameters described in

Step 2.

8

To delete a filter, select the filter and click Delete.

END OF STEPS
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15.11 To specify a plug-in using the LogViewer GUI

15.11.1 Purpose

Perform this procedure to configure and enable plug-ins for a log file.

15.11.2 Steps

1

Choose File→Local Log File from the LogViewer main menu, or click Open log in the log tab

tool bar. The Local Log File form opens.

2

Use the form to navigate to the log-file location.

3

Select a log file and click on the Add object... icon button between the form panels. The log is

listed in the panel on the right.

Note: The log file can be in compressed or uncompressed format.

4

Click on the Plugins tab.

5

Choose a plug-in from the Plugin drop-down menu.

6

If you choose the Bring to Front plug-in, perform the following steps:

1. Specify a regular expression as a match criterion in the Message Filter field.

2. Go to Step 8 .

7

If you choose the E-Mail plug-in, perform the following steps:

1. Specify a regular expression as a match criterion in the Message Filter field.

2. Configure the required parameters:

• Message Filter—specifies a regular expression that is used as a filter to identify the log

entries that invoke the plug-in

• Subject—specifies the e-mail message subject line

• Body Prefix—specifies the text that precedes the log-entry text in an e-mail message

• Authenticate? —specifies whether or not authentication is enabled

• User—specifies a user name associated with the plug-in
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• Password—specifies an SMTP password

• Host—specifies the name of an SMTP server

• Use TLS? —specifies whether the mail server uses Transport Layer Security (TLS)

encryption

• Use SSL? —specifies whether the mail server uses Secure Sockets Layer (SSL)

encryption

• To—specifies the e-mail address of the recipient

• From—specifies the sender e-mail address used by the plug-in

• Minimum E-mail Time (minutes)—specifies the minimum time between messages that the

plug-in sends, to prevent e-mail flooding

8

Click OK. The Local Log File form closes.

END OF STEPS

15.12 To display logs using the LogViewer CLI

15.12.1 Purpose

Perform this procedure to start the LogViewer CLI and view one or more logs.

15.12.2 Steps

1

Log in to a station as the nsp user.

2

Open a console window.

3

Enter the following:

bash$ /opt/nsp/nfmp/server/nms/bin/logviewer.bash argument options
parameter ↵

where

argument is an argument listed in Table 15-1, “LogViewer CLI startup arguments” (p. 191)

options is one or more of the options listed in Table 15-2, “LogViewer CLI startup options”

(p. 191)

parameter is a parameter listed in Table 15-3, “LogViewer CLI startup parameters” (p. 191)
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Table 15-1 LogViewer CLI startup arguments

Argument Meaning

--version Display LogViewer version information.

--help Display LogViewer CLI help text.

Table 15-2 LogViewer CLI startup options

Option Meaning

-counter Prepend a counter number to each displayed log entry.

-parseAll Parses and display the entire contents of a file before displaying the real-time

updates.

-ansi level attribute Display events and filters using ANSI-specified colors

where

level is a logging level, such as debug

attribute is an ANSI color attribute, such as 42m to specify the color green

-quit Quit LogViewer after parsing the log files.

Table 15-3 LogViewer CLI startup parameters

Parameter Meaning

-xml file_name Read information such as log file, plug-in and filter specifications from the XML

file specified by file_name. The LogViewer GUI can export this information to an

XML file.

file name Display the specified file when LogViewer starts.

The LogViewer CLI opens in display mode. If a log file is specified as a startup parameter, the

most recent entries in the log file are displayed as they are written to the log file. Otherwise, a

cursor is displayed.

4

Enter command mode by pressing ↵. The following prompt is displayed:

log>

This prompt is called the root prompt. The table below describes the options that are available

at the root prompt.

Table 15-4 LogViewer CLI root menu options

Option Function

open opens a submenu for choosing the logs to view

include opens a submenu for specifying which log files to list in the open submenu

filter opens a submenu for adding, listing or deleting filters
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Table 15-4 LogViewer CLI root menu options (continued)

Option Function

plugin opens a submenu for adding, listing or delete plugins

options opens a submenu for configuring LogViewer CLI and GUI options

list lists the files in the open submenu file list

reset resets the log message counts

stats displays LogViewer statistics for the current log

The following options are also available in submenus:

back goes to the previous menu

root goes to the root menu

quit quits LogViewer

return returns to display mode

5

Enter the following:

open ↵

The following prompt is displayed:

log-open>

6

Press ↵ to display the list of available logs.

7

Perform one of the following:

a. To view a log in the list, enter the name of a log and press ↵.

b. To view a log that is not listed, perform the following steps.

1. Enter the following:

other ↵

The following prompt is displayed:

File Name (full path)?

2. Enter the absolute or relative path of the log file that you want to open and press ↵.

LogViewer opens the file.

8

Enter the following to enter display mode and view the real-time log updates:

return ↵
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LogViewer enters display mode. Log updates are displayed as they occur.

9

To add a filter that restricts the types of log entries that are displayed during the current

LogViewer session, perform the following steps:

1. Press ↵ to enter command mode.

2. Enter the following to return to the root menu:

root ↵

The following prompt is displayed:

log>

3. Enter the following:

filter ↵

The following prompt is displayed:

log-filter>

Note:

You can also use commands at this menu level to list and delete filters.

4. Enter the following:

add ↵

The following prompt is displayed:

Filter name:

5. Enter a name for the filter and press ↵.

6. The following prompts are displayed in sequence:

Level:

Logger:

Thread:

Timestamp:

Message:

At each prompt, enter a regular expression to use as a match criterion, if required, and

press ↵.

7. The following prompt is displayed:

Display Filter? (Y/N):

Enter y ↵ to apply the filter to the current log display. LogViewer applies the filter.

8. Enter the following to return to display mode:

return ↵

LogViewer enters display mode. The log updates are filtered before they are displayed.
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10

To list the available log files, perform the following steps:

1. Press ↵ to enter command mode.

2. Enter the following:

list ↵

LogViewer lists the available log files.

3. Enter the following to return to display mode:

return ↵

11

To display statistics about the current LogViewer session, perform the following steps:

1. Press ↵ to enter command mode.

2. Enter the following:

stats ↵

LogViewer displays statistics about the current session.

3. Enter the following to return to display mode:

return ↵

12

To reset the statistics counters for the current LogViewer session, perform the following steps:

1. Press ↵ to enter command mode.

2. Enter the following:

reset ↵

LogViewer resets the counters.

3. Enter the following to return to display mode:

return ↵

13

Enter the following to close LogViewer:

quit ↵

END OF STEPS
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15.13 To configure the LogViewer CLI

15.13.1 Purpose

Perform this procedure to use the LogViewer CLI to configure general CLI options.

Note: The options configured in this procedure apply only to the current LogViewer CLI

session.

15.13.2 Steps

1

Open the LogViewer CLI.

2

To add a file to the list of files in the open menu, perform the following steps:

1. Press ↵ to enter command mode.

2. Enter the following at the root prompt:

include ↵

The following prompt is displayed:

log-include>

3. Enter the following:

add ↵

The following prompt is displayed:

File Name (full path)?

4. Enter the absolute or relative path of the log file that you want to add and press ↵.

LogViewer adds the file to the list in the open menu.

Note:

The LogViewer CLI supports file drag-and-drop functionality.

5. Enter the following to return to the root prompt:

root ↵

3

To configure LogViewer file parsing, perform the following steps:

1. Press ↵ to enter command mode.

2. Enter the following at the root prompt:

options ↵

The following prompt is displayed:

log-options>
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3. Enter y ↵ to confirm the action.

4. To specify whether LogViewer parses the entire log file, enter the following:

parseAll ↵

A confirmation prompt is displayed.

5. To force LogViewer to reparse the current log file, enter the following:

reparse ↵

6. If you are prompted to enable parsing of the entire log file, enter y ↵.

7. Enter the following to return to the root prompt:

root ↵

END OF STEPS

15.14 To specify plug-ins using the CLI

15.14.1 Purpose

Perform this procedure to specify a plug-in for the current LogViewer CLI session.

15.14.2 Steps

1

Open the LogViewer CLI.

2

Press ↵ to enter command mode.

3

Enter the following at the root prompt:

plugin ↵

The following prompt is displayed:

log-plugin>

4

Enter the following:

add ↵

LogViewer displays a list of the available plug-ins and the following prompt:

Which plugin would you like to specify? (name)

5

Enter the name of a plug-in from the list and press ↵.
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6

You may be prompted for plug-in configuration information. Supply the information, as required.

Note: The currently available plug-ins and the associated configuration options are

described in 15.11 “To specify a plug-in using the LogViewer GUI” (p. 189).

END OF STEPS
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16 Troubleshooting the NFM-P database

16.1 Database troubleshooting overview

16.1.1 Database status

The NFM-P monitors the primary and standby database status and displays a colored status based

on the primary and standby database connection and availability states. The following describes the

conditions that determine database status color. These conditions also cause the NFM-P to raise

database alarms.

Clear

The database status panel changes to clear status (gray) when the database connection, proxy,

and applicable standby entities are up and all database error conditions are cleared.

Yellow

The following conditions cause the panel to change to yellow status:

• A database switchover or failover is complete.

• The database connection is partially down.

• The primary database is up and the standby database is down.

• A problem is detected with synchronization or archiving.

Red

The following conditions cause the panel to change to red status:

• A database switchover or failover is starting.

• The database connection is down.

• The primary database is down.

16.2 Problem: NFM-P database corruption or failure

16.2.1 Solution

You can restore an NFM-P database using a backup copy.

Note: Before you perform a database restore operation, you must shut down the databases

and main servers in the NFM-P system. Contact technical support before you attempt to

perform a database restore.

In a redundant NFM-P system, you must perform one or both of the following to regain database

function and redundancy:

• Restore the primary NFM-P database.

Troubleshooting the NFM-P database
Database troubleshooting overview

NSP

Release 22.9
September 2022
Issue 1 199

© 2022 Nokia.
Use subject to Terms available at: www.nokia.com/terms

3HE-18817-AAAC-TQZZA

http://www.nokia.com/terms/


• Reinstantiate the standby NFM-P database.

Both operations are required after a primary database failure. After a standby database failure, no

restore operation is required, but you must reinstantiate the standby database to restore

redundancy. You can use the NFM-P client GUI or a CLI script to reinstantiate a database.

Note: In a redundant NFM-P system, you can restore a database backup only on a primary

database station. To restore a database backup on a station other than the primary station,

you must do the following on the station before you attempt the restore:

• Uninstall the NFM-P database, if it is installed.

• Install a primary NFM-P database on the station.

Note: In a redundant NFM-P system, you can reinstantiate a database only on a standby

database station. To reinstantiate a database on a station other than the standby station, you

must do the following on the station before you attempt the reinstantiation:

• Uninstall the NFM-P database, if it is installed.

• Install a standby NFM-P database on the station.

See the NSP Administrator Guide for information about restoring or reinstantiating an NFM-P main

database.

16.3 Problem: The database is running out of disk space

16.3.1 Database disk space

Sufficient database disk space is essential for efficient NFM-P database operation. You can also

check whether your database backup schedule is adequate. Underscheduling backups while the

database is in ARCHIVELOG mode creates numerous log files.

16.3.2 Steps

1

Verify that the database platform is adequately sized. See the NSP NFM-P Planning Guide or

consult technical support.

2

Verify that the thresholds for disk space and archive logs are sufficient for your network, and

determine how the disk space is being used. Contact your technical support representative for

more information.

3

Check the root database backup directory or partition to ensure that:

• the size of the assigned disk space or slice is sufficient

• the disk directory or slice is sufficient to hold the configured number of database backups

Troubleshooting the NFM-P database
Problem: The database is running out of disk space

NSP

© 2022 Nokia.
Use subject to Terms available at: www.nokia.com/terms

3HE-18817-AAAC-TQZZA

Release 22.9
September 2022

200 Issue 1

http://www.nokia.com/terms/


4

If the disk directory has many archived log files due to underscheduling of database backups,

contact your technical-support representative for information about deleting archived log files.

5

Back up the NFM-P database, as described in the NSP Administrator Guide.

END OF STEPS

16.4 Problem: Frequent database backups create performance issues

16.4.1 Overscheduling database backups

Overscheduling the number of database backups can affect database performance by consuming

excessive system resources.

16.4.2 Steps

1

Choose Administration→Database from the NFM-P main menu. The Database Manager form

appears.

2

Click on the Backup tab.

3

Check the Backup Interval and Interval Unit parameters. For example, setting the Backup

Interval parameter to 6 and setting the Interval Unit parameter to hour means a backup is

performed every 6 hours, or four times a day. Such frequent backups can cause performance

issues.

Note: Nokia recommends scheduling database backups to occur once daily.

4

Modify other parameters as required to improve performance.

5

Save your changes and close the Database Manager form.

END OF STEPS
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16.5 Problem: An NFM-P database restore fails and generates a No
backup sets error

16.5.1 Solution

WARNING

Equipment Damage

Performing NFM-P database modifications using Oracle database tools can cause irreparable harm

to the NFM-P database and the network management data, and can void your warranty or support

agreement.

Contact your technical support representative for assistance with database troubleshooting.

Database backup sets expire based on a retention period. After the retention period passes, the

database backup sets are set to expired. You cannot restore databases from expired backup sets.

Contact your technical support representative for assistance with an NFM-P database restore

failure.

16.6 Problem: NFM-P database redundancy failure

16.6.1 Steps

WARNING

Equipment Damage

Performing NFM-P database modifications using Oracle database tools can cause irreparable harm

to the NFM-P database and the network management data, and can void your warranty or support

agreement.

Contact your technical support representative for assistance with database troubleshooting.

1

Ensure that the database redundancy configuration is correct, as specified in the NSP

Installation and Upgrade Guide:

• The primary and standby database directory structures and disk partition configurations are

identical.

• The same OS version and patch level, and the same NFM-P software release and patch

level, are installed on the primary and standby database stations.

2

Ensure that there are no network communication problems between the primary and standby

database stations; see Chapter 6, “NSP system troubleshooting”.

END OF STEPS

Troubleshooting the NFM-P database
Problem: An NFM-P database restore fails and generates a No backup sets
error

NSP

© 2022 Nokia.
Use subject to Terms available at: www.nokia.com/terms

3HE-18817-AAAC-TQZZA

Release 22.9
September 2022

202 Issue 1

http://www.nokia.com/terms/


16.7 Problem: Primary or standby NFM-P database is down

16.7.1 Primary or standby database is down

The status bar of the NFM-P client GUI indicates that the primary or standby database is down.

16.7.2 Steps

WARNING

Equipment Damage

Performing NFM-P database modifications using Oracle database tools can cause irreparable harm

to the NFM-P database and the network management data, and can void your warranty or support

agreement.

Contact your technical support representative for assistance with database troubleshooting.

1

Verify the correct IP address and instance name of the database. From the NFM-P main menu,

select Administration→Database to open the Database Manager. Verify the information in the

Instance Name and DB Server fields.

2

Verify the network connectivity between the NFM-P primary server and the primary or standby

database by ensuring that the primary server and the primary or standby database can ping

each other; see Chapter 6, “NSP system troubleshooting”.

END OF STEPS

16.8 Problem: Need to verify that Oracle database and listener
services are started

16.8.1 Purpose

Perform the following procedure to determine the status of the Oracle database and listener

services, each of which starts automatically during NFM-P database station initialization.

16.8.2 Steps

1

Open an NFM-P GUI client.

Troubleshooting the NFM-P database
Problem: Primary or standby NFM-P database is down

NSP

Release 22.9
September 2022
Issue 1 203

© 2022 Nokia.
Use subject to Terms available at: www.nokia.com/terms

3HE-18817-AAAC-TQZZA

http://www.nokia.com/terms/


2

View the status bar at the bottom of the GUI. The background of the NFM-P database section

of the status bar is yellow or red when there is a problem with a service. The status bar text

indicates the database service status.

END OF STEPS

16.9 Problem: Need to determine status or version of NFM-P database
or Oracle proxy

16.9.1 Purpose

Perform the following procedure to determine the status of the NFM-P database or Oracle proxy,

each of which starts automatically during NFM-P database station initialization.

16.9.2 Steps

1

Log in as the Oracle management user on the database station.

2

Open a console window.

3

Navigate to the /opt/nsp/nfmp/db/install/config/db directory

4

Enter the following command.

bash$ ./oracleproxy.sh option ↵

where option is one of the options in the table below.

Table 16-1 oracleproxy.* flag options

Flag option Description

start Starts the Oracle proxy

no option, or help Lists the available options

proxy_version Displays Oracle proxy version information

proxy_status Displays Oracle proxy status information

db_version Displays NFM-P database version information

db_status Displays NFM-P database status information
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5

Review the command output.

The following sample shows the output of the proxy_status option.

Proxy is UP

The following sample shows the output of the db_version option.

NSP Version Release - Built on Wed Mar 27 03:14:15 EST 20XX

6

Close the console window.

END OF STEPS

Troubleshooting the NFM-P database
Problem: Need to determine status or version of NFM-P database or Oracle
proxy

NSP

Release 22.9
September 2022
Issue 1 205

© 2022 Nokia.
Use subject to Terms available at: www.nokia.com/terms

3HE-18817-AAAC-TQZZA

http://www.nokia.com/terms/


Troubleshooting the NFM-P database
Problem: Need to determine status or version of NFM-P database or Oracle
proxy

NSP

© 2022 Nokia.
Use subject to Terms available at: www.nokia.com/terms

3HE-18817-AAAC-TQZZA

Release 22.9
September 2022

206 Issue 1

http://www.nokia.com/terms/


17 Troubleshooting NFM-P server issues

17.1 Overview

17.1.1 Problems associated with the NFM-P server

NFM-P server statistics collection is a useful troubleshooting tool for memory, alarm, and SNMP

issues on an NFM-P main or auxiliary server. See the NSP NFM-P Statistics Management Guide for

more information.

When no NE is associated with an NFM-P alarm, the alarm Site ID and Site Name properties are

populated with the IP address and hostname, respectively, of the NFM-P main or auxiliary server

that raised the alarm.

17.2 Problem: Cannot start an NFM-P server, or unsure of NFM-P
server status

17.2.1 Server status indicators

The NFM-P main or auxiliary server startup script provides server status indicators that include the

following:

• how long the server has been running

• the used and available memory

• the NFM-P database connectivity status

• NFM-P license capacity

17.2.2 Steps

1

Log in to the NFM-P server as the nsp user.

2

Open a console window.

3

To check the status of an NFM-P main server, perform the following steps.

1. Enter the following:

/opt/nsp/nfmp/server/nms/bin/nmsserver.bash appserver_status ↵

The general server status is displayed.

2. Enter the following at the CLI prompt:

Troubleshooting NFM-P server issues
Overview

NSP

Release 22.9
September 2022
Issue 1 207

© 2022 Nokia.
Use subject to Terms available at: www.nokia.com/terms

3HE-18817-AAAC-TQZZA

http://www.nokia.com/terms/


/opt/nsp/nfmp/server/nms/bin/nmsserver.bash nms_status ↵

Detailed NFM-P server information is displayed.

3. To obtain more specific server status information, run the nmsserver script in step 3 using

the appropriate option from the following table in place of the nms_status or appserver_

status option.

NFM-P main-server startup script options

Option Description

start Starts the NFM-P main server in a non-interactive mode

stop Stops the NFM-P main server

debug Starts the NFM-P server in an interactive mode. Note: The server

shuts down if the console is closed or if Ctrl-C is pressed.

appserver_status Returns information about the status of the NFM-P main server (both

active and standby servers when the NFM-P is configured for

redundancy)

appserver_version Returns NFM-P software release information that includes the start

time of the current NFM-P main server instance

nms_status Returns the following information:

• NFM-P standalone, primary, or standby server start time and

running time

• total used and available memory

• NFM-P database connectivity status

• redundancy configuration and status

• NFM-P license information

• JVM memory-usage information

• alarm forwarding information

• basic auxiliary server information

• number and status of current process threads

-v nms_status Verbose version of the nms_status option that returns the following

additional information:

• ID and status of the current process threads

• general JMS server information

• currently connected JMS subscribers, by topic

-s nms_status Short version of the nms_status option that returns the following

information:

• system information

• IP address

• NFM-P database information

• installation information
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Option Description

nms_info Returns the following information from the NFM-P database:

• number of managed devices by device type; for example, 7750 SR

• number of MDA ports by type

• number of equipped ports by type

• number of services by type; for example, IES or VLL

• number of access interfaces, connection termination points, and

channels, by type

• number of alarms, listed in order of severity

• lists of enabled statistics, file, and accounting policies, including

the counts and the polling frequency for different types of objects

nms_version Returns NFM-P software release information

jvm_version Returns version information about the currently running Java Virtual

Machine environment

script_env Returns main server script environment information

read_config Rereads the nms-server.xml server configuration file while the server

is running in order to put configuration file updates into effect

force_restart Forces the NFM-P main server to restart

force_stop Forces the NFM-P main server to stop

passwd <username> <current>

<new>

where

username is the NFM-P database

username, for example, samuser

current is the current password

new is the new password

Changes the NFM-P database user password

read_metrics_config Reads the server metrics configuration file

import_license Imports a new license zip file for the server

threaddump Prints a thread dump for every SAM java process running on the

station

webstart Starts the web server

webstop Stops the web server

webstatus Prints web server status

webforce_restart Forces the web server to restart

webforce_stop Forces the web server to stop and not restart

jmsstart Starts the JMS server in interactive mode

jmsstop Stops the JMS server
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Option Description

jmsstatus Returns information that includes the following:

• general JMS server information

• currently connected JMS subscribers, by topic

jmsread_config Rereads the JMS server configuration file while the JMS server is

running

jmsforce_restart Forces the JMS server to restart

jmsforce_stop Forces the JMS server to stop

jmsjvm_version Returns version information about the currently running Java Virtual

Machine environment

jmsappserver_status Returns the JMS server status

jmsscript_env Returns the JMS script environment

no keyword, help, or ? Lists the available command options

4

To check the status of an NFM-P auxiliary server, perform the following steps.

1. Enter the following at the CLI prompt:

/opt/nsp/nfmp/auxserver/nms/bin/auxnmsserver.bash aux_status ↵

The general server status is displayed.

2. Enter the following at the CLI prompt:

/opt/nsp/nfmp/auxserver/nms/bin/auxnmsserver.bash auxappserver_
status ↵

Detailed NFM-P server information is displayed.

3. To obtain more specific server status information, run the nmsserver script using the

appropriate option from the following table in place of the aux_status or appserver_status

option.

NFM-P auxiliary-server startup script options

Option Description

auxappserver_status Returns information about the operational status of the auxiliary

server

auxdebug Starts the auxiliary server in interactive mode

auxforce_restart Forces the auxiliary server to restart

auxforce_stop Forces the auxiliary server to stop

auxjvm_version Returns the auxiliary server JVM version

auxread_config Directs the auxiliary server to read and apply the settings in the

general configuration file
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Option Description

auxread_metrics_config Directs the auxiliary server to read and apply the settings in the

metrics configuration file

auxscript_env Returns auxiliary server script environment information

auxstart Starts the NFM-P auxiliary server

auxstatus Returns information about the auxiliary server that includes the

following:

• IP address

• port number

• NFM-P database connections

• installed server software release ID

auxstop Stops the NFM-P auxiliary server

aux_version Returns auxiliary server software release information

auxthreaddump Returns a thread dump for every auxiliary server process currently

running on the station

auxhelp, no keyword, or ? Lists the available command options

5

Review and record the displayed information for technical support, if required.

6

Close the console window.

7

View the NFM-P server logs for error messages using the LogViewer utility, as described in

Chapter 2, “Troubleshooting scenarios using multiple NSP applications”.

8

Report the error messages that you find to a technical support representative.

END OF STEPS

17.3 Problem: NFM-P server and database not communicating

17.3.1 Purpose

Perform this procedure when an NFM-P server cannot connect to an NFM-P database.
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17.3.2 Steps

1

Verify network connectivity between both the primary and standby servers and the primary and

standby NFM-P databases by ensuring that both the primary and standby servers and the

primary database can ping each other. See Chapter 6, “NSP system troubleshooting”.

2

Ensure that the ports specified at installation time are available and not being blocked by

firewalls; see Chapter 6, “NSP system troubleshooting”.

3

Perform the following troubleshooting activities for the primary NFM-P database, as described

in 16.7 “Problem: Primary or standby NFM-P database is down” (p. 203).

• Verify the NFM-P database IP address and instance name.

• Verify that the database instance is running.

• Verify that the database is running in the correct mode.

END OF STEPS

17.4 Problem: An NFM-P server starts up, and then quickly shuts down

17.4.1 Solution

When a server starts then stops, collect the logs identified in 2.2.7 “Use the Network Health

Dashboard to retrieve data about the health of a service and its components” (p. 39) and contact

your technical support representative.

17.5 Problem: Client not receiving server heartbeat messages

17.5.1 Purpose

Perform this procedure when an NFM-P client is not receiving heartbeat messages.

17.5.2 Steps

1

Verify network connectivity between both the primary and standby servers and the clients by

ensuring that both the primary and standby servers and the clients can ping each other. See

Chapter 6, “NSP system troubleshooting”.
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2

Verify that the NFM-P server and client clocks are synchronized. To set the date and time for

NFM-P server and client clocks, see the NSP Administrator Guide.

END OF STEPS

17.6 Problem: Main server unreachable from RHEL client station

17.6.1 Purpose

Perform this procedure to check the IP connectivity between an NFM-P client and main server

using ping commands. When the ping commands indicate that IP communication is active but there

are still IP reachability issues, the problem could be poor LAN performance.

17.6.2 Steps

1

Perform a ping test to measure reachability, as described in 10.2 “Problem: Lost connectivity to

one or more network management domain stations” (p. 145).

2

If you cannot ping the main server from a RHEL single-user client or client delegate server

station, ensure that the server hostname is in the /etc/hosts file on the client station.

1. Log on to the client station as the root user.

2. Enter the following:

# cd /etc ↵

3. Open the hosts file with a plain-text editor such as vi.

4. Edit the file, as required, to contain the following:

server_IP server_hostname

where

server_IP is the IP address of the main server

server_hostname is the hostname of the main server

5. Save the changes and close the file.

END OF STEPS
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17.7 Problem: Excessive NFM-P server-to-client response time

17.7.1 Increasing available server network management resources

As the number of managed devices grows and as more GUI or OSS clients are brought online, the

processing load on the NFM-P system increases. For optimum NFM-P performance, you must

ensure that the NFM-P configuration meets the requirements in the NSP NFM-P Planning Guide as

your network expands.

You can do the following to increase the available NFM-P server network management resources:

• Deploy the NFM-P system in a distributed configuration.

• Deploy the NFM-P system in a redundant configuration.

• Deploy NFM-P auxiliary servers.

• Reallocate the NFM-P server resources that are assigned to groups of managed devices.

See the NSP NFM-P User Guide, , and the NSP Installation and Upgrade Guide for information

about a particular option. Contact technical support for reconfiguration assistance.

Perform this procedure to check the following:

• NFM-P auxiliary server status

System performance may degrade if the number of available Preferred and Reserved auxiliary

servers drops below the number of configured Preferred auxiliary servers.

• NFM-P main server status

Alarms raised against the NFM-P main server may provide information about the performance

degradation.

17.7.2 Steps

CAUTION

Service Disruption

Only Nokia support staff are qualified to assess and reconfigure an NFM-P deployment.

Contact your technical support representative for assistance.

1

Open an NFM-P client GUI.

2

Choose Administration→System Information. The System Information form opens.

3

Click on the Faults tab to view auxiliary server and general NFM-P system alarm information, if

required.
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4

If your NFM-P deployment includes one or more auxiliary servers, perform the following steps

to check the status of each auxiliary server.

1. Click on the Auxiliary Servers tab.

2. Review the list of auxiliary servers.

3. Select an auxiliary server in the list and click Properties. The properties form for the

auxiliary server is displayed.

4. Review the information, which includes:

• the auxiliary server IP address

• the auxiliary server hostname

• the auxiliary server port number

• the auxiliary server type (Reserved or Preferred)

• the auxiliary server status (Unknown, Down, Up, or Unused)

5. If the auxiliary server status is Down, perform 17.2 “Problem: Cannot start an NFM-P

server, or unsure of NFM-P server status” (p. 207) on the auxiliary server.

6. If the auxiliary server status is Unknown, perform 17.12 “Problem: Slow or failed

resynchronization with network devices” (p. 219) to check the connectivity between the

managed network and the main and auxiliary servers.

5

Close the System Information form.

END OF STEPS

17.8 Problem: Unable to receive alarms on the NFM-P, or alarm
performance is degraded

17.8.1 General information

By default, the system begins purging alarms when the outstanding alarm count reaches 50 000,

unless historical alarm record logging and purging alarm policies are configured to keep the

outstanding alarm count below that level.

17.8.2 Steps

CAUTION

Service Disruption

Exceeding the alarm limit configured in the nms-server.xml file may cause system performance

problems.

Contact your technical support representative for assistance.
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1

Check the status bar of the NFM-P client GUI status bar for indications that the maximum

number of alarms for the system is reached.

2

If required, clear outstanding alarms or delete them to the alarm history record log, as

described in the NSP NFM-P User Guide.

3

If the NFM-P system includes one or more auxiliary servers, perform 17.7 “Problem: Excessive

NFM-P server-to-client response time” (p. 214) to ensure that system performance is not

degraded because of auxiliary-server unavailability.

4

Contact your technical support representative for more information.

END OF STEPS

17.9 Problem: All SNMP traps from managed devices are arriving at
one NFM-P server, or no SNMP traps are arriving

17.9.1 Configuration for SNMP trap notifications

When you install the NFM-P, you specify the port on which SNMP traps arrive.

In addition, the following configuration is required for SNMP trap notifications to work:

• Enable the SNMP parameters on the devices before managing them.

• Ensure that a unique trapLogId is specified for each router to communicate with the NFM-P.

Note: You must have sufficient user permissions, for example, admin permissions, to

configure SNMP on a device.

17.9.2 Steps

1

See the commissioning chapter of the NSP NFM-P User Guide for more information about

configuring devices for NFM-P management.

2

Configure SNMP on the device using CLI.

END OF STEPS
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17.10 Cannot manage new devices

17.10.1 New devices cannot be managed

The possible causes are:

• The number of managed devices or MDAs exceeds the licensed quantity.

• Large packet sizes from the managed devices are being dropped by intermediate routers

because the packets exceed the device MTU, causing resynchronizations to fail.

Additional devices cannot be managed, but can be discovered, when the licensed MDA limit is

exceeded.

17.10.2 Steps

CAUTION

Service Disruption

Do not modify other nms-server.xml parameters. Modifying the file can seriously affect network

management and performance of the NFM-P.

Consult technical support before you attempt to modify parameters.

1

Check the license key status.

1. The NFM-P generates an alarm when a license limit is exceeded or nearly exceeded. View

the NFM-P alarm list in the client GUI, or use an OSS client to monitor the JMS alarm event

stream for license alarms.

2. Choose Help→NFM-P License Information from the NFM-P main menu. The NFM-P

License (Edit) form opens.

3. Click on the Devices and Quantities Licensed tab.

4. View the information to ensure that the required Remaining quantity is not equal to zero.

Note:

If you have a new license that supports a greater number of managed objects, you can

dynamically update the license without restarting the main server. See the NSP NFM-P

User Guide for information about updating an NFM-P license.

5. Close the NFM-P License (Edit) form.

2

Ensure that the new devices are configured to send SNMP packets of up to 9216 bytes. Check

the MTU size, as described in 10.4 “Problem: Packet size and fragmentation issues” (p. 147).

END OF STEPS
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17.11 Problem: Cannot discover more than one device, or device
resynchronization fails

17.11.1 General information

Consider the following:

• When using SNMPv3 encryption, the engine ID of the managed device must be unique. As well,

SNMP issues may result in Polling Problem alarms. Otherwise, the following issues may occur:

− unreliable or slow discovery of network devices

− resynchronization during scheduled polling fails

− slow communication and synchronization times

− polling fails completely

• When NFM-P resynchronizes some functions on an NE, for example, BGP configurations for the

7750 SR, the SNMP packets may be broken into two or more smaller packets, when the

maximum PDU size of 9216 bytes is exceeded.

• Each MIB entry policy has its own polling interval. When there is insufficient time in a polling

interval for a resynchronization to occur, the interval may need to be changed to ensure proper

resynchronization.

17.11.2 Steps

1

For resynchronization issues that may be caused due to insufficient MIB polling intervals.

2

Choose Administration→Mediation from the NFM-P main menu. The Mediation (Edit) form

opens with the General tab selected.

3

Ensure that the Polling Admin State is Up.

Note: Polling and scanning use system resources, and can increase the amount of

management traffic. Consider your network needs and network management domain

capabilities before setting these parameters.

4

Check the MIB polling intervals for different managed devices, as required, by clicking on the

MIB Entry Policies tab.

A list of MIBs appears, organized by managed device type.

1. Select a MIB in the list and click Properties.

2. Configure the Polling Interval parameter to ensure that sufficient time is configured for the

polling to occur.

3. Configure the Administrative State of polling for the MIB entry, if required.
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4. Click OK to save the changes and close the form, or click Cancel to close the form without

saving changes, as required.

END OF STEPS

17.12 Problem: Slow or failed resynchronization with network devices

17.12.1 General information

When NFM-P performance is slow, especially when performing network device resynchronizations,

SNMP and IP performance along the in-band or out-of-band interfaces between the network device

and the NFM-P server may be the problem.

Check the following:

• configuration of the LAN switch port and the NFM-P station port match

• configuration of the LAN switch port and the network device management ports match

• mediation policy SNMP timeout and retry values are sufficient to allow the transfer of data

between network devices and the NFM-P

17.12.2 Steps

1

Ensure that port configurations are compatible for the NFM-P server, the network device

management ports, and the LAN switch. This is normally done by configuring auto-negotiation

between the platforms, but your network may require more specific configuration.

2

Check whether all data is being transferred between the network device in-band management

port and the NFM-P server.

1. Open a Telnet or SSH session to the device from the NFM-P.

2. Check statistics on the in-band management port of the device:

# monitor port 1/2/3

Check the output for the following.

• errors that may indicate a communication problem with the a LAN switch.

• Over each time interval, is the number of input and output packets constant? This may

indicate intermittent traffic.

• Are there more input packets or octets being transferred than output packets or octets?

This may indicate a unidirectional traffic problem.

The types of error messages displayed determine the action to take.

• For failure errors, consider increasing the SNMP timeout value

• For collision errors, consider increasing the SNMP retry value

3. Check the mediation policy for the device using the NFM-P client GUI. Check the SNMP

timeout and retry value for the mediation policy.
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If the output of step 2 indicates failures, consider increasing the default SNMP timeout

value and perform step 2 again.

When the output of step 2 indicates frequent collisions, consider increasing the default

SNMP number of retries value, then retest to see if resynchronizations are more reliable.

Increasing the number of retries increases the likelihood that an SNMP packet is not

dropped due to collisions.

You can check SNMP timeout and retry values from the Administration→Mediation menu.

Click on the Mediation Security tab.

CAUTION:

When LAN performance is poor, increasing timeout values may mask an underlying

problem. Increasing the SNMP timeout value in an environment where collisions are

frequent reduces performance. Timeout values should be based on typical network

response times

Check LAN communication issues, as specified in Chapter 6, “NSP system

troubleshooting”. If problems persist, collect the logs as specified in 2.2.7 “Use the Network

Health Dashboard to retrieve data about the health of a service and its components” (p. 39)

and contact your technical support representative.

END OF STEPS

17.13 Problem: Statistics are rolling over too quickly

17.13.1 Problem

Statistics database tables roll over, or lose statistics during an interval, if the tables fill before all

statistics are collected or the next collection interval starts.

Solution

To ensure sufficient statistics collection, consider the following:

• the statistics table size, depending on the configuration specified in the NSP Installation and

Upgrade Guide

• the number of statistics collected, the number of objects with statistics collection enabled, and

the frequency of statistics collection, as specified in the NSP NFM-P User Guide

• the OSS requests data from the statistics tables less frequently than the configured rollover

interval

• FTP must be enabled on the managed device in order for the NFM-P to retrieve statistics.

Nokia recommends that statistics collection planning includes the following considerations to

prevent the loss of statistics data.

• measure the rate of statistics collection over a sufficient time interval

• determine the appropriate collection interval and statistics database table size based on

individual network configurations

• ensure that the polling interval is sufficient for polled statistics
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18 Troubleshooting NFM-P clients

18.1 Problem: Cannot start NFM-P client, or error message during
client startup

18.1.1 Prerequisites

Before you proceed, ensure that the following conditions are present:

• the NFM-P client and server have the same software versions and compatible patch sets

• the login name and password of the user are correct

• there are no OS errors

• a local firewall is running on the client station

18.1.2 Steps

1

If the NFM-P client is installed on RHEL and you receive a “Cannot execute” message when

you try to run the client, the client executable file permission may have been reset by an event

such as an auto-client update failure. You must ensure that the correct file permissions are

assigned.

1. Log in as root, or as the user that installed the client, on the client station.

2. Open a console window.

3. Enter the following:

# chmod +x path/nms/bin/nmsclient.bash

where path is the NFM-P client installation location, typically /opt/nsp/client

2

Review the login messages that are displayed when a client GUI attempts to connect to a

server. Messages that state things like the server is starting or the server is not running indicate

the type of problem.

3

Ensure that the user name and password are correct.

4

To check that the NFM-P server is up and to view additional server configuration information,

perform the following steps.

1. Log on to the NFM-P server station as the nsp user.
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2. Open a console window.

3. Navigate to the /opt/nsp/nfmp/server/nms/bin directory.

4. Enter the following:

./nmsserver.bash appserver_status ↵

Server status and configuration information are displayed.

5. To check additional server status conditions, perform 17.2 “Problem: Cannot start an

NFM-P server, or unsure of NFM-P server status” (p. 207).

5

Check the client GUI login error message.

When a firewall is running locally on the client station, a login error message may appear

indicating that the server is not available. Ensure that a local firewall is not preventing a

connection to the server, and that the NFM-P server IP address is in the client host-lookup file.

END OF STEPS

18.2 Problem: NFM-P client unable to communicate with NFM-P server

18.2.1 Prerequisites

Before you proceed, ensure that the following conditions are present:

• The NFM-P client points to the correct IP address and port of the server.

• The problem is not a network management domain LAN issue. See Chapter 6, “NSP system

troubleshooting” for more information.

• Firewalls between the NFM-P clients and the server are correctly configured

18.2.2 Steps

1

To check that the NFM-P client points to the correct IP address and port of the server, open the

nms-client.xml file using a text editor. The default file location is installation_directory/nms/

config.

where installation_directory is the directory in which the NFM-P client software is installed, for

example, /opt/nsp/client

2

Verify the IP address of the server as specified by the ejbServerHost parameter.

3

Verify the server port as specified by the ejbServerPort parameter.

Troubleshooting NFM-P clients
Problem: NFM-P client unable to communicate with NFM-P server

NSP

© 2022 Nokia.
Use subject to Terms available at: www.nokia.com/terms

3HE-18817-AAAC-TQZZA

Release 22.9
September 2022

222 Issue 1

http://www.nokia.com/terms/


4

Modify the IP address and port values, if required.

5

Save the file, if required.

6

Perform 17.2 “Problem: Cannot start an NFM-P server, or unsure of NFM-P server status”

(p. 207) to check the server status. A client cannot connect to an NFM-P server that is not

started.

7

If the server is started, compare the firewall and network configuration guidelines in the NSP

NFM-P Planning Guide to with your network configuration to ensure that it complies with the

guidelines.

8

Contact your technical support representative if the problem persists.

END OF STEPS

18.3 Problem: Delayed server response to client activity

18.3.1 Causes

Possible causes are:

• a congested LAN

• improperly sized platforms

Using the netstat command on the client may help troubleshoot network throughput problems.

When an Ethernet LAN is highly congested, the actual throughput slows down. This is caused by

packets colliding on the LAN as multiple machines begin to transmit at approximately the same

time, for example, when multiple GUI or OSS clients are performing tasks simultaneously.

18.3.2 Steps

1

Client GUIs may respond more slowly than normal during resynchronizations of managed

devices. Repeat the client GUI action when the resynchronization is complete.

2

Check for LAN throughput issues.

1. Open a shell console window.
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2. Enter the following at the console prompt to display local network-interface transmission

data over a period of time:

# netstat -i s ↵

where s is the time, in seconds, over which you want to collect data. Nokia recommends

that you start with 50 s

3. Review the output. The following is sample netstat output:

netstat -i 5

input le0 output input (Total) output

packets errs packets errs colls packets errs packets

errs colls

6428555 41 541360 80 49998 6454787 41 567592 80

49998

22 0 0 0 0 22 0 0 0 0

71 0 7 0 3 71 0 7 0 3

This sample displays the number of input and output packets, errors and collisions on the

le0 interface. One column displays the totals for all interfaces. This sample only has one

interface, so both sets of columns display the same data.

Calculate the number of collisions as a percentage of the number of output packets. For

example, according to the last line of output, there were three collisions and seven output

packets resulting in a 42% rate.

This number is high, but the time in which the sampling was obtained (5 s), was low.

Change the sample rate to, for example, 50 s for an accurate sampling of the network

throughput.

When collisions are between 2% and 5%, congestion on the interface is within the normal

operating range.

In a typical network, when collisions are greater than 5%, you may have a serious

congestion problem on the interface. Review your LAN topology and design to reduce the

number of network bottlenecks.

4. To stop the command, press Ctrl-C.

3

Check that the server and client platforms are appropriately sized. See the NSP NFM-P

Planning Guide for more information.

END OF STEPS

18.4 Problem: Cannot place newly discovered device in managed state

18.4.1 Solution

If the newly discovered device cannot be placed in a managed state, ensure that the number of

managed MDAs do not exceed the NFM-P license. Also, check for resynchronization problems

between the managed network and the NFM-P. See 17.10 “Cannot manage new devices” (p. 217).
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18.5 Problem: User performs action, such as saving a configuration,
but cannot see any results

18.5.1 Causes

Possible causes are:

• Failed SNMP communication between the server and managed device; see 17.9 “Problem: All

SNMP traps from managed devices are arriving at one NFM-P server, or no SNMP traps are

arriving” (p. 216).

• Failed deployment of the configuration request.

18.5.2 Steps

1

For the NFM-P client, perform the following:

1. Choose Administration→NE Maintenance→Deployment from the NFM-P main menu.

The Deployment form opens. Incomplete deployments are listed, and deployer, tag, state

and other information is displayed.

The possible states for a deployment are:

• Deployed

• Not Deployed

• Pending

• Failed — Resource Unavailable. Failure occurred because one of the resources required

to apply the configuration is not present in the NFM-P database

• Failed — Configuration. Failure occurred because the configuration could not be applied

to the specified objects

• Failed — Partial. Failure occurred at deployment and some of the configuration can been

sent to the network

• Failed — Internal Error. Failure a occurred due to general error conditions. Code is

intended as a catch-all code for all other possible errors

• Cancelled

• Postponed

You can also suspend or resume deployment retries by clicking Suspend Retries or

Resume Retries. You can clear a deployment by clicking Clear. When you clear a deployer,

no further attempt is made to reconcile the network device status with the NFM-P database.

Affected objects should be resynchronized.

If a deployment is not sent to a managed device, the intended configuration change is not

made on the device.

2. Choose a failed deployment and click Properties to view additional information. The

deployment properties form opens.
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2

When a deployment fails and you receive a deployment alarm, check the following steps:

1. Using CLI, check on the device whether the deployment change is on the device.

2. If the change is on the device, the deployment alarm was likely raised because the

configuration already exists on the device. Clear the failed deployment and resynchronize

the device with the NFM-P.

If the change is not on the device, collect the information from the deployment properties

form and contact your technical support representative.

3

Note: These steps describe how to troubleshoot asynchronous deployment requests only.

Nokia recommends that deployment requests be made in asynchronous mode.

For OSS clients, perform the following steps:

1. Browse real-time alarms received via JMS. An alarm denoting a deployment failure

contains the following text:

Attribute: alarmClassTag Value: generic.DeploymentFailure

The alarm also contains additional information, including the object affected by the alarm

and the severity of the alarm. See the NSP NFM-P XML API Developer Guide for more

information.

2. Find the following text in the alarm:

Attribute: requestID=requestID

The parameter specifies the request id sent with the original request. The request id should

be unique per request.

3. Determine the original request using the request id.

4. Troubleshoot the original request. If there are problems with the original request, clear the

deployer, fix the request, and send the new request. See the NSP NFM-P XML API

Developer Guide for more information.

5. If there are no problems with the original request, the failure may be caused by a network

communication or device failure, or by packet collisions caused by conflicting

configurations.

You can:

• resend the request

• troubleshoot your network or device

END OF STEPS
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18.6 Problem: Device configuration backup not occurring

18.6.1 Steps

1

Use the NFM-P client to check the device database backup settings. Choose

Administration→NE Maintenance→Backup/Restore from the NFM-P main menu. The Backup/

Restore form opens.

2

Click on the Backup/Restore Status tab. The managed devices are listed and backup and

restore status information is displayed.

3

Select the device and click Properties. The NE Backup/Restore Status form opens.

4

View the information in the Backup Status panel. A Backup State other than Successful may

indicate a communication problem or a backup policy configuration error.

5

Ensure that the device configuration file and the associated index file are saved on the device

and available for backup. Click on the Configuration Saves tab, and ensure that the Config

Save State indicator reads Success.

See the appropriate device OS documentation for more information.

6

Click on the Backups tab to view a list of backup operations that are currently in progress. A

backup operation disappears from the list after it completes.

7

Click on the Faults tab to view additional troubleshooting information.

8

Close the NE Backup/Restore Status form.The Backup/Restore form is displayed.

9

Use the information obtained from the NE Backup/Restore Status form to check the backup

policy configuration, if required. Click on the Backup/Restore Policy tab.

10

Select the backup policy for the device and click Properties. The Backup Policy (Edit) form

opens.
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11

Ensure that the policy is assigned to the device.

1. Click on the Backup/Restore Policy Assignment tab.

2. If required, configure a filter and click OK.

3. Move the device to the Assigned Sites list if it is not there by selecting the site from the

Unassigned Sites list and clicking on the right-arrow button.

4. Click Apply to save changes, as required.

12

Click on the General tab.

13

Verify the parameter settings and modify, if required.

14

Save the changes and close the form.

END OF STEPS

18.7 Problem: NFM-P client GUI shuts down regularly

18.7.1 Causes

The NFM-P client GUI automatically shuts down under the following conditions:

• no activity on the GUI for a specified amount of time

• no communication between the GUI and the server for a specified amount of time.

• when there is an communication error that causes problems between the server and the client

Note: Changing the OS clock setting on the server station can cause communication

problems on the client. If the server clock setting changes significantly, the clients must log off

and the server must be restarted. Nokia recommends that the server OS clock be tied to a

synchronous timing source to eliminate time shifts that may lead to polling and communication

problems.

18.7.2 Steps

1

Disable the GUI activity check, if required. Choose Administration→Security→NFM-P User

Security from the NFM-P main menu. The Security Management (Edit) form appears with the

General tab selected.
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2

Set the Client Timeout (minutes) parameter to 0 to disable the GUI inactivity check. Alternately,

you can configure a higher value for the parameter, to increase the time that must pass before

the client GUI is shut down due to inactivity.

3

Click Apply and close the form.

END OF STEPS

18.8 Problem: Configuration change not displayed on NFM-P client
GUI

18.8.1 Solution

The NFM-P supports the configuration of complex objects, for example, services, using

configuration forms or templates. Additional configuration forms and steps may be contained by

main, or parent, configuration form. For example, when you configure a VLL service, a site

configuration form is contained within the main configuration form. In turn, an L2 interface

configuration form is contained within the site configuration form. Alternatively, when you use

service templates, parent templates for site configuration must also be configured.

Objects configured in contained configuration forms are not saved until the parent configuration

form is saved. For example, when you configure a VLL service, sites or L2 interfaces that you

configure are not saved during service creation until the parent configuration form is saved. You

cannot view new objects or new object configurations in other parts of the GUI, such as the

navigation tree, until the service is saved. The NFM-P displays a dialog box to indicate that

configured objects in a configuration form are not saved until the parent configuration forms are

saved.

18.9 Problem: List or search function takes too long to complete

18.9.1 Solution

You can perform simple listings or complex searches using the Manage menu on the NFM-P main

menu to query the database for information about services, customers, and other managed entities.

Depending on the type of information and the number of entries returned, a list or search operation

may take considerable time to complete. As a general rule, Nokia recommends that you use filters

to restrict the number of items in a list or search operation to 10 000 or fewer.

See the NSP NFM-P User Guide for information about the NFM-P client GUI list and search

functionality. See the NSP NFM-P Planning Guide for information about NFM-P scalability and

system capacity guidelines.
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18.10 Problem: Cannot select some menu options or save some
configurations

18.10.1 Solution

An NFM-P administrator can restrict user access to GUI functions, and limit the ability of a user to

configure objects. See your administrator for information about your general user permissions,

scope of command, and span of control.

The NFM-P license may also affect user access to functions or objects; see the NSP System

Administrator Guide for information.

An administrative change to a user or group permission takes effect immediately, and determines

which actions are available to the user or user group.

See 17.10 “Cannot manage new devices” (p. 217) to identify which NEs are licensed for NFM-P

management.

18.11 Problem: The NFM-P client GUI does not display NE user
accounts created, modified, or deleted using the CLI

18.11.1 Cause

When an NE user account is created, modified, or deleted using the CLI, the NFM-P client GUI

does not update the user list in the NE User Profiles form. For increased security, the NE does not

send a trap for changes made to NE user accounts. You can update the NFM-P with the NE user

account changes by resynchronizing the NE.

18.11.2 Steps

1

On the Equipment tree, navigate to the NE. The path is Network→NE.

2

Right-click on the NE and choose Resync.

The Resync menu option specifies that SNMP MIB and CLI information bases are reread to

resynchronize them with the NFM-P, which also resynchronizes the network management

settings with the router. Resynchronization does not impact the contents of the historical

statistics database.

END OF STEPS
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